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This file consist of 9 packages that are offered in COMPUTER APPLICATION COURSE.

1.Introduction to Computer

2.Computer Systems

3.Introduction to word processing

4.Introduction to spreed sheet

5. Introduction to databases

6.Introduction to desktop Publishing

7.Internet and emails

8.Data Security

9.Introduction to powerpoint

INTRODUCTION TO COMPUTERS.
Definition of a Computer:
· A Computer is an electronic device that operates (works) under the control of programs stored in its own memory unit.

· A computer is an electronic machine that processes raw data to give information as output.
· An electronic device that accepts data as input, and transforms it under the influence of a set of special instructions called Programs, to produce the desired output (referred to as Information).

A computer automatically accepts data & instructions as input from an Input device, stores them temporarily in its memory, then processes that data according to the instructions given, and finally transfers the processed data (Information) to an Output device.

Explanations;

· A computer is described as an electronic device because; it is made up of electronic components and uses electric energy (such as electricity) to operate.
· A computer has an internal memory, which stores data & instructions temporarily awaiting processing, and even holds the intermediate result (information) before it is communicated to the recipients through the Output devices.
· It works on the data using the instructions issued, means that, the computer cannot do any useful job on its own.  It can only work as per the set of instructions issued.  

A computer will accept data in one form and produce it in another form.  The data is normally held within the computer as it is being processed.

Program:
· A computer Program is a set of related instructions written in the language of the computer & is used to make the computer perform a specific task (or, to direct the computer on what to do).

· A set of related instructions which specify how the data is to be processed.

· A set of instructions used to guide a computer through a process.

Data:
Data is a collection of raw facts, figures or instructions that do not have much meaning to the user.

· Data may be in form of numbers, alphabets/letters or symbols, and can be processed to produce information.
TYPES OF DATA.

There are two types/forms of data:

a). Digital (discrete) data:
Digital data is discrete in nature.  It must be represented in form of numbers, alphabets or symbols for it to be processed by a computer.

· Digital data is obtained by counting. E.g. 1, 2, 3 …

b). Analogue (continuous) data:
Analogue data is continuous in nature.  It must be represented in physical nature in order to be processed by the computer.

· Analogue data is obtained by measurement.  E.g. Pressure, Temperature, Humidity, Lengths or currents, etc
· The output is in form of smooth graphs from which the data can be read.

Data Processing:
· It is the process of collecting all items of data together & converting them into information.

· Processing refers to the way the data is manipulated (or handled) to turn it into information.

The processing may involve calculation, comparison or any other logic to produce the required result.  The processing of the data usually results in some meaningful information being produced.

Information:

Information is the data which has been refined, summarized & manipulated in the way you want it, or into a more meaningful form for decision-making.
· The information must be accurate, timely, complete and relevant.

Comparison between Data and Information.

	Data
	Information

	1. Unprocessed (raw) facts or figures.
2. Not arranged.
3. Does not have much meaning to the user.
4. Cannot be used for decision-making.
	1. It is the end-product of data processing (processed data) 
2. Arranged into a meaningful format.
3. More meaningful to the user.
4. Can be used to make decisions.


Characteristics / Features of a Computer.
Before 20th century, most information was processed manually or by use of simple machines.  Today, millions of people are using computers in offices and at home to produce and store all types of information 
The following are some of the attributes that make computers widely accepted & used in the day-to-day activities in our society:
1. Speed.
Computers operate at very high speeds, and can perform very many functions within a very short time.
They can perform a much complicated task much faster than a human being.

The speed of a computer is measured in Fractions of seconds.

Millisecond
- a thousandth of a second (10-3)

Microsecond
- a millionth of a second (10-6)

Nanosecond
- a thousand millionth of a second (10-9)

Picosecond
- a million millionth of a second (10-12)

The speed of a computer is usually linked to the technology used to build it.

a). 1st Generation computers (1940s & early 1950s).

The computers were built using Vacuum tubes, and the speed was measured in Milliseconds.  E.g., a computer could perform 5,000 additions & 300 multiplications per second.

b). 2nd Generation computers (1950s & early 1960s).

Were built using Transistors.  Their operation speeds increased & were measured in Microseconds.  E.g., a computer could perform 1 million additions per second.

c). Mid 1960s.

Integrated Circuit (IC), which combined a no. of transistors & diodes together on a silicon chip, was developed.

The speed increased to tens of millions of operations per second.

d). In 1971, Intel Corporation produced a very small, single chip called a Microprocessor, which could perform all the operations on the computer’s processor.  The chip contained about 1,600 transistors.

e). Today’s microprocessors are very powerful, cheaper & more reliable due to the use of the Large Scale Integration (LSI) & Very Large scale Integration (VLSI) technologies, which combines hundreds of thousands of components onto a single chip.

The computer speeds are now measured in Nanoseconds & Picoseconds.

2. Accuracy:
Unlike human beings, computers are very accurate, i.e., they never make mistakes.  
A computer can work for very long periods without going wrong.  However, when an error occurs the computer has a number of in-built, self-checking features in their electronic components that can detect & correct such errors.  

Usually errors are committed by the users entering the data to the computer, thus the saying Garbage in Garbage Out (GIGO).

This means that, if you enter incorrect data into the computer and have it processed, the computer will give you misleading information.

3. Reliability.

The computer can be relied upon to produce the correct answer if it is given the correct instructions & supplied with the correct data.

Therefore, if you want to add two numbers, but by mistake, give the computer a “Multiply” instruction, the computer will not know that you intended to “ADD”; it will multiply the numbers supplied.

Similarly, if you give it the ADD instruction, but make a mistake and enter an incorrect data; let say, 14 & 83 instead of 14 & 38; then the computer will produce the “wrong” answer 97 instead of 52.  However, note that, 97 is ‘correct’ based on the data supplied.

Therefore, the output produced by a computer is only as reliable as the instructions used & the data supplied.

4. Consistency:
Computers are usually consistent.  This means that, given the same data & the same instructions, they will produce the same answer every time that particular process is repeated.

5. Storage:
· A computer is capable of storing large amounts of data or instructions in a very small space.
· A computer can store data & instructions for later use, and it can produce/ retrieve this data when required so that the user can make use of it.  
· Data stored in a computer can be protected from unauthorized individuals through the use of passwords.

6. Diligence:

Unlike human beings, a computer can work continuously without getting tired or bored.  Even if it has to do a million calculations, it will do the last one with the same speed and accuracy as the first one.

7. Automation:
A computer is an automatic device.  This is because, once given the instructions, it is guided by these instructions and can carry on its job automatically until it is complete.
It can also perform a variety of jobs as long as there is a well-defined procedure.

8. Versatile:
A computer can be used in different places to perform a large number of different jobs depending on the instructions fed to it.
9. Imposition of a formal approach to working methods:
Because a computer can only work with a strict set of instructions, it identifies and imposes rigid rules for dealing with the data it is given to process.
Review Questions.

1. What is a Computer?

2. Why is a computer referred to as an electronic device?

3. Define the following terms as used in computer science.
a). Data.

b). Programs.

c). Data processing.

d). Information.

4. (a)
Briefly explain the two forms of data.

(b)
Give THREE differences between Data and Information.
5. The speed of a computer is measured in ___________.

6. What does the term GIGO stands for?
7. List and explain 4 salient features/ properties of a computer.

8. List FIVE advantages of a computerized system over a manual system.
PARTS OF A COMPUTER.

A computer is made up of a collection of different components that are interconnected together in order to work as a single entity.
A Computer consists of the following parts/devices: -

1. The System Unit.

2. Input devices.

3. Output devices.

4. Storage devices.

System Unit.
This is the casing (unit) that houses electronic components such as the ‘brain’ of the computer called the Central processing Unit (CPU) and storage devices.  

The components in the System unit include: -

· Central Processing Unit (CPU), which is also referred to as Processor.

· Motherboard.

· Power supply unit.

· Memory storage devices.

· Disk drives, which are used to store, record and read data.

Types of System units

There are two makes of System units:

a) Tower style system unit

This system unit is made to stand alone.  They are designed to be placed on the floor.
· Tower style units have more space for expansion than the typical desktop units.

b) Desktop system units

Desktop units lie on the desk with the monitor resting on top of the system unit.
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Features of the System unit.

· It houses the CPU.

· It connects to all peripheral devices using ports.

· It has the computer’s Power switch.

The Central processing unit (CPU) 

This is the brain of the computer, and carries out all the processing within the computer.
Input devices.
These are the devices used to enter/put data into the computer.

· They accept data for processing & convert it into a suitable form that the computer can understand.

Examples: Keyboard, Mouse, Joysticks, Light pen, Scanner, etc.



The Keyboard 
The keyboard looks like a typewriter, and has letters, numbers and other keys through which data is entered into the computer.

To enter data & instructions into the computer, the user should press the required keys.
The Mouse 

It is a pointing device that enables the user to issue instructions to the computer by controlling a special mouse pointer displayed on the screen.

Output devices.
Output devices are used to give the end results of data that was entered into the computer.

· They extract/ disseminate processed data (information) from the computer.
· They accept data from processing devices & convert it into human sensible form.
Examples: Screens (Monitors), Printers, Graph plotters, Speakers, etc

The Monitor 

It is a television like screen used for displaying output.  When you type a letter or number on the keyboard, it shows up on the monitor.

Note.  The monitor enables the user to monitor/track or see what is going on in the computer.
Printer 

Printers are used to create permanent copies of output on paper.
Memory storage devices.
These are devices used to store programs & data in computers.

· They hold data & programs until they are needed for processing.

· They also hold the results after processing.

Computer storage is divided into 2:

i). Primary (main) storage.
This is the storage found within the computer itself.  It is used to hold data, programs & instructions required immediately (or currently being used) by the Processor.  
Examples: Random Access Memory (RAM) & Read Only Memory (ROM).
ii). Secondary (Backing) storage.
It is used by the computer to store backup information that is not needed immediately by the Processor.  It is also used by the computer to supplement the computer’s main memory/ internal memory in case of mass storage purposes. 
Secondary storage units provide permanent data storage facilities.  They allow large quantities of information to be stored permanently on some form of magnetic media such Magnetic tapes or disks.

The programs & data are transferred to & from the secondary storage units to the Main memory only when they are required; hence the information is said to be online to the computer.
Examples of secondary storage devices:
· Hard disk





* Floppy disks.





* Magnetic Tapes.

· Cassette tapes.




* Punched cards.





* Zip disks.


· Compact disks




* Digital Video Disks (DVDs).

Computer peripherals.
A computer is basically made up of a system unit and other devices connected to the system unit called Peripheral devices.
Peripheral devices are the elements (components) connected to the system unit so as to assist the computer satisfy its users.  

Peripheral devices are connected to the System unit using special cables called data interface cables that carry data, programs & information to and from the processor.  The cables are connected to the system unit using connectors called Ports.
Examples of peripheral devices include;

· Monitor, 





- Keyboard, 




- Mouse
· Printer.





- Modem.





- Speakers.
· Plotter.
Review Questions.

1. List down the components that make up a computer.

2. Clearly draw and label the main physical parts of a simple computer system.

3. What are computer peripherals?

4. (a). Name and explain the two main divisions of computer storage.

(b). Give two common examples of secondary storage devices.
5. Name two output devices.

6. (a). Explain the term System unit.

(b). Name some of the components found in the System unit.

(c). Give three features of a computer’s System Unit.

7. Why is the screen also called a Monitor?

8. What is a Mouse in relation to computing?
DEVELOPMENT OF COMPUTERS.

HISTORY OF COMPUTING.

Before 1900, most data processing was done manually using simple tools like stones & sticks to count and keep records.

Around 2000 years ago, Asian merchants came up with a special calculating tool called Abacus that could be used to calculate large figures.

An Abacus is made up of a rectangular frame and a crossbar at the middle.  It is fitted with wires or strings running across from the frame to the crossbar.

How to represent a number using an Abacus.

Each bead in the lower row has a value of 1, while each bead in the upper row has a value of 5.  To represent a number, the bead is moved to the crossbar.  Those beads away from the crossbar represent zeros. 

The Figure below represents the number 6908 (Six thousand nine hundred and eight).
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After Abacus, the first machine that is usually regarded as the forerunner of modern computers was named the Analytical Engine, and was developed by an English mathematician called Charles Babbage.

In 1939, Professor Howard Aken of Horrard University designed the first computer-like machine named Mark 1.  Since then, a series of advancements in electronics has occurred.  With each breakthrough, the computers based on the older form of electronics have been replaced by a new “generation” of computers based on the newer form of electronics.

COMPUTER GENERATIONS.

A Computer generation is a grouped summary of the gradual developments in the computer technology.  The historical events are not considered in terms of individual years, but are classified in durations (a period of more than a year).

1ST Generation computers (1946 – 1956).

The 1st generation of computers used thousands of electronic gadgets called Vacuum tubes or Thermionic valves to store & process information.  

[image: image3.png]











Vacuum tube

The tubes consumed a lot power, and generated a lot of heat during processing due to overheating.

The computers constantly broke down due to the excessive heat generated, hence were short-lived, and were not very reliable.

They also used Magnetic drum memories.

Cards were used to enter data into the computers.

Their internal memory capacity was limited.  The maximum memory size was approx. 2 KB (2,000 bytes).

The computers used big physical devices in their circuitry; hence they were very large in size, i.e. the computer could occupy several office blocks.  For example, ENIAC occupied an area of about 150m2 - the size of an average 3-bedroom house.  

They were very slow - their speed was measured in Milliseconds.  E.g., ENIAC (the earliest electronic computer) could perform 5,000 additions per second & 300 multiplications per second.

The computers were very costly - they costed millions of dollars.

Examples of 1ST Generation computers:

· ENIAC (Electronic Numerical Integrator And Calculator) built in 1946 for use in World War II.  It contained 18,000 Vacuum tubes.

· EDVAC (Electronic Discrete Variable Automatic Computer) developed in 1945 by Dr. John Von Neumann.  It was the first computer that used instructions stored in memory.

· UNIVAC (UNIVersal Automatic Computer).

· IBM 650.

· LEO (Lyon’s Electronic Office).

2ND Generation computers (1957 – 1963).

The 2nd generation computers used tiny, solid-state electronic devices called Transistors.  The transistors were relatively smaller, more stable & reliable than vacuum tubes.
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      Transistor

The computers consumed less power, produced less heat, were much faster, and more reliable than those made with vacuum tubes.

They used Magnetic core memories.

RAM Memory size expanded to 32 KB.

Their operation speed increased to between 200,000 – 300,000 instructions per second.  Their speeds were measured in Microseconds.  E.g., a computer could perform 1 million additions per second, which was comparatively higher than that of the 1st generation computers.

The computers were smaller in size & therefore, occupied less space compared to the 1st G computers.

They were less costly than the 1st G computers.

Examples of 2nd Generation computers:

· NCR 501, IBM 300, IBM 1401, IBM 7070, IBM 7094 Series & CDC-6600 Mainframe computers.

· ATLAS LEO Mark III.

· UNIVAC 1107.

· HONEYWELL 200.

3RD Generation computers (1964 – 1979).

Used electronic devices called Integrated Circuits (ICs), which were made by combining thousands of transistors & diodes together on a semiconductor called a Silicon chip.
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Integrated circuit

The processing speed increased to 5 Million instructions per second (5 MIPS).

The storage capacity of the computers (i.e., the RAM memory sizes) expanded to 2 MB.

They were smaller in size compared to 2nd generation computers.

The computers used a wide range of peripheral devices.

The computers could support more than user at the same time.  They were also able to support remote communication facilities.

Magnetic disks were developed for storage purposes.

The 1st microcomputer was produced during this period (1974).

Examples of 3rd Generation computers:

· IBM 360, 370; 

· ICL 1900 Series; 

· 8-bit Microcomputers & PDP-11 Mainframe computers.

4TH Generation computers (1979 – 1989).

The 4th generation computers used Large Scale Integrated (LSI) circuits & Very Large Scale Integrated (VLSI) circuits.  These circuits were made by compressing more tiny circuits and transistors into even smaller space of the silicon chip.
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Very Large integrated circuit

The computers were small, and very fast.  Their processing speeds increased to 50 Million instructions per second.

Had large storage capacity, i.e., their memory sizes expanded to several hundred Megabytes.

Memories used included Magnetic disks, Bubble memories & Optical disks.

Examples of 4th Generation computers:

· IBM 308 and 4300; 

· Amdahl 580

· Honeywell DPS-88

· Burroughs 7700, and the 16-bit & 32-bit microcomputers.  The first microcomputer was called Apple II.
5TH Generation computers (1990 – Present).

In this generation fall today’s computers.

The technologies used are Parallel architectures, 3-Dimensional circuit design & super conducting materials.  

These technologies have led to the development of computers referred to as Supercomputers, which are very powerful, and have very high processing speeds.  Their speeds are measured in Nanoseconds & Picoseconds.

They are able to perform parallel (or multi-processing) whereby a single task is split among a number of processors.

The memory sizes range between 1 Gigabyte & 1 Terabyte. 

The computers are designed using VLSI and the Microchip technology that has given rise to the smaller computers, known as Microcomputers used today.

The computers have special instruction sets that allow them to support complex programs that mimic human intelligence often referred to as Artificial Intelligence.  Such programs can help managers to make decisions and also provide critical expert services to users instead of relying on human professionals.

Review Questions.

1. Briefly describe the history of computers.

2. (a). What do you mean by computer generations?

 (b). Describe the FIVE generations of computers in terms of technology used and give an 

example of a computer developed in each generation.

(c). Compare computer memory sizes during the Five computer generation periods.

3. What was the most remarkable discovery during the second computer generation?

4.  (a). Technology is the basis of computer classification.  Based on this, explain briefly the 

difference between the first three computer generations.

(b). What is so peculiar in the fourth and fifth generation of computers?

5. Match the following generations of computers with the technology used to develop them.

	Generation
	Technology

	First generation
	A). Very Large Integrated Circuit

	Second generation
	B). Thermionic valves (Vacuum tubes)

	Third generation
	C). Transistors

	Fourth generation
	D). Integrated Circuits


6. Give four characteristics of First generation computer.

7. Write the following abbreviations in full:

(a). ENIAC

(b). VLSI

(c). IC

8. What is Artificial Intelligence?

FACTORS THAT DETERMINE THE TYPE OF COMPUTER.

1) Type of processor (Central processing unit – CPU)
Microcomputers use microprocessors, which are manufactured on a single chip, as their CPU.  
In larger computers such as supercomputers, mainframe & minicomputers, the processing is carried out by a number of separate, high-speed components instead of a single processor.

2) Processing speed.

Every computer has a clock that drives its operations.

Larger computers have faster clocks and therefore can process many instructions per second compared to small computers, which have slower clocks.

3) Amount of Main memory (RAM).

All computers have some amount of RAM (Random Access memory), which is used to hold the instructions required to perform a task.

Larger computers have more RAM and therefore can handle large volumes of data & also support many and sophisticated programs which might require large memory sizes.

4) Storage capacity of the Hard disk.

The storage capacity is the amount of space that is available for storing the instructions required to manipulate data.

Larger computers have higher storage capacities than microcomputers.
5) Cost of the computer.

The cost of computers is directly related to the size.  Microcomputers are less costly compared to minicomputers, mainframes or Supercomputers.

6) Speed of Output devices.

The speed of an output device is determined by the amount of information that can be printed in a specified amount of time.

The speed of microcomputer output device is less than that of the larger computers in that:

For a microcomputer, the speed of its output device is measured by the number of characters printed per second (cps).  For larger computers, their output devices are faster and their speeds are measured depending on the number of lines or pages printed per minute (lpm / ppm).

7) Number of users who can access the computer at the same time.

Most microcomputers can support only 1, 2 or 3 users at the same time.  However, they can be networked to share resources.  

Larger computers can support hundreds of users at the same time.

Review Questions.

1. Briefly explain five factors that can be used to determine the type of a computer.

CLASSIFICATION OF COMPUTERS

Computers can be classified according to the following factors:

1. Physical size & processing power.

2. Purpose for which they are designed.

3. Functionality (Method/ mode of operation).

A. CLASSIFICATION ACCORDING TO PHYSICAL SIZE.
Computers can be classified into 5 main groups according to their size as:

· Supercomputers.

· Mainframe computers.

· Minicomputers.

· Microcomputers.

· Portable computers (Laptops, Notebooks & Palmtops).

Supercomputers.
Supercomputers are the fastest, largest, most expensive & also the most powerful computers available.

They are very fast in processing.  They can perform many complex calculations in a fraction of a second.
Most Supercomputers use multiple processors.  In this case, a single task is split among the processors for faster execution.  However, all the processors are controlled by a single central processor. 
Supercomputers generate a lot of heat, & therefore require special cooling systems.  Sometimes, the whole CPU is deeped in a tank containing liquid Fluorocarbon to provide cooling.

Supercomputers are very large & heavy, and are usually kept under special environmental conditions (i.e., in a special room).

They are operated by computer specialists.  A Supercomputer can be operated by over 500 users at the same time.

Areas where supercomputers are used:

Supercomputers are mainly used for complex scientific applications that involve many calculations & require a lot of computational power.  Some of the applications that use supercomputers include; 
· Weather forecasting.
· Petroleum research.
· Defence and weapon analysis.
· Aerodynamic design and simulation.
Note.  These tasks use large amounts of data, which need to be manipulated within a very short time.

Examples of Supercomputers:

· CRAY T3D, NEC-500.

Mainframe computers.
Mainframes are less powerful & less expensive than supercomputers.

They are big in size but smaller compared to Supercomputers.

Are powerful computers with very high capacities of Main storage.  They also have a large backing storage capacity.

Have a very high processing speed, i.e., can process large amounts of data very quickly.

They can support a large number of peripherals of different types (can support between 5–300 terminals).

They can handle hundreds of users at the same time, e.g., they can be operated by 200 users at a time.

Mainframe computers are general-purpose, and can handle all kinds of problems whether scientific or commercial.
Areas where mainframe computers are used:

Mainframe computers are mostly found in government departments, big organizations and companies which have large information processing needs, e.g., they are used;
· In Banks & Hospitals for preparing bills, Payrolls, etc.
· In communication networks such as the Internet where they act as Servers.
· By Airline reservation systems where information of all the flights is stored.
Examples of Mainframes:

· IBM 4381.

· ICL 39 Series.

· CDC Cyber series.

Minicomputers.
A Minicomputer is physically smaller than a mainframe.  However, it can support the same peripheral devices supported by a mainframe.

A Minicomputer can support several users at a time, e.g., can be operated by 6 users at a time.  Several workstations/ terminals are connected to one central minicomputer so that the users connected can share its resources (C.P.U time, storage, etc).

Minicomputers are easier to manufacture & maintain compared to mainframes.

Minicomputers are cheaper than the mainframes, but more costly than the microcomputers.

They handle small amounts of data, are less powerful, & have less memory than the mainframes. 

Minicomputers are slow compared to mainframe computers.

Areas where minicomputers are used:

Minicomputers are used mainly in:

· Scientific laboratories & research institutions.

· Engineering plants/factories to control of chemical or mechanical processes.
· Space industry.

· Insurance companies & Banks for accounting purposes.
· Smaller organizations as Network Servers.

Example of Minicomputer:

· PDP-8 built in 1965 by Digital Equipment Corporation in U.S.

Microcomputers.
Microcomputers are the PCs mostly found today in homes, schools & many small offices.  They are called Personal Computers (PCs) because they are designed to be used by one person at a time.

They consist of very few connected units, i.e. can support very few peripheral devices (usually 1 or 2).

The data processing in microcomputers is done by a Microprocessor (a single chip containing the Arithmetic Logic unit & Control unit).
Microcomputers are smaller in size & also cheaper than minicomputers.  Their design is based on Very Large Scale Integration (VLSI) that confines several physical components into an IC.

They are less powerful than minicomputers & their internal memory is smaller than that of minicomputers.  

Areas where microcomputers are used:

Microcomputers are commonly used in:

· Training and learning institutions such as schools.
· Small business enterprises, and 
· Communication centres as terminals.  

Microcomputers have become very popular because of the following reasons:

1) Are cheaper than both mini & mainframe computers.
2) Are very fast (i.e. have high processing speeds).

3) Small in size, hence they occupy less space in an office.

4) Are more energy efficient (i.e., consume less power).

5) Are more reliable than the early Mainframe computers.

Examples:

· IBM PCs such as Apple Macintosh, Dells, Compaq, etc.

Laptops & Notebooks.
A Laptop is a PC sufficiently small & light such that a user can use it comfortably on his/her lap.  It is designed to be used by placing it on the lap.

· Laptops are very small in size & are portable.  They are small enough to fit inside a briefcase; still leaving room for other items.
· A Laptop computer operates mainly on electricity or by rechargeable batteries.

· Laptops normally have in-built disk drives & Flat screens (Liquid Crystal Displays).

· Can only support a limited number of peripheral devices.

· Have limited storage capacities.

Note.  The smaller computers like Laptops tend to be more expensive than Desktop computers because of the following reasons:

1) The technology of producing smaller devices is expensive.

2) They are convenient because they are portable.

3) They have advanced power management capabilities (they consume less power since a laptop can operate on rechargeable batteries).

Palmtops.
Palmtops are small enough to fit in the pocket, and can be held in the palm when being used.
· Have limited storage capacities.

· Palmtops are mainly used as Personal Organizers, with some minimal programs for calculations, Word processing, Spreadsheets, & E-mail.

Example of a Palmtop; Personal Digital Assistant (PDA).

Desktop computer.
This is the name given to any computer designed to be used when placed on a desk in an office environment.

· They are not portable.

Examples of desktop computers:

1) Home computer.

This is a low-cost microcomputer of limited capability designed for domestic use.  It has programs that are used typically for computer games or controlling family finances.

2) Personal computer (PC).

This is a microcomputer designed for independent use by an individual at work or in the home mainly for business purposes.

· A PC can support only 1 user at a time.

· PCs are mostly used in offices, schools, business premises, and at home for various applications like computer literacy, Games, Database management, Accounting, Word processing, Telecommunications, etc. 

· A PC can be connected to a mini & mainframe computer so as to enable the user access the facilities offered by the larger machines.

3) Workstation.

A workstation is usually a desktop computer with all the facilities but interlinked to a network.

A typical workstation works in a similar way to a Personal computer.  However, it is more advanced than a typical PC in the following ways:

i). It is larger & more powerful than a PC.  E.g., workstations use 32-bit microprocessors, while PCs use 16-bit microprocessors.

ii). It has in-built capabilities for its interconnection & operation with other computers, i.e., it is fully connected to a computer network as any other computer on the network in its own right.

iii). It has high resolution graphics.

iv). It has a Multi-tasking operating system, i.e. it is able to run multiple applications at the same time.

An Embedded computer.

This is a computer that is within another device or system but is not accessed directly.  E.g., there are embedded computers operating within Petrol pumps, Watches, Cameras & Video recorders.

B. CLASSIFICATION ACCORDING TO PURPOSE.

Digital computers can be classified further according to the tasks they perform either as:

· General-purpose.
· Special purpose
· Dedicated computers.

General-purpose computers.
General-purpose computers are designed to perform a wide variety of tasks.  They use specifically written instructions (programs) to carry out the desired processing tasks.

Example;

A single computer can be used to process documents, perform calculations, process the Payroll, simulate the loading on a bridge, process Insurance policies, and play games, among others.  

The programs used in a general-purpose computer are exchangeable.  This means that, to perform a particular task, the appropriate set of instructions required to perform that particular task are loaded into the computer memory.

E.g., if you want to play a game, the appropriate program is loaded into the computer’s memory & the computer is instructed to execute the instructions which make up the game.

Examples of general-purpose computers: Mainframes, Minicomputers, Microcomputers & Laptops used in most offices & schools.

Special-purpose computer.
A special-purpose computer is designed to handle/accomplish a particular specific task only.
Such computers cannot perform any other task except the one they were meant to do.  Therefore, the programs which are used in a special-purpose computer are fixed (hard-wired) at the time of manufacture.

For example; 

In a computer Network, the Front End Processor (FEP) is only used to control the communication of information between the various workstations and the host computer.

A Special-purpose computer is dedicated to a single task; hence it can perform it quickly & very efficiently.

Examples of special-purpose computers:

· Robots used in a manufacturing industry for production only.

· Mobile phones used for communication only.

· Calculators that carry out calculations only.

· Computers used in Digital watches.
· Computers used in Petrol pumps.

· Computers used in Washing machines.
· An Automatic pilot – a computer dedicated to the task of operating an aircraft.

· A Word processor – a special-purpose computer used in the production of office documents, letters, etc.

Reasons why a Mobile phone is regarded to be a computer.

· It is electronic.

· Has a screen.

· It has a Keypad.

· Has a Memory.

· It is programmable.

Dedicated computer.
A Dedicated computer is a general-purpose computer that is committed to some processing task; though capable of performing a variety of tasks in different application environments.

E.g., the computer can be dedicated to carrying out Word processing tasks only.

C. CLASSIFICATION ACCORDING TO FUNCTIONALITY.

Usually, there are two forms of data; Digital data, and Analogue data.  Computers can be classified according to the type of data they can process as either.  
· Digital computers.

· Analogue computers, or

· Hybrid computers. 

Digital computers.
This is the most commonly used type of computers.  

A Digital computer is a computer that operates on discrete data only.  It can process both numeric & alphabetic data within the computer, e.g., 0, 1, 2, 3…, A,B,C….

Their operation is based on 2 states, “ON” & “OFF” or on digits “1” & “0”.  Therefore, any data to be manipulated by a digital computer must first be converted to digital form.

Their output is usually in form of numbers, alphabets, & symbols.

Digital computers are usually general-purpose computers; hence, they are widely used in different areas for data processing.

Most of the devices found at homes today are digital in nature.
Digital computers are less accurate, i.e. may not solve all your problems since the facilities provided are generalized.   

Examples:

· A Television with a button which is pressed to increase or decrease the volume.

· Digital watches.
· Calculators.

· Microcomputers.  They are said to be digital because they posses the ALU.

Analogue computers.
An Analogue computer is a computer that operates on continuous data.
They carry out their data processing by measuring the amount of change that occurs in physical attributes/quantities, such as changes in electrical voltage, speed, currents, pressure, length, temperature, humidity, etc.

An Analogue computer is usually a special-purpose device that is dedicated to a single task.  For example, they are used in specialized areas such as in:

· Scientific or engineering experiments,

· Military weapons,

· Controlling manufacturing processes like monitoring & regulating furnace temperatures and pressures.

· Weather stations to record & process physical quantities, e.g., wind, cloud speed, temperature, etc.

The output from analogue computers is in form of smooth graphs produced by a plotting pen or a trace on a Cathode Ray Tube (CRT) from which the information can be read.  

Note: Analogue computers usually use one characteristic, e.g. a length, to give information about another physical characteristic, such as weight.

Analogue computers are very accurate & efficient since they are dedicated to a single task.

They are very fast since most of them use multiple processors.

Examples of analogue devices:

· The computer used to control a flight simulator for training pilots.

The computer responds to the Cockpit simulator control movements made by the pilot to physically change the environment so that the pilot feels as if he were controlling an actual aeroplane.

· A Bathroom scale.

It uses the weight of a person to move a pointer smoothly/continuously over calibrated scale, which shows the person’s weight.  

· Thermometer.

It uses a volume of Mercury to show temperature.  The Thermometer is calibrated to give an exact temperature reading.

· Speedometer.

In Speedometer, the rotation of the wheel is converted to a voltage, which causes a pointer to rotate over a dial calibrated in Km/h or Miles/h.

· A Petrol pump measures the rate of flow of Gasoline (petrol) & converts the volume delivered to 2 readings; one showing the volume & the other showing the cost.

· A Post-office scale converts the weight of a parcel delivered into a charge for posting.

· A Monitor with knobs that are rotated to increase brightness.

· A Television with knobs that are rotated to increase or decrease the volume.

· A Radio with a knob that slides in a slot to increase volume.

Hybrid computers.
Hybrid computers are designed to process both analogue & digital data.  They combine both the functional capabilities of the digital and analogue computers.  

Hybrid computers are designed by interconnecting the elements of a digital computer & analogue computer directly into one processor, using a suitable interfacing circuitry.
Hybrid computers are more expensive.

Example;

In a hospital Intensive Care Unit, an analogue device may be used to measure the functioning of a patient’s heart, temperature and other vital signs.  These measurements may then be converted into numbers and send to a digital device, which may send an immediate signal to the nurses’ station if any abnormal readings are detected. 

Comparison between a Computer and Calculator.

	Computer
	Calculators

	1. Costly due to the technology used.

2. Bigger in size.

3. Operate at very high speeds.

4. Are more accurate – they give up to over 10 decimal places of accuracy.

5. Flexible – can be used in solving any problem.

6. Work under the control of programs.

7. Support a variety of peripherals, e.g. keyboard, mouse, light pen, printer, etc.

8. Have large internal memory of several KB’s.

9. Support large Backing storage media.

10. A computer can support several people at the same time.

11. Have got telecommunication capabilities.

12. Require well-monitored environmental conditions.
	1. Cheaper – they imitate simple computer technology.

2. Comparatively smaller.

3. Slower than computers.
4. Less accurate – most calculators give up to 8 dp of accuracy.

5. Mostly used for numerical calculations involving arithmetic/ mathematical operations
6. Calculators are non-programmable, but if programmable, the range is limited.

7. They only use Display units & Keyboards of limited capabilities.

8. their internal memory is very small.  Most calculators only use Registers for temporary storage during calculations.

9. Some calculators have got some sort of fixed Backing store, though very limited.

10. A calculator can serve only 1 user at a time.

11. Have no telecommunication capabilities.

12. Do not require well-monitored environmental conditions.


Review Questions.

1. State three methods of classifying computers.  In each case, list the different types of computers.

2. What is a Personal computer?

3. Differentiate the following types of computers.

a). Supercomputer and Mainframe computer.

b). Minicomputer and a Personal computer.

c). Special-purpose (dedicated) computers and General-purpose computers.

d). Desktop computers and Laptop computers

4. Briefly describe terms “Analogue” and “Digital computers” as used in computer science.

5. Give three examples of Special-purpose computers.

6. Name any FOUR classes of computers based on size and complexity.

ADVANTAGES OF USING COMPUTERS.
Computers have many advantages over other types of office and business equipments that are used for data processing functions.  Some of the advantages are:

1) Computers process data faster:
The processing speed of a computer when measured against other devices like typewriters & calculators is far much higher.
2) Computers are more accurate & reliable:
Computers produce more accurate results as long as the correct instructions & data are entered.  They also have the ability to handle numbers with many decimal places.
3) Computers are more efficient:
A computer requires less effort to process data as compared to human beings or other machines.
4) Computers can quickly and effectively store & retrieve large amounts of data.
5) They are very economical when saving information, for it can conserve a lot of space.

6) Computers occupy very little office space.
7) Computers help to reduce paper work significantly.

8) Computers are flexible:

A computer can perform a variety of jobs as long as there is a well-defined procedure.

9) Computers are cheap:

They can be used to perform a number of organizational functions/ activities, which are meant for individual persons, hence reducing the number of employees & the costs.

10) Computers enhance security & confidentiality:

Data stored in a computer can be protected from unauthorized individuals.

11) Have made communication easier.

12) Computers produce better information:

Computer output is usually tidy and error-free (accurate).

13) Computers reduce the problems of data or information duplication:
14) Computers can operate in risky environments, e.g. volcanic sites, dangerous chemical plants, where human life is threatened:

DISADVANTAGES OF USING COMPUTERS.

1) Computers are very costly in terms of purchase & maintenance.
2) Computers can only be used areas where there is source of power.

3) Requires skilled manpower to operate, i.e., one has to have some knowledge so as to operate a computer.

4) The records are usually kept in a form that is not visible or human-readable.  This makes it difficult to control the contents of the computer’s master file.
5) A computer, like any other machine can break down.

6) Information stored in computers can easily get lost due to power interruptions or machine breakdown.

7) A computer doesn’t have its own intelligence, i.e., it cannot do any useful job on its own, but can only work as per the set of instructions issued.
8) Installation of computers causes retraining or retrenchment of staff/ employees.

9) The computer technology is changing very fast such that the already bought computers could be made obsolete/ out dated in the next few years.  

In addition, this rapid change in the computer technology makes computers & related facilities to become outdated very fast, hence posing a risk of capital loss.

10) The emergence of computers has increased the rate of unemployment since they are now being used to perform the jobs, which were done by human beings.
11) Computers have led to increase in computer crimes especially in Banks.  The computer criminals steal large amounts of funds belonging to various companies by transferring them out of their company accounts illegally.  In addition, they destroy vital data used in running the companies.

AREAS WHERE COMPUTERS ARE USED.

The following are some of the areas where computers are used:
1. Supermarkets.

· Supermarkets and other retail stores use computers for stock control, i.e., to help them manage their daily activities.
The stock control system keeps record of what is in store, what has been sold, and what is out of stock.  The Management is automatically alerted when a particular item or items are running out of stock and need to be reordered.

· For calculating customer’s change.

· For production of receipts.

· It can be used as a barcode reader.

2. Industries.


The use of computers has made Industries more productive & efficient.  They are used:
· To monitor and control industrial processes.  The industries use remote controlled devices called Robots.  A Robot is a machine that works like a human being, but performs tasks that are unpleasant, dangerous, and tedious to be done by human beings.
· For management control, i.e. to keep track of orders, bills and transactions.
· By companies as a competitive tool.  E.g., they are used to assist in defining new products & services.  They also help industries form new relationships with suppliers and therefore, enable the producers maintain a competitive edge against their competitors.
· For advertisement purposes, which enable an industry to attract more customers.
3. Banks/Insurance industries

Computers are used by Banks & Insurance industries:

· To manage financial transactions.  They use special cash dispensing machines called Automated Teller Machines (ATMs) to enable them provide cash deposit & withdrawal services.

· For processing of Cheques.

· For preparation of Payrolls.
· For better record keeping and processing of documents.
· To provide electronic money transfer facilities.

4. Process control.

Computers are used in production environments such as factories to control chemical & mechanical processes.  The computers are usually loaded with specialized programs & each computer is designed to do a specific job.
5. Hospitals.

Computers are used in hospitals:

· To keep & retrieve patient’s medical records.

· For automatic diagnosis of diseases like Cancer, electro-cardiogram screening & monitoring.
They are used to get a cross-sectional view of the patient’s body that enables physicians to properly diagnose the affected part of the body with high levels of accuracy.  
· In medical equipments, e.g. blood pressure monitors, blood analyzers, etc.

· To control life-supporting machines in the Intensive Care Units (ICU).

· To enable medical experts in different countries to share their expertise or labour, thus reducing the transportation of patients & professionals.
6. Offices.

· For receiving & sending of messages through e-mails, fax, etc.

· Production of documents.

· Keeping of records.

7. Government Institutions.

Computers are used in government ministries & agencies:

· To store/keep records and improve the efficiency of work within the Civil service.
If computers were not used, the large number of files in government registries would make information recovery extremely difficult.
· To produce bills & statements.

8. Education.
Computers are widely used in the teaching & learning process.  Learning and teaching using computers is referred to as Computer Aided Learning (CAL) and Computer Aided Teaching (CAT).

· Computers are used in learning institutions (schools & colleges) as teaching aids, i.e. to help in teaching various subjects.
E.g., they are used to demonstrate experiments in subjects like Chemistry or Physics using a special program that can illustrate them on the screen through a process called Simulation.
· To assist the Long distance learning in universities usually referred to as the Open University Concept.

· To analyze academic data.

· Computers are used in Aviation for training of pilots.  Flight simulators are used to monitor the control movements made by the pilot while the computer is used to physically change the environment so that the pilot feels as if he were controlling an actual aircraft.
9. Research.

Computers can be used for research in various fields.  They are used by:
· Scientists to analyse their experimental data, e.g., in weather forecasting.
· Engineers & Architects to design & test their work.

· Computers have greatly assisted in space exploration.
· They are used to study the movement of stars.
· They have made manned & unmanned space exploration possible – they are used to launch space vehicles and monitor the flights & activities both onboard and around them. 

10. Communication industry.

The integration of computers & telecommunication facilities has made the transmission and reception of messages very fast and efficient.
· They are used in telephone exchanges to switch incoming & outgoing calls.
· For sending & receiving electronic messages, e.g. fax and e-mails, if connected to a computer network.
11. Transport industry.

Computers are used in:

· Automobile traffic control, e.g., to monitor vehicle traffic in a busy town.
· Railway corporations to co-ordinate the movement of their goods & wagons.

· Shipping control.  The computers are used for efficient management of fleets & communication.
· Airports (Airline industry).  The computers are used;

· To control the movement of aircrafts, take off & landing through the use of radar equipment.

· Making reservations (booking purposes).

· Storing flight information.

12. Police (Law enforcement agencies).

· Computers are widely used in fighting crime.  The Police use computers to keep databases on fingerprints and also analysed them.
· The Police also use computers for face recognition, scene monitoring & analysis, which help them to arrest traffic offenders and criminals.

The information held in computers such as fingerprints, photographs and other identification details helps law enforcers to carry out criminal investigations speedily.
13. Defence.

· Computers are used in electronic news gathering, efficient communication, detecting and tracking of targets; in radar systems, warning systems & in guided missile systems.
· Computers are used in military defence equipments, e.g. Fighter jets, Rockets, Bombers, etc.

14. Multimedia applications.
· Computers are used to prepare business presentations for advertisement purposes.
The presentations are done using overhead projectors attached to computers running slide shows & digital video clips taken using a Camcorder.  An overlaid voice is used to describe the product.
· Computers are used in music related equipment such as Synthesizers.
· In entertainment (i.e., games & movies), computers are used to add stereo sound & digital video clips, which make games more realistic.

· In Education & Training, Multimedia discs are used as teaching aids for all types of subjects.

15. Domestic and Entertainment systems.

Computers are used at homes:

· For watching movies, playing music and computer games.

· For storing personal information.

· For calculating and keeping home budgets.

· For shopping purposes.  They provide people with lists of shopping items as well as their prices.  They also provide electronic money transfer facilities.

· In household items, such as, Microwave ovens, Televisions, etc. 
16. Library services.

Computers can be used in a library:

· To enable the library personnel to easily access & keep updated records of books and other library materials.
· To search for book titles instead of using the manual card catalogue.

17. Employment.

The emergence of computers has provided employment opportunities to very many people.
Review Questions.
1. Explain exhaustively the importance of computers in the following areas: 

i). Industries.

ii). Hospitals.

iii). Education
iv). Research.

v). Communication industry.

vi). Law enforcement agencies.

vii). Domestic and Entertainment.

2. Explain various ways computers have been mostly used in our country.

3. List down and explain 6 uses of computers in our society.

4. Explain the similarities and differences between human beings and computer systems.
COMPUTER LABORATORY.

Definition:

A Computer laboratory is a room that has been specially prepared to facilitate installation of computers, and provide a safe conducive environment for teaching & learning of Computer Studies.

SAFE USE & CARE OF COMPUTERS (COMPUTER HYGIENE)

Computer systems are expensive to acquire & maintain, and should therefore be handled with great care.  Most computer breakdowns are caused by failure to follow the correct instructions on use of equipment, carelessness, and neglect.
Computer hygiene involves keeping the computers in good care & order.

Factors to consider when preparing a computer laboratory.

The following factors must be considered when preparing a computer laboratory:
1. Security of the computers, programs and other resources.
2. Reliability of the source of power.

3. Number of computers to be installed, and the amount floor space available.

4. The maximum number of users that the laboratory can accommodate.
Requirements of a Computer Laboratory.

i). Standard and Enough furniture.
ii). Good ventilation.

iii). Reliable & Enough source of power supply.

iv). Free from Dust and Moisture.

v). Enough floor space.

vi). Proper cabling of electric wires.

vii). Fire fighting equipment.

viii). Good lighting equipment.
ix). Strong rooms & doors for the security of computers.
Review Questions.

1. Define a computer Laboratory.

2. Give three factors to be considered when preparing a computer laboratory.
3. What are the requirements of a computer laboratory?

SAFETY PRECAUTIONS & PRACTICES IN A COMPUTER LABORATORY.

After establishing the computer laboratory, a number of safety precautions, rules, and practices need to be observed in order to avoid accidental injury to the users, damage of computers or lack of a conducive environment for teaching and learning.
The safety precautions and practices include;

1. BEHAVIOUR IN THE COMPUTER LABORATORY.
The following rules must be followed in and around a computer laboratory.

a). Entering the computer room.
· Only authorized people should enter the computer room.
· Remove your shoes before entering the computer room to prevent dust.

· Avoid smoking or exposing computers to dust.  This is because; smoke & dust contain small abrasive particles that can damage computer components and cause wearing of the moving parts.
· Do not carry foods such as Toffees, chocolates, chewing gums, & drinks/beverages to the computer room.  

Food particles may fall into the moving parts of the computer and damage them.  Liquids may spill into the computer parts causing rusting or electrical faults.

· Collect any waste materials (e.g., paper bits) which might be lying in the computer room & put them into the dustbin.

· Avoid unnecessary movements, because you may accidentally knock down the peripheral devices.
· Computer users should be trained on how to use computers frequently.
· Computer illiterates should not be allowed to operate the computers.
· Shut the door of the computer room properly.

b). Starting and shutting down the computer.

· Always follow the proper procedure for starting & shutting down the computer to avoid loss of data and damage to computer programs.
· Avoid turning the computer on & off frequently as it is harmful.  Every time a PC is turned on, the internal components get heated and again cool down when the computer is turned off.  As a result, the circuit boards expand & contract and this can badly affect the solder-joints of the computer.
· Do not open up the metallic covers of computers or peripheral devices without permission and particularly when the computer’s power is still on.
2. PROTECTION AGAINST FIRE AND ACCIDENTS.

Fire outbreaks in the laboratory can be caused by either:

a). Inflammable chemicals, such as those used for cleaning & servicing the computer equipment.

b). Electrical faults, such as open wires or cables.
c). Smoking.
· Keep the chemicals away in a store after using them to avoid any accidents.
· Ensure that all electrical wires are properly insulated.  Open wires or cables must be properly covered with an Insulating tape or replaced with new ones as they can cause fire leading to damage of equipment.
· The computer room must always have a gaseous fire extinguisher especially those containing Carbon dioxide in case of any accidents.
Note. Water based or Powder extinguishers should not be used in the computer room because; they can cause damage to computer components.
Water causes rusting of the metallic parts and short circuits, while Powder particles normally settle on storage devices and may scratch them during read/write operations.
· Any incidence that may result in damage to equipment should be reported to the person in charge of the laboratory.
· No student should attempt to repair the equipment as this may lead to complete damage of the equipment.

3. INSULATION OF CABLES.

· All power cables in the computer room must be properly insulated and laid away from busy pathways in the room (i.e., preferably along the walls).  This prevents the user from stumbling on the cables, which might cause electric shock or power interruptions.
· System cables should be of the best quality & type, and should also be properly clipped (fixed).
· The cables should be handled carefully especially at the ends to avoid breaking the pins.

4. STABLE POWER SUPPLY.

Computers are delicate devices that require a stable source of power.
· Ensure that there is a steady flow of input power to the computer in order to prevent loss of data or information & also prevent damaging the computer’s secondary storage media.
Note.  Power from main supply is not always stable and may sometimes experience power surges or under voltage (also referred to as Brownout).  To protect the computer from being damaged due to power instabilities especially in areas where power fluctuates, avoid connecting it directly to the main supply.  Instead, it is important to connect the computer to a special power correction equipment or device such as a Stabilizer or Uninterrupted power supply /source (UPS), then connect the UPS to the main supply.
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The UPS gets charged when the main power is on.  When the main power goes off, the UPS gives some sound (usually a beep) to alert the user.
Functions of the UPS

1. It regulates power from an unstable power source to the required clean stable voltage.
2. It prevents power surges and brownouts that might destroy the computer.

3. It temporarily provides power to the computer in case of the main power failure.  This allows the user to save his/her work and shutdown the computer using the correct procedure.
4. Alerts the user of any power loss (by beeping).

To ensure that work continues even in the absence of main power, organizations that give important services such as banks, schools, & hospitals usually install devices that provide alternative sources of power such as standby generators, solar panels, rechargeable batteries, etc that automatically comes on in case of a power failure.  Such devices are referred to as Power backups.
However, note that, power from a generator must pass through a UPS before being fed to the computer, because it is also not stable.
· Ensure that all power or electrical sockets are firmly fixed.

5. BURGLAR PROOFING.

Physical access to the computer room should be restricted to ensure that only authorized persons get access to the computers.

To prevent unauthorized access to the computer room, the following controls should be implemented:
· Fit strong metallic grills and locks on the doors, windows & roofs (in case the roofing is weak).
· Lock the doors, (i.e., keep the computers in a strong room, which should remain firmly locked when not in use).
· Avoid welcoming strangers into the computer room.
· Use of Personal Identification cards.
· Use of fingerprint identification.
· Install security alarms at strategic access points so as to alert the security personnel in case of a break in.
· Use of special voice recorders that would be able to analyse the voice of a trespasser & check against the database containing the voice patterns of valid users.
· Secure/protect the computers with Passwords to minimize chances of theft.

6. VENTILATION.

Both computers and human beings emit heat energy into the environment.  Therefore, the computer room must have good circulation of air to avoid overheating and suffocation. 

Proper ventilation enables the computers to cool, and therefore, avoids damaging the electronic parts.

The following facilities can ensure proper ventilation in a room:

· The room should have large & enough windows & doors.
· Installing an air-conditioning system.
· Installing cooling fans.
· Avoid overcrowding of either machines or people in the room.
7. DUST CONTROL

· Set up the computer laboratory in a location away from excessive dust.
· Remove your shoes before you enter the computer room to prevent dust.
· The computer room should be fitted with special curtains that would reduce entry of dust particles.
· The floor should be covered with Carpets in order to absorb dust, and also absorb the noise made by chairs.
· Cover the computer devices with Dust covers when not in use or when cleaning the computer room.
NB:  If the environment is dusty, the computers should be regularly serviced to get rid of harmful dust.
The service should include; blowing dust from the System unit, cleaning the floppy drives, cleaning the Keyboard, cleaning the Monitor externally, and also cleaning all peripheral devices such as Printers and Mouse.
8. DUMP CONTROL.

Humidity in the computer laboratory must be regulated to remain at an optimum 50%.  If the humidity is low, it allows static electricity to build up and causes damage to sensitive electronic components.  Similarly, high humidity of over 70% causes rusting of the metallic parts of the computer system.
To eliminate low humidity, place humidifiers in the room, while high humidity can be controlled by installing dehumidifiers in the room.
9. HANDLING OF MATERIALS & EQUIPMENT.

Computer devices must be handled with a lot of care as they are extremely fragile and can easily get damaged.  Dropping or bumping can cause permanent damage on the device, e.g., to transport the System unit always handle it on its frame.
· Always use the manufacturer’s shipping carton when transporting the devices.
· Do not place heavy objects on the computers.
· Protect the computer devices especially the Monitor & the disks from any electrostatic discharge.
· The computer devices should not be exposed to direct sunlight or warm objects.  This causes the internal components of the computer to get heated, and as a result, effects the computer’s solder-joints.

· Students should only perform operations on the computer that they are sure of and under supervision.  If in doubt, the student should ask to ensure that no damage is caused due to lack of proper knowledge.
· Computer equipment should be regularly checked and serviced.

Floppy disk management.
Floppy disks are used to store data, and if properly taken care of, they reduce the likelihood of destroyed or corrupted data.

Note.  Data is very difficult & expensive to reconstruct, unlike application software, which can easily be re-loaded.

Handling precautions for diskettes.
1). Insert the diskette in the drive with the correct side up & in the correct direction.
The diskette should slide in easily (with no force at all) until it locks in the drive.  To remove the diskette out of the drive, press the Eject button.
2). Don’t touch the exposed surface of the diskette when inserting or removing it.
3). Don’t remove the diskette from the drive if the drive light is shining.  This indicates that the diskette is in use, and removing it might damage the files on the diskette.
4). Never leave the diskette in the computer after finishing its job.
5). Ensure that all your diskettes are labelled carefully using meaningful names that indicate the right contents of the diskette.  The labels should be applied at the slightly depressed region at the top surface of the diskette.
Labelling prevents confusing the data in the different diskettes, and also mixing diskettes that are used everyday with those used for long-term storage of important data.
6). Use a soft writing material such as a soft felt pen to write on the diskette.
7). Use the shutter at the bottom of the diskette to write-protect it in order to protect the data stored in it.
Note.  To write-protect the diskette, the shutter is pushed up until the hole is covered & no data can be written to the diskette.  To write to the diskette, the hole must be left open.
8). Avoid overusing the diskette.  If used for long (usually over 6 months), its surface wears out.
9). Never place heavy objects on the diskette to avoid damaging it.
10). Keep your disks safely away from extreme temperatures or direct sunlight, i.e., avoid placing the diskette near possible heat sources, e.g. on top of monitor displays.

11). Keep floppy disks away from any magnetic media, e.g., near power supplies & magnets.  They can corrupt the data.
12). Never carry disks in loose bags or in pockets to prevent dust from getting in & harming them.

Store your diskettes in disk banks or a proper storage jacket.  Use envelopes or enclosed polythene when carrying them.
13). Always store the disks vertically in the storage box/container.
14). Never use clips or staples to hold the disks to avoid damaging them.
15). Do not bend the diskette, or leave it lying on top of the desk.
16). Protect the diskettes against computer viruses, i.e. you should not use foreign diskettes in your computer, especially if you suspect that they might have viruses in them.
Use of Printers.

1. Different printers have different sensitivity to printing papers.  Using the wrong quality paper in a particular printer can make the paper get stuck.

2. Printers are very specific to manufacturer’s cartridges & ribbons.  Use of clones or imitations (i.e., the wrong make & model) can damage the printer mechanism.

3. Avoid refilling of cartridges or re-inking of Ribbons.  This can spoil the printer due to leakage or use of poor quality materials.
10. LABORATORY LAYOUT.

· The computer laboratory should have enough floor space to facilitate free movement from one place to another.

· The laboratory furniture must be well arranged to prevent accidents.

· Your working surface must be large enough to hold the computer equipment & any other additional items required.  This prevents squeezing the devices together & also minimizes breakages.
· The sitting arrangement of users should be proper.
11. STANDARD FURNITURE & POSTURE.

· The table/bench on which a computer is placed must be strong and wide enough to bear the weight and accommodate all the peripheral devices.
· The seat for the user must be comfortable, and have a straight backrest that allows someone to sit upright.  This prevents muscle pains & backaches caused by poor sitting posture.
· Adjust the furniture to meet your needs for comfort.
For example;

· Adjust the height of the chair or working surface so that your forearms are parallel with the floor and your wrists are straight.
· The seat must be high enough relative to the table to enable the user use the hands on the keyboard comfortably.

· The eyes must be at the same level with the top of the screen when the user is seated upright.
· You should be able to maintain your proper arm position and place your feet firmly flat on the floor.
· Adopt a relaxed, upright working posture.  Avoid slouching (bending) forward or leaning far backwards.
· The Chairs should have low back support & footrest and should also be adjustable.
Keyboard, Mouse and Input devices.

Place frequently used work materials within easy reach.

For example;

· The Keyboard, Mouse & other input devices should be positioned such that your hands are in a relaxed, comfortable position.
· Position the Keyboard directly in front of you.  This makes it possible to type with your shoulders relaxed and your upper arms hanging freely at your sides.
· Position the Mouse at the same level as the keyboard.

12. LIGHTING & VISION CARE.

A computer room must be well lit to avoid eyestrain that eventually leads to headaches, stress, and fatigue.  Similarly, when you work at your computer for long periods of time, your eyes may become irritated.  Therefore, special care should be given to your vision.

· Tilt the computer so that the display faces away from the windows.  This will minimize glare (or bright reflections) on the screen.

· Position the lighting equipment or sources of light such that glare (or bright reflections) on the display are minimized.  Where necessary, use indirect lighting to avoid bright spots on the display.
· Use/fit radiation filter screens that are specially tinted to reduce the light that reaches the eye.
· Avoid using a flickering monitor.  This causes extreme eyestrain that can damage your eyesight.
· The wall paints used should not be very bright as they reflect too much light causing eyestrain.
· Use the brightness & contrast controls on the Monitor to adjust the brightness of the computer monitor until the eyes feel comfortable, and also to improve image quality of your display.
· Turn off the screen when not in use or reduce its brightness in order to prevent screen burnout.
· If the room has windows, use blinds or shades to control the amount of daylight in the room.
· Take frequent breaks and rest your eyes.
· You should have glasses that are specifically suited for working with the computer display.

· Keep your glasses and the display clean.

· Have your eyes examined regularly by a vision care specialist.

· The distant between the user & screen should be between 450 – 500 mm.
Review Questions.

1. List down THREE safety precautions one should observe when entering a Computer laboratory.

2. Why must foods and beverages be kept out of the computer room?

3. Discuss TWO main causes of fire or accidents in the computer laboratory and give the precautions that should be taken to guard against them.

4. (a). Give Six safety precautions you should take when handling diskettes.

(b). Where should the arrow on a diskette point when being inserted into the floppy drive.

5. List THREE things that can spoil a Printer if they are not of the correct specification, and explain what damage may be caused.

6. Why are powder based and water-based fire extinguishers not allowed in the computer room? 

7. Identify three facilities that will ensure proper ventilation in a room.

8. Give THREE reasons why it is important to regularly service the computer.

9. Explain precisely how the Keyboard, mouse, and other Input devices should be arranged to avoid strain while working on the computer.

10. (a). What name is given to alternative sources of power in a computer.

 (b). Name any THREE sources of power in a computer system.

11. State two reasons why a computer needs to be connected to a stable power supply.

12. State two functions of the UPS.
13. State two reasons that are likely to cause eye-strain in the computer room.

14. Identify three proper sitting postures while using the computer.

STARTING-UP (BOOTING) A COMPUTER.
1. Before switching on a computer, make sure that all the components are properly connected, and that the computer is connected to an active power source.

2. Turn on the switch at the source of the power supply.  If your computer is connected to a constant voltage Stabilizer or an Uninterrupted power supply (UPS), turn it on after switching the main supply.  

3. Turn on the switches on the System unit and the Monitor.  Switch on the power button on the Monitor first, then followed by that of the System unit.

After the power is on, the computer automatically goes through a process called Booting.  Booting is a term used to describe the starting up of a computer.  It is the entire process that makes the computer ready for use.
Types of Booting.

There are 2 types of booting, namely;
a). Cold booting.
b). Warm booting.
Cold booting.

This happens when a computer that was originally off is switched on by pressing the power button on the system unit.
Warm booting.
This happens when a computer that was originally on is forced to restart by pressing the Restart button on the System unit or by pressing a combination of keys on the keyboard (Ctrl+Alt+Del). 

In Windows operating systems, one can use the Restart option on the Shutdown dialog box to perform a warm boot. 
When Power is switched on, the computer starts by checking all its components to determine whether they are available for use and whether they are functioning correctly.  It does this by executing a small program called the Power-On-Self-Test (POST) that is permanently stored in ROM.
POST prepares the computer for use by instructing it to perform a number of diagnostic tests when booting up.  It instructs the computer to check the memory (RAM) to make sure it is operating correctly; check the CMOS (BIOS), Hard disk controller, Floppy disk drive controller & the Keyboard.  

During this process, some monitors display information showing the status of each device being tested.  If a problem is found, e.g., in case one of the devices is faulty or missing, the process will halt and display an appropriate error message on the screen indicating to the user where the problem is located.  Sometimes, an error code is displayed with the message, or an abnormal number of beeps are sounded.

The special program that directs the POST process is called the Basic Input Output System (BIOS).
Shutting down a computer.

After finishing working with the computer, the user must follow the correct procedure of shutting down the computer in order to ensure that loss of data, damage of programs and computer components does not occur.

1. Save all the work done on the computer, and close all programs that may be currently running.
2. Remove any floppy disk you might have inserted in the computer.
3. Follow the proper shut-down procedure required before switching off the computer.
For example;

To turn off any computer running Windows operating systems:
a). Click the Start button on the screen, then select Shut Down from the list.

b). In the prompt that appears, select Shut down, then press the Enter key on the keyboard.

c). After a few seconds, the message “It is now safe to turn off the computer” appears on the screen.  Switch off the System unit, then the Monitor.

Note.  Some system units switch themselves off automatically.  In such a case, press the button on the Monitor to turn off the screen.

4. Press the button on the monitor to turn off the screen.

5. Switch off your Printer and any other output devices.

Review Questions.

1. (a). What is meant by the term ‘booting up’?
(b). Differentiate between cold booting and warm booting.

2. Write down the procedure to be followed when switching on a computer.
3. Complete the abbreviation ‘POST’ in computer technology and explain briefly its purpose.

4. List down the steps that must be followed before switching off the computer.
KEYBOARD.

The Keyboard is a computer input device by which data & instructions is typed into the computer memory.

It enables the user to enter data & instructions into the computer by pressing its keys.

Types of Keyboard.
1. Standard Keyboard – has 99 keys.

2. Enhanced Keyboard – has between 102 & 105 keys.

KEYBOARD LAYOUT.

The Keyboard of a computer consists of keys similar to those of a typewriter.  It contains the usual range of alphabetic characters (A – Z), digits 0 – 9, and other symbols frequently used to represent data items.  However, it has some command keys for giving special instructions to the computer.
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Data & programs are input into the computer by pressing the appropriate keys.  When you type data into the Keyboard devices, it converts it into machine-sensible forms.

SECTIONS OF THE KEYBOARD.

Most Keyboards have a total of 101 keys, which are divided into 5 different groups: -

(a). Function/ Command keys.

These are the keys located along the top of the Keyboard marked F1 up to F12.  They are used to issue commands into the computer.

Each of these keys is used to perform a special function in various application packages, e.g., F1 is used in most applications for help.

Function keys are used differently by different applications, i.e. their functions vary with different programs, and are therefore sometimes called Programmable Keys.

(b). Alphanumeric keys.

This section consists of alphabetic & numeric keys.  Alphanumeric keys are mostly used for typing of text.
It has the 26 letters of the English alphabet marked on them in capital letters, and Number keys arranged in their natural order from 0 – 9.  Along with these keys are Punctuation marks (comma, full-stop, etc) and some Symbols.  
At the bottom of the alphanumeric keys, is the Space bar, which is used to separate words or sentences from each other (or to create a blank space after typing each word).

(c). Numeric Keypad keys.

It is on the rightmost part of the Keyboard.  It has keys with digits (numbers) 0 - 9 marked on them in rows from the bottom upwards.
The keypad also has some mathematical symbols marked on its keys.  They include: the multiplication sign (*), subtraction sign (-), addition sign (+), division sign (/) & the decimal point (.).

The Keypad is used for fast entry of numeric data into the computer.

Note.  The numbers on the Numeric keypad can only be used when the Num Lock key is turned on.

(d). Directional (or Cursor positioning) keys.
They are used to move the Cursor (insertion point) within the window of an application.

They include; Page Up, Page Down, Home, End, & the four Arrow Keys.  

· Arrow keys:
To move the cursor one character to the right in a Word processing document, press the Right arrow key; to move the cursor one character to the left, press the Left arrow key.
To move the cursor one line up, press the Up arrow key; to move the cursor one line down, press the Down arrow key.
· Page Up & Page Down:
To move the cursor up one page in case the document has many pages, press the Page Up key; to move the cursor down one page, press the Page Down key.
· Home & End keys:
To move the cursor to the beginning of the current line, press the Home key; to move the cursor to the end of the current line, press the End key.

Editing keys.

They are used to delete or insert characters in a document.  These are:

i). Backspace key. 
It has a backward arrow (() marked on it.

· Used to erase characters to the left of the cursor (i.e., from right to left on the same line).  

When pressed, it makes the cursor move one space backwards and the immediate letter or number to the left is erased.
ii). Delete (Del) key.
It is used to erase characters to the right of the cursor, (i.e., from left to right).

iii). Insert (Ins) key.
· Used in a word processor to switch between the Insert mode & Overtype mode.  When pressed, it helps the user to insert text in the middle of a sentence or replace a character at the cursor position (i.e., overwrite the text).
(e). Special PC operation keys.

They are used in combination with the other keys or on their own to perform special functions/tasks, or to give special instructions to the computer.

Examples; Esc, Tab, Caps Lock, Shift, Ctrl, Alt, Enter, Num Lock, Scroll Lock.
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TAB key (


).

It is used in certain programs such as Word processors to move the text cursor or a certain text at set intervals on the same line to the required position on the screen, e.g., 10mm, 20mm, etc.

A Cursor is a blinking underscore ( __ ) or a vertical beam (I ) that shows where the next character to be typed will appear.

CAPS Lock.

Used to switch between capital (uppercase) letters & small (lowercase) letters.

When pressed on, an indicator with a Green light appears on the top-right hand corner of the Keyboard, and all the text typed will appear in capital letters.  When pressed off, all the text typed will appear in small letters.
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SHIFT key (      ).

This special key works in combination with other keys.
· It can be used to get single capital letters.  Hold down the SHIFT key & press an alphabet key to get the letter in its capital form. 

· It is used to get the punctuation marks on top of the Number keys or the symbols on top of certain keys especially on the alphanumeric section.

To get the punctuation mark on top of a number key or the symbol on top of a certain key; press & hold down the SHIFT key before pressing the required key.
ENTER key (↵).

· It is used as a RETURN key.  When pressed at the end of a text line or paragraph in a word processor, it forces the text cursor to move to the start/ beginning of the next line or paragraph.

· It is used to issue completion commands to the computer.  It is used to instruct the computer to carry out (execute) a command that has been typed or selected on the screen.
ESCAPE (ESC) key.

It generates special code for the computer.  In some programs, it is used when you want to quit doing some task, i.e. escape from or to cancel a task. 

CONTROL (CTRL) key.

It controls various functions in combination with other keys, e.g. CTRL+”S” is used to give the command for saving the text/object.
Commonly confusing keys.

Some key shapes cause much confusion.  If you use the wrong key, the process you are working on may not work as expected, but it may be very difficult to determine what is wrong.

The I, 1, l and o, O, 0 keys.

Look closely to spot the difference between capital “I”, one (1) and “l” (lowercase “L”), and between small “o”, capital “O” and zero “0”.

The Slash (/) and Backslash (\) keys.

The slash (“/”) is used as:
· A division symbol when writing a formula.

· A command key to get into the menus in Lotus 1-2-3.

· To separate parts of a path in a UNIX file name.

The backslash (“\”) is used:
· In Lotus 1-2-3 to fill a cell with a character.

· In MS-DOS to separate parts of a path in a file name.

The Space, Hyphen ( -) and Underscore ( _ ) Keys.

The Space is entered using the Spacebar on the keyboard.

Note.  A blank space is a printing character; it takes up memory, has an ASCII code, and is printed on the screen in the same manner as any other character.

The Hyphen key (dash or minus) & the Underscore (underline) are on the same physical key top.  To get the underscore, use the SHIFT.

The Underscore is often used in places where a space is needed to separate individual words, but is not legal in the context.  E.g., the filename TAX 1990 is illegal in MS-DOS because of the blank space between TAX and 1990, but TAX_1990 is legal.  The Underscore takes the places of the blank space.

Single & Double quote, Accent grave, and Tilde.

Single quote (‘) & Double quote (“).

Both symbols are on the same physical key top.  To get the double quote, use the SHIFT.

Accent grave (`) & Tilde (~) are found on the same key top. The Tilde is used in Mathematics, foreign languages, or in UNIX operating system to indicate the home subdirectory.

The Parenthesis (  ), Square brackets [ ], & Curly braces {  }
Each of these symbols is used differently depending on what program you are running.

Mathematical  symbols (+, -, *, /, ^).

Slash (/) 



- used for division,

Asterisk (*) 


- for multiplication, 

Plus (+) symbol 

- for addition, 

Minus (-) symbol 
- is used for subtraction, 

Up carat (^) 


- indicates exponential (raising to a power).

Practical Keyboard skills.

When using the keyboard, observe the following typing rules:
1). Sit upright with both feet firmly on the ground, maintaining an alert posture.

2). Place the material to be typed on your left in a position you can read without strain.
3). Rest both hands on the keyboard with fingers resting on the Home keys.

Home keys are the keys on which fingers rest during typing in readiness to press other keys.  The home keys for the left hand starting with the small finger are A, S, D, F with the thumb on the Spacebar, while those of the right hand are the apostrophe (‘), semicolon (;), L, K with the thumb on the Spacebar.

4). Start typing the text slowly at first, making sure you are using all the ten fingers, and that you press the key nearest to the home keys with the closest finger, e.g., to press Q, use the small finger on the left hand, while to press J, use the index finger on the right hand.
Descriptive Questions.

1. Define a Keyboard.
2. (a)
Give the TWO types of Keyboards found in the current market.

(b)
State and briefly explain the functions of five categories of keys found on a standard keyboard.

3. State the use of each the following section or combination of keys on the keyboard:

a). Function keys.
b). Numeric keypad.
c). Arrow keys.
d). Control key.
4. Name 3 main sections of the Keyboard that are used in typing.

5. What is the difference between Function keys and Special PC operation keys?

6. State the functions of the following keys on the keyboard.

i). Caps Lock.

ii). Spacebar.

iii). Shift Key.

iv). Enter Key.

v). Backspace.

vi). Delete.

vii). Escape.

viii). Num Lock.

7. Give two uses of the SHIFT key.

MOUSE.

A Mouse is a pointing device that enables the user to issue instructions to the computer by controlling a special mouse pointer displayed on the screen.
A Mouse consists of 4 parts: -

1). A Casing - to assist in holding the mouse in the hand.
2). A Roller ball – used to slide/move the mouse on a flat surface.  It also enables the cursor to move on the screen as required.
3). The Sensor Buttons (Right & Left) – used for making selections.

4). A Cable - connects the mouse to the System unit.
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Using the Mouse.

To use a mouse, hold it in your hand and move it across a flat surface or on top of a table.  When you move the mouse, an arrow-shaped pointer called the Mouse pointer moves across the computer screen in the same direction.  The pointer is usually controlled by moving the mouse.
To select an option/ item on the screen;

· Position the tip of the pointer (cursor) over the item to be selected;

· Press a button on the mouse to make your selection.
When using the mouse, observe the following rules:
a). Place the mouse on a flat smooth surface.
b). Gently hold the mouse with your right hand, using the thumb and the two rightmost fingers.

c). The index finger should rest on the left button, while the middle finger rests on the right button.

Terminologies associated with the use of a Mouse.

Point: - this means moving the mouse until the tip of the pointer on the screen is over the item you want to select.
To select an item on the screen, point the item, then press a mouse button.  Use the Left button (Primary button) for most tasks or the Right button (Secondary button) to quickly accomplish common tasks. 

Clicking: - pressing & releasing the left mouse button once.  A click usually selects an object/item on the screen.
Double-clicking: - pressing the left button twice in a row (in a quick succession) without moving the mouse.  Double-clicking usually opens a file or starts a program.
Right-clicking: - pressing the right mouse button once (or, selecting an item by use of the right mouse button).  
A right click usually displays a list of commands from which the user can make a selection.  This list of commands is called a Shortcut menu or Context-sensitive menu.  This is because; the commands on this menu apply to the specific item that has been right-clicked.
Shortcut menu:
· A list of commands that appears when you right-click an object.
· A menu that shows a list of commands specific to a particular right-clicked item.

Drag and drop: This is whereby the user moves an item from one location on the screen to another.
To move an item on the screen by dragging;
1. Point to the item you want to drag.

2. Press & hold down the left mouse button.
3. Slide the mouse until the pointer reaches the desired position on the screen while still holding down the mouse button.

4. Release the mouse button to ‘drop’ the item in its new location.
Review Questions.
1. What makes a mouse move a pointer on the screen?

2. State THREE advantages of using a Mouse instead of a keyboard.
3. Explain the meaning of the following terms associated with the use of a mouse:
(a). Mouse pointer.

(b). Clicking.
(c). Double-clicking.

(d). Right-clicking.

(e). Drag and drop.

4. Distinguish between:
(a). Click and right-click. 

(b). Double-clicking and dragging.

5. What is a Shortcut menu?
COMPUTER SYSTEMS

System

A system can be defined as a collection of interrelated components that work together towards a collective goal. The function of a system is to receive inputs and transform them into outputs.
Information System

An information system is a system that accepts data resources as input and processes them into information products as output. 
Computer System

A computer system is a collection of entities that work together to process data and manage information using computers.

Components of a computer system

A computer system consists of three main components namely;

(i) People (liveware/orgware)


People are required for the operation of all computer systems. These people resources include end users and specialists.

· End users (also called users or clients) are people who use computer system or the information it produces. They can be accountants, salespersons, engineers, clerks, customers, or managers. Most of us are information system end users.

· Computer Specialists are people who develop and operate computer systems. They include systems analysts, programmers, computer operators etc. 
(ii) Hardware


Computer hardware includes all physical or tangible components of a computer system. Examples of computer hardware are:
· Central Processing Unit

· Input devices e.g. keyboard, mouse

· Output devices e.g. printers and monitors

· Secondary storage devices e.g. hard disks and flash disks
(iii) Software


Computer software refers to the instructions that tell the computer hardware how to perform a task. 

COMPUTER HARDWARE

The hardware elements of a computer are generally grouped into four major categories namely:

· Input devices

· The Central Processing Unit (CPU)

· Output devices

· Secondary Storage devices

The diagram below shows functional organization of the computer hardware.
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INPUT DEVICES

Input devices are computer hardware that translates data from human readable into a form that the computer can process. In other words, input devices allow people to put or enter data into the computer in a form the computer can use. The human-readable form may be words like the ones in these sentences but the computer-readable form consists of binary 0s and 1s, or on and off signals. 

Input devices can be classified according to how they are used to enter data. These include:

· Keying devices 

· Pointing devices

· Scanning devices

· Speech/Voice recognition devices

· Digital devices

Keying devices

Keying devices are input devices are input hardware that convert numbers and other characters into machine readable from. Keying devices include keyboard and keypad. Key pads are found on devices such smart phones and ATMs (Automatic Teller Machines). 

Because keying devices require typing by people, the data input this way is less accurate than data input via non-keyboard source data entry devices.

Pointing devices

One of the most natural of all human gestures is the act of pointing. This concept is incorporated in several kinds of input devices. The pointing devices used with microcomputers are the mouse, the trackball, the joystick and the touchpad all of which have variations. All pointing devices have the same purpose; allowing the user to move the cursor (or pointer) around the screen and to click to select items or perform other functions. 

Mouse

A mouse is a device that is rolled about on a desktop to direct a pointer on the computer’s display screen. Its name is derived from its shape, which looks a bit like a mouse, its connecting wire that one can imagine to be the mouse's tail, and the fact that one must make it scurry along a surface. When you move the mouse on the desktop, the pointer on the screen moves in the same direction.  The mouse pointer is the symbol that indicates the position of the mouse on the display screen. The pointer will change from an arrow to a pointing finger icon depending on the task you are performing. It also changes to the shape of an I-beam to indicate where text or other data may be entered.

Mice contain at least one button and sometimes as many as three, which have different functions depending on what program is running. Some newer mice also include a scroll wheel for scrolling through long documents. The movement of the mouse over a flat surface is mirrored by a pointer on the monitor screen. Buttons on the mouse allow you to make selections from the menus, move objects around the screen and paint or draw.
Types of Mice

Mechanical Mice
Mechanical mice use a rubber-coated ball that contacts the mouse pad. Moving the mouse causes the ball to move, which in turn causes one or both of the internal cylindrical rollers with which the ball is in contact to move. 

Advantages
· Mechanical mice are inexpensive. 
Disadvantages
· They require frequent cleaning since the ball can get dirty. Dirt causes the mouse pointer to move erratically. 
· They provide limited resolution
· They are unreliable because of many moving parts
Optical Mice 

Optical mouse uses an optical sensor instead of the mouse ball. It emits a small beam of red light which bounces off the surface into a sensor. The sensor sends co-ordinates to the computer which in turn moves the cursor or pointer on the monitor screen, according to these co-ordinates.

Advantages

· Do not require frequent cleaning as mechanical mice.

· More reliable because of the reduced number of moving parts

· Can slide over most surfaces since it does not have a ball.
Disadvantages

· They are more expensive than mechanical mice

Cordless Mouse
The cordless mouse uses the wireless communication technology (via infrared, radio or Bluetooth) to transmit data to the computer. And like the wireless, it doesn’t use any cord.

Mouse Terminology
The terms you are most likely to encounter when using a mouse or a trackball are as follows:
Point
To move the pointer to the desired spot on the display screen such as over a particular word or object.
Click 
Tap – that is press and quickly release the left mouse button. A click often selects an item on the display screen.
Double Click
Tap – press and release the left mouse button twice in quick succession. A double click often opens a document or starts a program.

Right Click
Tap – press and release the right mouse button. Right clicking brings up a pop-up menu with options available to the object over which the cursor is positioned.
 Shift Click 
Press and release the left mouse button while holding the Shift key down. Shift clicking enables you to select multiple items.

Drag 
Press and hold the left mouse button while moving the pointer to another location.

Drop
Releasing the mouse button after dragging

Trackball 
Another pointing device, the trackball is a variant on the mouse. A trackball is a movable ball on top of a stationary device that is rotated with the fingers or palm of the hand. A trackball looks like a mouse turned upside down. To move the pointer, you rotate the ball with your thumb, your fingers, or the palm of your hand. There are usually one to three buttons next to the ball, which you use just like mouse buttons. 
The touchpad
The touchpad contains a touch-sensitive pad and is normally found on laptops. It is a pressure- and motion-sensitive flat surface about the same size as a mouse over which you move your fingers to control the cursor/pointer on the screen. Buttons placed close to this surface allow for selection of features on the screen.
The Pointing Stick 

A pointing stick is a pointing device first developed by IBM for its notebook computers. Most pointing sticks are pressure-sensitive, so the pointer moves faster when more pressure is applied. The pointing stick found on laptop computers looks like a pencil eraser. It protrudes from the keyboard between the B, G and H keys. Pushing on the pointing stick with your finger will move the pointer around the screen. Once again, buttons placed close by allow for selection of features on the screen.
Joysticks

A joystick is an input device consisting of a stick which lets you control the movement of an object on the screen by operating a small lever. It is used mainly for computer games such as flight simulators and occasionally for CAM/CAD systems. Special joysticks are also available for people with disabilities that don’t let them use a mouse or a trackball.
Light pen

The light pen is a light-sensitive stylus or pen-like device connected by a wire to the computer terminal. It allows you to point and make selections more accurately on a screen. The tip of the light pen contains a light-sensitive element which, when placed against the screen, detects the light from the screen and enables the computer to identify the location of the pen on the screen. Making selections with a light pen is far more accurate than using your finger to make selections on a touch sensitive screen. Light pens also allow the user to draw directly on the screen. However, they are not as accurate as a digitising tablet and drawing can become uncomfortable.

Digitising tablet (graphics tablet)

A digitising tablet is a board which can detect the position of a pointing device such as a stylus or a puck on its surface. A stylus is a pen-like pointing device for a user sketches an image on the graphics/digitising tablet. A puck is a copying device with which the user traces or copies an image. The images the user sketches are displayed on the computer screen. Digitizing tablets are used primarily in graphics design, computer animation and engineering.

Pen-Based Systems
Pen-based computer systems use a pen-like stylus to enter handwriting and marks into a computer. Small handheld computers called PDAs (Personal digital assistants) use pen-based input.
Touch Screens

A touch screen is a video display screen that has been sensitized to receive input from the touch of a finger. Behind the screen, which is covered with a plastic layer, there are invisible beams of infrared light. The user can input a request for information by pressing on displayed buttons and then see the requested information displayed as output on the screen.

Touch screens are often used in automatic teller machines, in directories displaying tourist information in airports and hotels, in fast-food restaurants to select menu items and in preschool multimedia education.

SOURCE-DATA (DIRECT) ENTRY

Source-data input devices do not require keystrokes to input data to the computer. Data is entered from as close to the source as possible; people do not need to act as typing intermediaries. Source-data entry devices include scanning devices, voice recognition input devices and digital input devices

Scanning Devices

Scanners are input devices that use laser beams and reflected light to translate hardcopy images of text, drawings and photos into digital form. The images can then be processed by a computer, displayed on a monitor, stored on a storage device, or communicated to another computer.  Scanning devices can be classified according to the technology they use to capture data. These are optical scanners magnetic scanners.

Magnetic Scanners

Magnetic scanners capture by using magnetic technology. Magnetic scanners include: magnetic-ink character recognition (MICR) and magnetic stripe.

Magnetic-Ink Character Recognition (MICR)
Magnetic-Ink Character Recognition (MICR) is a scanner that translates the magnetically charged numbers printed at the bottom of bank cheques and deposit slips. MICR characters, which are printed with magnetized ink, are read by MICR equipment, producing a digital signal. This signal is used by a bank’s reader/sorter machine to sort cheques.
MICR is mainly used in the banking industry to read/sort cheques. Bank cheques have the following information encoded in them:

• The cheque number

• The bank branch number

• The customer’s account number.
Magnetic stripe codes

A magnetic stripe is a short length of magnetic coated tape printed on the surface of or sealed into a ticket or card. It contains information to identify the ticket or card and its user. 
The card is read by swiping it – moving the magnetic strip through a reader so that the strip can be read. Such stripes are found on bank cards which identify the card holder’s bank account, so that the card holder can perform banking transactions.
Cards with these magnetic stripe codes can provide quick identification of people entering buildings, allowing access to the card holder. These cards are therefore used for security purposes too. Examples of other uses are in phone cards and debit cards for cell phones. The magnetic stripe in this instance contains information about the amount of money left ‘on’ the card.
Optical Scanners

Optical scanners capture data using light. A special type of concentrated light is passed over the object, image or text that needs to be input. These types of scanners include: image scanners, Optical Character Recognition (OCR), Optical Mark Recognition (OMR) and Bar-Code Readers.

Image ((Graphics) Scanners

Image scanners are scanners that convert text, drawings and photographs into digital form. They were originally designed to scan pictures (image scanners) but now their use is extended, for example to scan text into a word processing program. Image scanners are used in document management, desktop publishing (DTP), and multimedia development.
There are many types of scanners:

· Flat-bed scanner: This is a type of optical scanner that consists of a flat surface on which you lay documents to be scanned. Flatbed scanners can scan single sheets and book-bound pages. The picture is placed on a flat scanning surface and the image is captured, similarly to how a photocopying machine works. 
· Hand-held scanner: This is a type of scanner that is rolled by hand over the documents to be scanned. These scanners are generally used to scan in small images or parts of images. Their resolution is not very high.

· Drum scanner: This is a type of scanner used to scan one sheet at a time. They cannot handle book-bound pages.
· Sheet-fed scanner: This is a scanner that allows only paper to be scanned rather than books or other thick objects. The sheet that contains the image is fed through rollers and the picture is scanned as the paper passes through.

Optical Mark Reader (OMR)
Optical Mark Recognition (OMR) uses a device that reads pencil/soft pen marks and converts them into computer usable form. OMR technology scans a printed form and reads predefined positions and records where marks are made on the form. 

OMR detects the position of black marks on white paper. The documents to be read have empty boxes pre-printed on them. The user makes pencil or ink marks in the appropriate boxes. The intensity of the reflected light from these marks on the form is detected by the OMR. This is sometimes called mark sensing. The computer records the position of the marks and analyses it to determine the meaning of the data. OMRs are used mainly in assessing multiple-choice examinations such as Kenya Certificate of Primary Education (KCPE), questionnaires given out by researchers or ballot papers.

This technology is also useful for applications in which large numbers of hand-filled forms need to be processed quickly and with great accuracy, such as surveys, reply cards, questionnaires and ballots. 
Optical Character Recognition (OCR)

OCR (optical character recognition) uses a device that reads special OCR character set called fonts as well as typewriter and computer-printed characters and converts them into machine-readable from. Some advanced OCR systems can recognize human handwriting but the letters must be block printed.

Examples that use OCR characters are utility bills and price tags on department-store merchandise.

 OCR is being used by libraries to digitize and preserve their holdings. OCR is also used to process checks and credit card slips and sort the mail. 

Barcode readers

A barcode is a set of vertical lines of differing thickness with a string of numbers printed at the bottom found on most manufactured and retail products. You can see barcodes on items in supermarkets, books in libraries and on such things as magazines. The barcode is read by an optical scanner (barcode reader) in which a laser beam scans the barcode and the light is reflected back into the scanner. The information received by the scanner is sent to a computer for processing. 
Barcodes form part of the Point of Sale (POS) system usually found at retail outlets. A terminal is connected to a central computer which records details after the barcode of an item has been scanned. The price of the product is displayed on a monitor at the point of sale. Meanwhile the central computer calculates the amount due, including VAT, and prints an itemised receipt. The information recorded can also be used for stock control and sales analysis.
Radio frequency identification (RFID) uses radio waves as a means of identifying animals, persons and objects. A chip connected to a small antenna makes up the RFID transponder or RFID tag. Information such as a serial number is transmitted to an RFID receiver that converts the radio waves to digital information so that it can be processed by the computer.
RFID chips are used for tracking animals, for example, as they can be embedded in the skin of the animal and the tag can be read once the animal is within range of the reader. Some stores are now tagging their merchandise with RFID tags to record POS information, and also as a means of security to reduce theft. Alarms can be raised when someone tries to exit a store without paying for an item. 
Smart cards

In recent years, new means of storing data on cards have become available. ‘Smart’ cards with very thin gold-coloured memory chips sealed into them can store more information than magnetic stripe cards. Data is stored on the memory chip embedded in the card, allowing a greater amount of information to be kept and updated on the card than would be the case with the old-style magnetic stripe. The chips can hold information for cell phone use, debit and credit cards, and any prepaid services. Eventually, smart cards may store information about a person’s driving history, their birth certificate or paper, and could even be imprinted with the holder’s voice, fingerprints and retinal scans.
Optical Cards
These are plastic, laser recordable, wallet-type cards used with optical card readers. They can store much more data than smart cards and may become more popular in future.

Audio and video input devices

Voice data entry/voice recognition

Voice recognition systems require the use of a microphone. This system accepts the spoken word as input data or commands. Human speech is very complex, because it carries tones, inflections and emphasis of various parts of words and phrases. The computer is programmed to recognise certain patterns of speech. Using a microphone, human speech is coded into a sequence of electronic signals. These signals are compared to a set of stored patterns. If they match, the command or data being entered is accepted by the computer and is processed. 
Simple commands can be used to control machines or even ‘type’ letters in a word processor. Voice recognition has become important in many areas of our lives. It has made life easier for people with movement difficulties, such as the paralysed, who with suitable equipment can now operate a wheelchair, lighting and even open doors using voice commands.
Sound capture

All modern computers contain a built-in microphone for sound capture. This means that you can record your voice, for example, to make comments that are embedded in a word processing document. A sound card on your computer is required for recording voice or music. The sound card digitises the information into a form that the computer can understand.
MIDI instruments

Electronic musical instruments can have a MIDI port (Musical Instrument Digital Interface) for input into the computer. The sounds are digitised and stored as a file, can be displayed on screen, edited and played back, using appropriate software.

Digital input devices

Digital cameras

Digital cameras capture an image and store it in memory within the camera. These cameras have a sensor that converts the light into electrical charges. The processor in the camera converts this information into digital data and stores it on a small diskette, flash memory or flash RAM card. The digital images can then be uploaded from the camera to a computer where they can be displayed, manipulated or printed. The memory can be erased so that more images can be captured. Unlike normal RAM memory where the information is lost when the computer is switched off, flash RAM is non-volatile. That is, the images are not lost when the camera is switched off. The resolution of the camera is measured in pixels. The larger the number of pixels the camera has, the clearer the image and the greater the detail captured. 
Digital video camera (Digital video camcorder or DVD camcorder)

In the digital video camera, light is focused onto an image sensor called a charge-coupled device which contains thousands of light-sensitive diodes called photo sites. These detect the light intensity and record an image. The digital video camera/camcorder detects not only light intensity but also levels of colour to reproduce a coloured image. The camera takes many pictures per second to give an impression of movement.

Remote control
A remote control emits a beam of infra-red light that carries data signals. Commonly used for input to televisions, stereo systems, VCRs and DVD players, they are now being used by computers as a wireless means of communication.
Sensors

A sensor is an input device that collects specific kinds of data directly from the environment and transmits it to a computer. Although you are unlikely to see these devices connected to a computer, they exist all around us. Sensors convert chemical or physical changes in humans and their environment to electrical signals that can be passed to a computer, where it is analysed, stored and manipulated by special software. Sensors are useful in the fields of medicine, environmental planning and preservation, weather reporting, and so on. A variety of sensors can be used to measure such things as heat, light, sound, pressure, strain, acidity (pH), oxygen concentration, humidity, pulse, water level, water flow, speed, tilt or even something like a door or a valve opening or closing.
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How a sensor system works

Human-Biology Input Devices

Characteristics and movements of human body when interpreted by sensors, optical scanners, voice recognition and other technologies can become forms of input. Examples include:

Biometric systems

Biometrics refers to the science of identifying an individual through their body characteristics such as face geometry and hand geometry (e.g. fingerprints), iris or retinal scans, veins and voice patterns. All these forms of identifying an individual can be input into a computer system set up for security purposes. In the near future they may become common, for allowing access to buildings and bank accounts. Retinal scans use a ray of light directed into the eye to identify the distinct network of blood vessels at the back of the eye. Fingerprint readers scan the imprint made by the pattern of ridges on the finger and compare it to a set of patterns stored in memory. Fingerprints are considered unique, as no two individuals have the same fingerprint.
Line-of-Sight Systems


Line-of-sight systems enable a person to use his/her eyes to point at a screen. This technology allows users with physical disabilities to direct a computer. This is accomplished using a video camera mounted beneath the monitor in front of the viewer. When the user looks at a certain place on the screen, the video camera and the computer translate that location into screen coordinates.

Terminals

People working on a large computer system are usually connected to the main or host computer via terminals. A terminal is an input/output device that uses a keyboard for input and a monitor for output. There are two types of terminals:

· Dumb: A dumb terminal can only be used to input data to and receive information from a computer system; it cannot do any processing on its own.

For example, airline clerks use dumb terminals at airport ticket and check-in counters.
· Intelligent:  An intelligent terminal has built-in limited processing capability and RAM but does not have its own storage capacity. Intelligent terminals are not as powerful as microcomputers and are often found in local area networks where users share application software and data stored on the server. Examples of intelligent terminals include ATMs and Point-of-Sale (POS) terminals.

· The Automated Teller Machines (ATM)
ATM is a terminal that reads the encoded magnetic stripe on the ATM card and provides output in the form of display on a monitor and printed records of transactions.

· Point-of-Sale (POS) terminals
A POS terminal combines input capabilities of a cash-register-type keypad, an optical scanner for reading barcodes, and/or a magnetic stripe reader for reading credit cards with output capabilities of a monitor and a receipt printer. POS terminals are usually hooked up to a central computer for credit checking and inventory updating. POS terminals are found in most supermarkets.
The Processing Hardware

Data in a computer is processed by the circuitry known as the processor. In large computers such as mainframes, the processor along with the main memory and other basic circuitry is called the Central Processing Unit (CPU). In microcomputers the processor is often called the microprocessor because it is made of a tiny silicon chip. The processor works hand in hand with other circuitry known as main memory and registers to carry out processing.
The Central Processing Unit (CPU)
The Central Processing Unit (CPU) which is considered as the “brain” of the computer is the most important component of the computer and without it the computer cannot process data. It is the centre of all processing that happens in the computer system. The CPU continually receives instructions to be executed. 
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Modern CPU's are called 'integrated chips' or microprocessors. The idea of an integrated chip is that several processing components are integrated into a single piece of silicon fixed on the motherboard. A CPU is plugged in a CPU socket on the motherboard, on top of the CPU is placed a heat sink and a fan which must run whenever the CPU is in use to keep it cool. Cooling is necessary because the CPU generates a lot of heat as it processes data, and for it to function properly and to prevent it from crashing, it must be cooled.
Parts of the Processor
The processor follows the instructions of the software to manipulate data into information. A CPU has three functional units namely; the Control unit, the Arithmetic/logic unit and the main memory. These components are connected by a kind of electronic roadway or pathway called a computer bus.
The Arithmetic/Logic Unit (ALU)
The arithmetic and logic unit (ALU) performs arithmetic operations and logical operations and controls the speeds of those operations. Arithmetic operations include: addition, subtraction, multiplication, and division.

Logical operations are comparisons.  These operations involve comparing one data item with another, and determine if the first item is greater than, equal to, or less than the second item.

Logical operations work with conditions and logical operators such as AND, OR, and NOT. Some common logic comparison symbols include the following;

Operator
Meaning
= 

equal to

< 

Less than

> 

Greater than

<= 

less than or equal to

>= 

greater than or equal to

<> 

not equal

The Control Unit (CU)
The control unit controls the computer operations by directing the flow of information into the CPU and/or memory or storage and controlling or determining which instructions the CPU will execute next. 

The functions of the CU include:

1. It tells the rest of the computer system how to carry out a program’s instruction.

2. It directs movement of electronic signals between main memory and ALU

3. It directs movements of electronic signals between main memory and the input devices, output devices and secondary storage devices.
4. It instructs the arithmetic logic unit which logical or arithmetic operation is to be performed. 

5. It co-ordinates the activities of the ALU and main memory as well all peripherals and auxiliary storage devices linked to the computer.

Computer Bus (System Bus)
A computer bus also known as the system bus is an electronic pathway through which bits are transmitted within the CPU and between the CPU and other devices in the system unit. The wider the computer bus, the wider it operates. There are three kinds of buses namely; Data bus, address bus, and the control bus. 

Data Bus
The data bus carries the data between the processor and other components. The size of the data bus determines the amount of data that can be transmitted simultaneously.
Address Bus

The address bus is a collection of wires connecting the processor with main memory that is used to identify particular locations (addresses) in main memory.
Control Bus
The control bus is used by CPUs for communicating with other devices within the computer by carrying commands from the CPU and returns status signals from the devices. 

Main Memory (Primary Memory)
The main memory or the primary memory is part of computer hardware where the processor or the CPU directly stores and retrieves information from. This memory is accessed by CPU in random fashion; this means that any location of this memory can be accessed by the CPU to either read information from it or to store information in it.


The primary memory itself is implemented by two types of memory technologies namely; Random Access Memory (RAM) and Read Only Memory (ROM). 
Random Access Memory (RAM)

Random Access Memory (RAM) is a temporary working storage. This means that RAM is the computer’s ‘work space’ or ‘desk area’ where data and programs needed for immediate processing are held. Computer memory is contained on memory chips mounted on the motherboard. Memory capacity is important because it determines how much data can be processed at once and how big and complex the program used to process data can be.

Functions of RAM

· It holds data waiting processing

· It holds the instructions (programs) for processing the data.

· It holds data that has been processed (information) and is waiting to be sent to an output, secondary storage, or communication devices.

Characteristics of RAM

· RAM is a temporary storage whose contents are lost when the power is turned off. Thus RAM is volatile.
· RAM is a random access memory i.e. the memory is accessed by the processor in a random fashion.
· The size of RAM determines how much data can be processed at once and how big and complex a program a program may be used to process the data.
Types of RAM

Random Access Memory (RAM) is available in two types: Dynamic Random Access Memory (DRAM) and Static Random Access Memory (SRAM).
Dynamic RAM (DRAM)

Dynamic random access memory (DRAM) is the most common kind of main memory in a computer. It is a prevalent memory source in PCs, as well as workstations. Dynamic random access memory is constantly restoring whatever information is being held in memory. It refreshes the data by sending millions of pulses per second to the memory storage cell. DRAM's density makes it a better choice for RAM. 
Static RAM (SRAM)

Static Random Access Memory (SRAM) is the second type of main memory in a computer. It is commonly used as a source of memory in embedded devices. Data held in SRAM does not have to be continually refreshed; information in this main memory remains as a "static image" until it is overwritten or is deleted when the power is switched off. Since SRAM is less dense and more power-efficient when it is not in use; it is therefore a better choice than DRAM for certain uses like memory caches located in CPUs. 
Read Only Memory (ROM)
ROM also known as firmware is "built-in" computer memory containing data that normally can only be read, not written to. Thus ROM cannot be erased or written on by a computer user. One of the ROM chips in a microcomputer contains instructions that tell the processor what to do when you first turn on or boot the computer. These instructions are called the ROM bootstrap. Another ROM chip helps the processor transfer information between the keyboard, screen, printer and other peripheral devices to make sure all units are functioning properly. These instructions are called ROM BIOS or Basic Input/Output System. Unlike a computer's random access memory (RAM), the data in ROM is not lost when the computer power is turned off. Thus ROM is non-volatile. ROM is sustained by a small long-life battery in the computer. 

Types of ROM

· Mask-Programmed ROM
Classic mask-programmed ROM chips are integrated circuits that physically encode the data to be stored, and thus it is impossible to change their contents after fabrication.

· Programmable Read Only Memory (PROM) are blank chips on which the user using a special device called a PROM programmer can write programs. Once a program is written, it cannot be erased.
·  Erasable Programmable Read Only Memory (EPROM) can be erased by exposure to strong ultraviolet light (typically for 10 minutes or longer), then rewritten with a process that again needs higher than usual voltage applied. Repeated exposure to UV light will eventually wear out an EPROM, but the endurance of most EPROM chips exceeds 1000 cycles of erasing and reprogramming. EPROM chip packages can often be identified by the prominent quartz "window" which allows UV light to enter. After programming, the window is typically covered with a label to prevent accidental erasure. 
· Electrically Erasable Programmable Read Only Memory (EEPROM) is based on a similar semiconductor structure to EPROM, but allows its entire contents (or selected to be electrically erased, then rewritten electrically, so that they need not be removed from the computer (or camera, MP3 player, etc.). Writing or flashing an EEPROM is much slower than reading from a ROM or writing to a RAM.
Special Purpose Memories

Apart from ROM and RAM there are other types of special purpose memories found inside the CPU or in the input and output devices. These memories are very vital because they enhance the overall performance of the processor. These memories include: cache memory, registers and buffers.

Registers
Registers are special high-speed temporary storage locations within the CPU that store data during processing and provide working areas for computation. Registers are found within the CU and the ALU.

Cache Memory

Cache (pronounced cash) memory is extremely fast memory that is built into a computer’s central processing unit (CPU), or located next to it on a separate chip. The CPU uses cache memory to store instructions that are repeatedly required to run programs, improving overall system speed. The advantage of cache memory is that the CPU does not have to use the motherboard’s system bus for data transfer. Whenever data must be passed through the system bus, the data transfer speed slows to the motherboard’s capability. The CPU can process data much faster by avoiding the bottleneck created by the system bus. 
The performance of cache memory is highly affected by its level. The level of cache to refers to its connecting circuits or electronic pathways (bus) and physical proximity to the CPU. 
Buffers

This is a temporary holding place that maybe part of the CPU or built-in an input or output device. Because the CPU is very fat compared to input and output devices, buffers provide temporary storage so that the CPU is free to carry out other activities instead of waiting for all data to be entered or information to be output. For example, printer buffers temporarily hold the output to be printed thus freeing the CPU to perform other functions.

Video Memory (Video RAM or VRAM)
VRAM chips are used to store display images for the monitor. The amount of video memory determines how fast images appear and how many colours are available. Video memory chips are particularly desirable if you are running program that display a lot of graphics. VRAM chips are usually located on a special video adapter card inserted in an expansion slot on the system board.

Flash Memory (Flash RAM cards)

Flash memory consists of circuitry on credit-card size cards that can be inserted into slots connecting to the motherboard. Flash RAM is derived from EEPROM and is used primarily in portable computers. Unlike RAM chips, flash memory is non-volatile. Flash memory can be used to simulate main memory and also to supplement or replace hard disk drives for permanent storage.
Memory Capacities

The following terms are used to express computer capacity.

· Bit: This is the smallest unit of measurement in a computer. Bit refers to a binary digit – either 0 or 1.

· Byte: To represent letters, numbers, or special characters such as ! or * bits are combined in groups. A byte refers to a group of eight bits and a byte represents one character, digit or value.

· Kilobyte: A kilobyte (K, KB) is about 1000 bytes or precisely 1024 bytes.

· Megabyte: A Megabyte (M, MB) is about 1 million bytes (1,048,576 bytes).

· Gigabyte: A Gigabyte (G, GB) is about 1 billion bytes (1,073,741,824 bytes).

· Terabyte: A Terabyte (T, TB) is about 1 trillion bytes (1,009,511,627,776 bytes)

· Petabyte: A Petabyte is a new measure that accommodates the huge storage capacities of modern databases. A petabyte represents about 1 million gigabytes.

THE SYSTEM UNIT

The system unit is the box or the cabinet that contains the microcomputer’s processing hardware and other components. The most important of these components include the power supply, mother board,  central processing unit (CPU), or microprocessor, RAM chips, ROM chips, Cache memory, VRAM, Ports, expansion slots and boards and bus lines and PC slots and cards.

THE POWER SUPPLY

The electricity available from a standard wall outlet is AC but a computer runs on DC. The power supply is the device that converts power from AC (Alternating Current) to DC (Direct Current) to run the computer. The on/off switch in your computer turns on or shuts off the electricity to the power supply. Because electricity can generate a lot of heat, a fan inside the computer keeps the power supply and other components from becoming too hot.
THE MOTHERBOARD
The motherboard or system board is the main circuit board in the system unit. This board acts as a container for the different components in the system unit such as the CPU, ROM chips and RAM chips.

RANDOM ACCESS MEMORY (RAM) CHIPS
These are integrated circuits that temporarily store data and instructions that will be processed shortly by the processor.  Memory chips are factory-fixed on a small circuit board (module). The circuit board has an edge pin connector which is fitted in a memory socket (slot) on the motherboard, and anyone can install them. RAM cards are manufactured with different speeds depending on the memory chips installed on them for example, 128 MB, 256 MB, 512 MB, 1024 MB and more. RAM modules are either SIMM or DIMM RAM modules. 

ROM CHIP
The ROM chips fixed on the motherboard, contain instructions, which are specific for that particular system board, the PC cannot write new data to those chips. All PC's have instructions in ROM chips or ROM BIOS chips on the system board, usually start-up instructions of the computer. The ROM chips are supplied by specialty software manufacturers, who make BIOS chips. 

Memory Slots
Modern computer system board slots support either DDR (184 pins) or DDR2 RAM (240 pins), which is becoming the more popular type of memory. Slots usually come either two or four to a board, and are often color-coded to tell you where to place matching memory cards. This means that more than one memory card can be fixed on a motherboard.

CMOS
CMOS (complementary metal-oxide semiconductor) memory is a special type of memory chip that is used to store information about the computer system configuration, such as the amount of memory, the type of peripheral devices (keyboard, mouse etc.) installed on the computer, and the capacity of disk drives fixed on the computer. CMOS also keeps track of the date and time. The system information in the CMOS memory is needed each time the computer is started. CMOS memory has very low electricity requirement and is powered by a battery known as the CMOS battery fixed on the motherboard. The battery power enables CMOS memory to retain the stored information even when the power to the computer is turned off, which is why your computer clock runs even when the computer is off. Information in the CMOS is changed whenever installation of a device is done.

EXPANSION SLOTS (BUS SLOTS) AND CARDS
They are sockets on the motherboard into which you can plug expansion cards. Expansion cards (adapter cards) are circuit boards that provide more memory or control peripheral devices. Examples of expansion cards are:

· Memory cards: Memory expansion cards (memory modules) allow you to add RAM chips giving you more memory.

· Video adapter cards: These cards allow you to adapt different kinds of colour display monitors for your computer.

· Graphics accelerator cards: These cards improve the performance of your computer when displaying graphics.

To install a new adapter card in your computer, you must plug the card into a bus slot to enable the new device to communicate with the rest of the computer system.
VIDEO MEMORY (VRAM)

VRAM chips are used to store display images for the monitor. The amount of VRAM determines how fast images appear and how many colours are available. VRAM chips are usually located on a special video adapter card inserted in an expansion slot on the system unit.

FLASH MEMORY (FLASH CARDS)

Flash memory is derived from EEPROM and is primarily used in portable computers. It consists of a circuitry on credit-card-size cards that can be inserted into slots connecting to the motherboard.

THE MICROPROCESSOR
Most of today’s microprocessors chips are of two kinds; those made by Intel and those made by Motorola although that situation may be changing.

Output Devices

Output hardware consists of devices that translate information processed by the computer into a form that humans can understand. Thus the function of output devices is to provide the user with the means to view and use information produced by the computer system. 
Information is output in either hardcopy or softcopy form. Soft copy or temporary output refers to information displayed on a screen or in audio or voice form through speakers. This kind of output is not tangible and disappears when the computer is switched off. Hard copy output or permanent output refers to output printed on paper. This kind of output is tangible; the output can be held in your hand.
Soft copy output devices

Monitor/Visual Display Unit (VDU)/Screen
Monitors are softcopy output devices that many people use most. Monitors can output still or moving pictures. Monitors run under the control of a graphics display adapter card plugged into an expansion slot on the motherboard. The adapter allows information to leave the computer and appear on the monitor. The display adapter comes with its own RAM, called VRAM or Video RAM. VRAM controls the resolution of images displayed on the monitor as well as the number of colours and the speed at which the images are displayed. The more video memory you have, the higher the resolution and the more colours you can display. Images and text are formed by many tiny dots of coloured light called pixels (short for picture element). A pixel is the smallest unit on the screen. It can be turned on or off or coloured in different shades. Pixels are so numerous that when placed together in certain patterns they appear to form a smooth image on the screen, be it a character in a word, a diagram or a photograph. There are two types of monitors: cathode ray tube (CRT) and flat panel display.

Cathode Ray Tube (CRT) 
A cathode ray tube (CRT) is a vacuum tube used as display screens in a computer or video display terminals. This same kind of technology is found not only in desktop computer screens but also in TVs and flight-information monitors in airports. A stream of bits defining the image is sent from the CPU to the CRT’s electron gun, where the bits are converted to electrons. The inside of the front of the CRT screen is coated with phosphor. When a beam of electrons from the electron gun (deflected through a yoke) hits the phosphor, it lights up selected pixels to generate an image on the screen.
Flat panel display (FPD)

Flat panel displays (FPDs) are thin, flat electronic devices used as display screens. Compared to CRTs, flat panel displays are much thinner, weigh less and consume less power. They are therefore better for portable computers although they are becoming popular for desktop computers. Flat panel displays are made up of two plates of glass with a substance in between, which activated in different ways.

Flat panel displays are distinguished in two ways:

1. by the substance between the plates of glass

2. by the arrangement of transistors

Substance between Plates

The types of technology used in flat display include liquid crystal display, electroluminescent display and gas plasma displays.
· LCD (liquid crystal display)
This is a common type of flat panel display used for computer monitors and TVs. LCD screens consist of layers of liquid crystal placed in between plates that are lit from behind by a fluorescent lamp to create images. LCD screens perform well in bright rooms. It is small, light and flat and uses much less power than the CRT display. It is therefore extensively used on laptop computers.

· Electroluminescent (EL) displays

El displays contains a substance that glows when it is charged by an electric current. A pixel is formed on the screen when current is sent to the intersection of the appropriate row and column. The combined voltages from the row and column cause the screen to glow at that point.

· Gas Plasma display
Gas plasma displays use a gas that emits light in the presence of an electric current. This technology uses predominantly neon gas and electrodes above and below the gas. Although gas plasma displays have high resolution they are quite expensive. They tend to perform well in dark rooms and poorer in well-lit rooms.

· Light-emitting diode displays (LED)

These are flat panel display screens that use light emitting diodes (LEDs) as a backlight for the screen instead of a fluorescent lamp. These display technology offers some potential advantages over LCDs such as better contrast ratios and less energy consumption.

· Organic light-emitting diode displays (OLEDs)

These are flat panel displays that function by exiting organic compounds with electric current to produce light. OLED displays do not have a back light like LCD and LED displays which allows for high contrast ratios and low power consumption. OLED is an emerging technology and is still primarily used in small portable devices such as cell phones and mp3 players.
Arrangement of transistors

Flat panel displays are either active-matrix or passive-matrix displays according to where transistors are located.

· In an active-matrix display, each pixel on the screen is controlled by its own transistor. Active-matrix displays are much brighter and sharper than passive-matrix displays but are more complicated and thus more expensive. An example of active-matrix display is thin film transistor (TFT) display.

· In a passive-matrix display, a transistor controls a whole row or column of pixels. Passive matrix provides a sharp image for one-color (monochrome) screens but is more subdued for color. Passive-matrix displays are less expensive and use less power.
Multimedia projector

This device is used to create and deliver dynamic multimedia presentations (presentations in which sound, photos, video, text and other moving graphics may be combined to interesting effect). There are two types of multimedia projectors: LCD projector and LCD panel.

The LCD projector has its own built-in lenses and light source and connects directly to computer, television, video/DVD player and video camcorder. Images from these devices are projected through the LCD projector onto a screen or wall. Versions of the LCD projector now come with a digital video camera on an arm extension attached to it. This video camera allows real-time videos and pictures to be instantly projected through the LCD projector onto a screen. For example, the camera can be directed at a page in a book or at someone performing a demonstration; the video camera image is projected through the LCD projector onto a screen or wall.

The LCD panel is used with a normal overhead projector (OHP). This panel is the size of a notebook and is placed directly on the surface of the OHP. Like the LCD projector, the panel can be connected to devices such as computer, television, video/DVD player and video camcorder. The image displayed on the panel is projected onto a screen when the light of the OHP shines through it.

Sound Output Devices

Sound output is another form of ‘soft copy’ output. Sound output devices produce digitized sounds ranging from beeps and chirps to music. All these sounds are non verbal. To produce sound, you need the necessary software and sound card or digital audio circuit board. The sound card plugs into an expansion slot on the motherboard. New computers come with the sound card integrated with the motherboard. Some of the sound output devices include:

Speakers

A simple speaker will make a range of sounds available to the computer user. Computer-generated sound, music output, computer-synthesised voice and the normal speaking voice are now conventional output using a speaker. Sound cards need to be installed in microcomputers to obtain good sound quality for music or games.

Voice Output Devices

Voice output devices convert digital data into speech-like sounds.

Voice response systems

The voice response system selects from a set of digitised pre-recorded words, phrases, music, alarms or other sounds stored on disk. The system combines these pre-recorded words into responses based on selections made by the user. For example, many phone banking systems use voice response systems. Based on the information given to them when a caller selects options on their telephone keypad, the bank computer outputs voice information to the caller. The sounds must be converted from digital format back to analogue before being output to the speaker.

Speech Synthesizers
This system converts written text into computer generated speech (‘text to speech’). It is used for computer-aided conversations by hearing and speech-impaired persons to aid speaking, sight-impaired persons to aid reading, or for converting conversations/text from one language into another. 

Hard copy output devices

You can print out information that is in the computer onto paper or film. By printing you create what is known as a ‘hard copy’. It is tangible – you can hold it in your hands.

Printers

A printer is a hardcopy output device which produces a text and/or graphics of documents stored in electronic form, usually on physical print media such as paper or transparencies. Printers can be categorized into two ways namely:

(i) according to whether or not the image produced is formed by physical contact of the print mechanism with the paper (printing technology)
(ii) according to the number of characters printed at ago (basic unit of printing)

There are therefore many different kinds of printers, which vary in their speed and print quality, depending on the desired print output. 
Classification of Printers according to basic unit of printing
Printers are broadly classified into three types according to the basic unit of printing.
· Character printers

· Line Printers

· Page Printers


Character printers

These are printers that print one character at a time much like a typewriter. They are also known as serial printers. Daisy wheel printers and dot matrix printers are examples of character printers. Character printers are slower than line and page printers.

Line printers

These are high-speed printers capable of printing an entire line at one time. A fast line printer can print as many as 3,000 lines per minute. The disadvantages of line printers are that they cannot print graphics, the print quality is low, and they are very noisy. They are used with mainframe computers where high speed is vital for the large volume of printed output required. 

Examples of line printers include drum printers, band printers and chain printers.

Page printers

These printers print a whole page at a time. They are therefore even faster and deal with very large volumes of printed output. A laser Printer is an example of page printers.

Classification of Printers according to basic printing technology
Printers can also be broadly classified into two types according to the basic printing technologies; 

· Impact printers

· Non-impact printers

Impact printers

An impact printer forms characters or images by striking a mechanism such as a print hammer or wheel against an inked ribbon, leaving an image on paper. The print head of an impact printer contains a number of metal hammers which strike an inked ribbon placed between the print head and the paper. These hammers may contain complete characters; alternatively, they may contain ‘dots’ that are used to build up a character. The main types of impact printer are:

•
Dot matrix printer

•
Daisy wheel printer

•
Drum, chain or band printer.

Characteristics of impact printers

· They are very noisy

· They can produce multiple copies by printing on duplicating paper

· They produce low quality output

Dot matrix printers (character printers)

This is a type of printer that produces characters and illustrations by striking pins against an ink ribbon to print closely spaced dots in the appropriate shape. Dot-matrix printers are relatively inexpensive and do not produce high-quality output. However, they can print to multi-page forms (that is, carbon copies). 

Characteristics of dot matrix printers include:

· Characters are formed from a matrix of dots.

· They are slow
· They are very noisy
· The print obtained is usually of poor quality. They are useful for low-quality carbon copy printing of text, or printing text on continuous sheets of paper.

· They are not good for printing graphics or photographs.

Daisy wheel printers (character printers)

The daisy printer wheel uses a disk made of plastic or metal on which characters stand out in relief along the outer edge. To print a character, the printer rotates the disk until the desired letter is facing the paper. Then a hammer strikes the disk, forcing the character to hit an ink ribbon, leaving an impression of the character on the paper. You can change the daisy wheel to print different fonts. Daisy-wheel printers cannot print graphics, and in general they are noisy and slow, printing from 10 to about 75 characters per second. 

Characteristics of daisy wheel printers include:

· Prints are made by a hammer-like action of the keys hitting the print ribbon.

· The process involves a lot of moving mechanical parts and is very noisy.

· Printing is slow (less than 90 copies per second).

· The text is generally crisp and clean
· The size and font produced can only be changed by using a different wheel, as the characters on the wheel are fixed.

This printer is not used much any more: it is becoming obsolete, as laser printers are able to produce the same quality print as the daisy wheel printers and are much more versatile.

Drum Printers (Line Printers)
Drum printer is an impact printer in which the type is mounted on a rotating drum that contains a full character set for each printing position. In a typical drum printer design, a fixed font character set is engraved onto the periphery of a number of print wheels, the number matching the number of columns (letters in a line) the printer could print. The wheels, joined to form a large drum (cylinder), spin at high speed and paper and an inked ribbon is stepped (moved) past the print position. As the desired character for each column passes the print position, a hammer strikes the paper from the rear and presses the paper against the ribbon and the drum, causing the desired character to be recorded on the continuous paper. 

Chain Printers (Line Printers)

A Chain printer is an impact printer that carries the type slugs by links of a revolving chain. Chain printers placed the type on moving bars (a horizontally-moving chain). As with the drum printer, as the correct character passes by each column, a hammer is fired from behind the paper. Compared to drum printers, chain printers have the advantage that the type chain could usually be changed by the operator. By selecting chains that had a smaller character set (for example, just numbers and a few punctuation marks), the printer can print much faster than if the chain contained the entire upper- and lower-case alphabet, numbers, and all special symbols. 

Band Printers (Line Printers)

These are a variation of chain printers, where a thin steel band is used instead of a chain, with the characters embossed on the band. A selection of different bands is generally available with a different mix of characters so a character set best matched to the characters commonly printed could be chosen.

One other type of printer worth mentioning is the Braille printer. This is an impact printer which converts text into the Braille code, producing patterns of raised dots on paper for use by the blind.

Non-impact printers

Non-impact printers form characters and images without making direct physical contact between the paper and printing mechanism. These printers are faster and quieter than impact printers because they have fewer moving parts. The main types of non-impact printer are:

· Thermal printer

· Laser printer

· Ink-jet printer
Thermal printers (character printers)

These printers use colored waxes and heat to produce images by burning dots onto special paper. Thermal printers are widely used in fax machines and some ATMs (automated teller machines).
Laser printers (page printers)

Laser printers use the principle of dot-matrix printers of creating images with dots. Laser printers use laser beams to create the images on a drum treated with a magnetically charged ink-like toner (powder) and then transferred from the drum to paper. The light of the laser alters the electrical charge on the drum wherever it hits. The drum is then rolled through a reservoir of toner, which is picked up by the charged portions of the drum. Finally, the toner is transferred to the paper through a combination of heat and pressure. This is also the way copy machines work. Because an entire page is transmitted to a drum before the toner is applied, laser printers are called page printers.
Inkjet printers (line printers)

Inkjet printers produce an image by spraying ink onto the paper in a dot matrix pattern. Colour graphics can be produced by spraying cyan, magenta, yellow and black ink onto the page. Inkjet printers can print in both colour and black-and-white. Ink-jet printers are capable of producing high quality print approaching that produced by laser printers. 
Characteristics of non-impact printers
· Much quieter – useful in hospitals, busy offices, etc.

· Much faster printing speeds

· Sometimes require special paper

· Do not have multiple-copy facilities, that is they cannot produce multiple copies by printing on duplicating paper
Plotters

Plotters are special output devices used to produce hard copies of large graphs and designs on paper. Plotters are often used for the production of construction maps, engineering drawings, architectural plans and business charts. 

· Plotters are slow, but can draw continuous lines often in a variety of colours. 

· They are useful for producing architectural drawings, building plans, maps and CAD (computer aided design) drawings, where precision is required.

· The paper is sometimes laid on a flat bed (flat-bed plotter) or on a rotating drum (drum plotter).

There are four main types of plotters: drum (pen plotters), flat-bed plotters, inkjet plotters and electrostatic plotters.

Drum Plotter
A drum plotter is pen plotter that wraps the paper around a drum with a pin feed attachment. The drum then rotates the paper as pens move across it and draw the image. It was the first output device used to print graphics and large engineering drawings. There are two types of drum plotters, external and internal. With an external drum plotter, the paper is wrapped around its external surface, while the internal drum plotter uses a sheet of paper wrapped around its internal surface. 

Flat-Bed Plotter

A flat-bed plotter is a mechanical drafting device used with many CAD programs for designers. The paper remains stationary on a flat surface while a pen moves across it horizontally and vertically. This plotter may use several different colours of pens to create the graphics. The size of the graphic is limited to the size of the flat-bed plotter's surface. 
Inkjet Plotter

The inkjet plotter is a plotter that creates an image by spraying small droplets of ink onto a piece of paper. A popular choice for advertising agencies and graphic designers, inkjet plotters are used generally for large outputs, such as banners and billboards and large signs often seen on roadsides. They are available in thermal or piezoelectric models. Thermal inkjet plotters use heat to apply droplets of ink, while piezoelectric plotters use charged crystals to apply the ink. Inkjet plotters tend to produce better quality graphics than other types of plotters. 

Electrostatic plotter

This is a plotter that uses an electrostatic method of printing. Electrostatic plotters apply colour using coloured toner particles suspended in a liquid carrier. Charges are applied to the paper and passed through liquid toner, where charged toner particle adhere to the paper. As the paper is removed from the bath, the toner emerges dry.

Secondary Storage devices

Data and computer programs must be stored in a computer-usable form. During processing a copy of the software instructions must be retrieved from the secondary storage device and placed into RAM. The operating system determines where and how programs are stored on the secondary storage devices. 

Secondary storage, also called auxiliary or backup storage, is used to store data and program instructions when they are not in use.  The most commonly used secondary storage devices are magnetic storage (magnetic tapes and magnetic disks), optical storage (CD-ROM, CD-R, CD-RW, DVD-ROM, DVD-R and DVD-RW) and solid state memory (flash memory and USB drives).
Characteristics of Secondary storage devices
· Secondary storage is more permanent than main memory, since data and instructions are retained when the power is turned off. 
· Secondary storage is also much cheaper than primary storage
·  Secondary storage devices provide high amount of storage compared to primary storage

Factors to consider when choosing a secondary storage device
 Because of diverse range of storage needs, a number of secondary storage devices are available. Devices are chosen for a particular use based on:

· Storage capacity (how much data the device can store)

· Access speed (the time needed to locate the data and transmit it to 
the CPU)
· Transfer rate; this refers to the speed at which data is transferred from the secondary storage to the main memory.
· Size; some situations require compact storage devices for portability others don’t.
· Portability (ability to be easily removed and used on another system)

· Cost; The cost of the device is directly related to the previous factors 

Classification of secondary storage device

Secondary storage devices are mainly classified according two factors;

1. The technology used to make the devices e.g. magnetic and optical technology 

2. Portability i.e. whether the device is fixed or removable. Fixed storage devices are those that are not removed from the system unit such as hard disks. Removable storage include magnetic tapes, optical disks, floppy disks, zip disks, jaz disks and flash disks.

Magnetic Storage Media
Magnetic Tapes

Magnetic tape is a ribbon of plastic material coated with a metal oxide film on which data is recorded as magnetized or unmagnetized spots. The magnetic orientations of the magnetized and unmagnetized spots represent the binary digits 0 and 1. On mainframe computers the tape is stored on reels or cartridges. In microcomputers tapes are stored in cartridges similar to those used to store music, but of a much higher quality. Just like the tape in a tape recorder, data can be written to, or read from, the tape as it passes the magnetic heads.
Magnetic tape is not suitable for data files that are revised or updated often because it stores data sequentially. This means that data is retrieved in the order in which it was stored. Therefore accessing data is very slow as you cannot go directly to an item of data on the tape. It is necessary to start at the beginning of the tape and search for the data as the tape goes past the heads.
However, magnetic tapes are erasable, reusable and moderately durable, and are made to store large quantities of data inexpensively. For these reasons they are mainly used for emergency backup purposes.

Magnetic Disks

Magnetic disks are one of the most widely used secondary storage media for computers. All magnetic disks provide direct access to data stored. This means that you can go directly to a specific piece of data without having to access any other data either before or after the data you want. The capacity and access speeds of magnetic disks vary with each device or medium. Magnetic disks include floppy disks (diskettes) and hard disks.

Floppy Disks (Diskettes)

A floppy disk or a diskette is a soft, flexible plastic disk coated with magnetized material. Unlike most hard disks, floppy disks are portable, because you can remove them from a disk drive. 
To use a diskette, you need a disk drive. A disk drive (floppy drives) is a device that holds, spins and reads data from and writes data to a diskette. Read means that the data stored on the secondary storage is copied to the primary storage. Write means that the information held in the main memory is transferred to a secondary storage device.

Floppy disks are useful for transferring data between computers and for keeping a backup of small files. 
Hard disks 

Hard disks are thin but rigid metal platters covered with a substance that allows data to be held in the form of magnetized spots. Hard disks are tightly sealed within an enclosed hard-disk drive unit to prevent any foreign matter from getting inside. Data may be recorded on both sides of the disk platters. 

The disks constantly rotate at a high speed and may have one read/write head per disk (moveable head).

The access time (time to get data) from a spinning disk with one read/write head is a combination of:

· Seek time – how long it takes the head to get to the right track;

· Rotational delay or latency time – how long it takes for the data to rotate under the head; and

· Transmission time – the time taken to read the data and transmit it to the CPU.

Like floppy disks, a hard disk must also be formatted before any data can be stored on it. Formatting sets up the tracks, sectors and cylinders. A cylinder is made up of all the tracks with the same number from all the metal disks that make up the hard disk, which can be read or written to at the same time. For example, if you start from the bottom of a stack of disks, track 5 of the second disk will be directly above track 5 of the first disk. Track 5 of the third disk will be directly above track 5 of the first and second disks and so on. If you put these all together on top of each other, you’d have something that looks like a tin can with no top or bottom – a cylinder.

The computer keeps track of what it has put where on a disk by recording the addresses of all the sectors used – a combination of the cylinder, track and sector numbers. Data is written down the disks on the same cylinder. This works quickly because each metal platter has a read/write head for each side and they all move together. So for one position of the read/write heads, the computer can put some data on all the platters.
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 Cross-section of a hard disk arranged and divided into tracks, sectors and cylinders
Virtual Memory

Sometimes the computer uses hard-disk space called virtual memory to expand RAM. When RAM space is limited, the use of virtual memory can let users run more software at once, if the computer’s CPU and operating system are equipped to use it. The system does this by using some free hard-disk space as an extension of RAM – that is the computer swaps parts of the program and/or data between the hard disk and RAM as needed.
Hard disk variations
Two additional types of hard drives that can be used with a PC are external hard drives and removable disk.

· External hard drive: An external hard drive can be used if there is no space in the system unit to house another hard drive. It may come with its own power source and is connected to the system unit via a special cable. External hard drives can be easily removed and connected to another computer, thereby giving them a certain amount of portability and flexibility of use.
· Removable hard disks or cartridge systems
Hard disk cartridges or removable hard disks consist of one or two platters enclosed along with read/write heads in a hard plastic case. The case is inserted into an internal or detached external cartridge drive connected to a microcomputer. These cartridges are often used to transport huge files. They are also used for backing up files. Although they are relatively expensive, they hold much more information and are much faster than diskettes and tapes. Examples include zip drives and jaz drives.

Zip drive

These are a floppy-like technology that use design concepts from hard disks and Iomega's earlier Bernoulli disks developed by Iomega Corporation. Zip disks are slightly larger than conventional floppy disks, and about twice as thick. They can hold 100 or 250 MB of data. Because they're relatively inexpensive and durable, they have become a popular media for backing up hard disks and for transporting large files. 

Jaz Drive

This is a removable hard disk drive developed by Iomega Corporation. The removable cartridges hold up to 2 GB of data. The fast data rates and large storage capacity make it a viable alternative for backup storage as well as everyday use. 
Hard disks for large computers consist of the following;

· Removable hard disk pack: A removable hard disk pack may contain between 6 and 20 hard disks aligned one above the other in a sealed unit. The storage capacity is usually very large, in the terabyte range.
· Fixed disk drives: These are similar to those found in PCs. They have a high storage capacity and are more reliable than removable hard disks. A mainframe computer may have between 20 and 100 fixed disks housed in a single cabinet. Data is transmitted to the CPU using a single data path.
· RAID storage system: RAID stands for Redundant Array of Independent Disk. A RAID storage system consists of a cabinet which may contain a large number of disk drives (up to 100). Besides holding more data than a fixed disk, it stores multiple copies of data on different drives. If one drive fails, others can take over allowing the data to be recovered. Data is transmitted to the CPU using multiple data paths.
For larger computer systems hard disks consist mainly of removable hard disk packs, fixed disk drives and RAID (Redundant Array of Independent (or Inexpensive) Disks) storage systems.
Hard Disk Interfaces

The hard disk interface defines the physical and logical means by which the hard disk connects to the motherboard. A modern PC uses one or more of the following hard disk interfaces:

· Integrated Drive Electronics (IDE) 

IDE (pronounced as individual letters) was by far the most common hard disk interface used in PCs from the early 1990s through 2003. IDE is officially designated ATA (Advanced Technology Attachment), but is now often informally called Parallel ATA or PATA, to differentiate it from the new Serial ATA (SATA) interface. IDE is still used in new systems, although it is being superceded by SATA. 

· Serial ATA (SATA) 

Serial ATA (SATA) is a new technology that will ultimately replace parallel IDE/ATA. SATA has several advantages over PATA, including superior cabling and connectors, higher bandwidth, and greater reliability. Although SATA and PATA are incompatible at the physical and electrical levels, adapters are readily available that allow SATA drives to be connected to PATA interfaces and vice versa. 

· Small Computer System Interface (SCSI) 

Usually pronounced scuzzy, SCSI hard disks are generally used in servers and high-end workstations, where they provide two major advantages: improved performance relative to IDE and SATA in multitasking, multi-user environments and the ability to daisy-chain many drives on one computer. 

Optical disks

An optical disk is a removable disk on which data is written and read through the user of laser beams. The disk is made mainly of a type of plastic (polycarbonate). In optic technology, a high-power laser beam is used to represent data by burning tiny pits (holes) onto the surface of a plastic disk.  The data is stored on a layer inside the plastic. To read the data, a low-power laser light scans the disk surfaces; pitted areas are not reflected and are interpreted as 0 bit; the areas that do not have pits (land) are interpreted as 1 bit. Thus in optical devices the presence of light is interpreted as ‘1’ and the absence of light is interpreted as ‘0’. Because the pits are so tiny, a great deal more data can be represented than is possible with the same amount of space on a diskette. 
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The optical disk technology used with computers consists of four types:

· CD-ROM (Compact Disk - Read Only Memory) disks

· CD-R (Compact Disk – Recordable) disks

· CD-RW (Compact Disk – Rewritable) disks

· DVDs (Digital Versatile Disks)

CD-ROM Disks
This is an optical disk format that is used to hold pre-recorded text, graphics and sound. Read only means that the disk’s content is recorded at the time of manufacture and cannot be written on or erased by the user.

The speed at which the data is accessed depends on how fast the disk spins. The faster the disk spins, the faster the data can be transferred to the computer’s memory. The speed of a CD-ROM drive is indicated by a number followed by an ‘X’. Typical CD-ROM drive speeds are 48X, 50X, etc. The higher the number the faster the disk spins, resulting in faster data access.
Because of their large storage capacity (up to 750 MB), CD-ROMs are used to store software packages for sale or distribution. They are particularly useful for storing multimedia (text, graphics, sound and videos) and application software packages such as encyclopaedias, reference works, word processors, training programs, games and graphics packages.
CD-R

This is a CD format that allows users to use a CD-Recorder to write data (only once) onto a specially manufactured disk that can then be read by any compatible CD-ROM drive. It is ideal for storing large volumes of data that does not need to change. A typical use is to create music CDs. The storage capacity of CD-R, like all CDs, is between 750 and 800 MB.

CD-RW

This is a CD format that allows users to record and erase data so that the disk can be used over and over again. The data layer of these disks uses a phase-changing metal alloy film. By using a higher intensity laser light the film can be melted to level out the marks made by the laser burner when the data was stored, effectively erasing previously stored data. New data can then be recorded using a lower intensity laser light to burn the new data. In theory you can erase and write on these disks as many as 1000 times. It therefore makes it an ideal backup storage device for storing large volumes of data that change frequently.

DVD disks

This is an optical disk format that represents a new generation of high-density CD-ROM disks, which are read by laser and which have both write-once and rewritable capabilities. The main types are DVD-ROM (read only), DVD-R (recordable) and DVD-RW (rewritable). They look similar to a CD-R disk but are capable of holding much more information. This is possible because:

· The tracks on a DVD are placed closer together as compared to a CD, thus allowing more tracks.

· The pits on a DVD are much smaller and closer together than those on a CD allowing far more information to be represented there.

· The technology uses a new generation of lasers that allows a laser beam to focus on pits roughly half the size of those on CDs.

· DVD formats allow for two layers (dual layer) of data-defining pits
· Some DVDs are double-sided. This allows data to be stored on both sides and therefore dramatically increases the disk’s capacity.
· Data is squeezed into fewer pits through data compression.
Single-sided single-layer DVD has a capacity of 4.7 GB, single sided dual layer has a capacity of 8.5 GB. Double sided single layer has a capacity of 9.4 GB and double sided dual layer has a capacity of 17 GB.

Care of Optical Disks

CDs and DVDs are not indestructible, as they were made out to be when they first became popular. Although they are more reliable than diskettes, CDs must be handled with care otherwise data may be lost. Data loss results from:

· Physical damage (breaking, melting, scratching, etc.)

· Blocking of laser light by dirt, paint, ink and glue
· Corrosion of the reflecting layer.
The following are some guidelines for the proper handling of CDs and DVDs.

1 CDs and DVDs should be stored in their cases when not in use to prevent them from being scratched or getting dirty.

2 Avoid soiling the surface of a CD – hold it by the edge or centre hole.

3 Keep your CDs clean by gently wiping both sides with a clean damp cloth from the centre to the outer edge, not by wiping around the disk. Wiping in a circle can create a curved scratch, which can confuse the laser. For stubborn dirt, use isopropyl alcohol or methanol, or CD/DVD cleaning detergent. 

4 Do not write on the top side of the CD with a ballpoint pen or other hard object as this can damage the data layer on the other side. Use a CD marker instead.

5 Don’t write on the top side with a fine-point marker or with any solvent-based marker. (Solvent may dissolve the protective layer.)

6 Do not expose a CD to high temperature or humidity for an extended period of time, as the CD may warp.
Flash memory

Flash memory technology is based on EEPROM (Electrically Erasable Programmable Read Only Memory) technology. Like EEPROM, flash memory is non-volatile. However, reading from and writing to flash memory is a lot faster than with EEPROM. This is because data in flash memory can be erased a block at a time instead of only a single byte at a time as is the case with EEPROM. Flash memory got its name because a block of memory cells is erased in a single action or ‘flash’.
The compact nature of flash memory enables it to be incorporated into very small solid state (no moving parts) devices that are available in all shapes and forms. These devices are rapidly becoming an integral part of modern living. Flash memory is particularly well known today because of the popular flash memory cards used in digital still cameras. 

USB drive

This new type of flash memory storage device does not yet have a generally accepted name. Each company calls it something different, including flash drive, flash pen, thumb drive, key drive and mini-USB drive. They often double as MP3 players, i.e. you can download music to them from your PC, plug in some headphones and listen to your favourite songs. All are small, about the size of your thumb or a large car key, and plug into a USB port on the computer. No additional software is needed for Windows XP, 2000 or ME. Plug it in and the computer notices that a new hard drive has been added, and will show it on your desktop. These small flash drives can have storage capacities from 8 MB to 1 GB or more! Some flash drives include a password protection facility and the ability to run software directly off the USB drive.

WORD PROCESSING.

Word processing is the art of text manipulation.  It involves creating & producing professional looking documents such as letters, memos, reports, etc.

Definition of a Word Processor.

· A Word Processor is a computer program that enables a person to create, save, retrieve, edit, format, and print text based documents.

Initially, the term Word processor was used to refer a computer system with a special piece of software used for the production of documents.
Purpose of Word Processing.

A Word processor is a tool that can be used to prepare & produce documents.  It can be used in:

(i). Writing Letters (i.e., Business & general mail). 

(ii). Writing Memos. 

(iii). Writing Books. 

(iv). Writing Articles, Research letters such as Reports/thesis and Term papers.
(v). Writing Essays and Projects.
(vi). Writing Curriculum vitae and Resumes.

(vii). Writing weekly Newsletters on sports, entertainment, etc.

(viii). Writing Lease agreements and other legal documents.

Common Features (Characteristics) of a Word processor.

A Word processor performs the same function as a typewriter, but offers very many useful features / facilities, which can be used to make your work more efficient and attractive.

A Word processor can be used to produce quality-finished documents of high standards compared to a typewriter.  

The following are some of the facilities provided by all Word processors:

· They allow the user to create a file, save it, and retrieve (recover/open) it when required for reuse, printing, editing or formatting.

· Has Text- editing features, such as: -

(i). Copy & Paste, which allows a marked block of text to be moved to another part of the document.

(ii). Find, which allows the user to search for words or phrases within the document.

(iii). Search & Replace, which allows replacement of every occurrence of a certain combination of characters with another set of characters.

(iv). Undo, which allows actions that have been performed to be reversed, such that if some text was accidentally deleted, then the action can be undone.

· Contains Text and Page formatting features such as: -

(i). Justification of text, which could be Left, Right, Centre, or Full.

(ii). Indents and use of Tabs for text alignment.

(iii). Page Numbering.

(iv). Insert of page Headers and Footers.

· Has different Fonts (lettering/typescripts), Character sizes & Styles such as Bold, Italic, Underline, etc.

· Enables Printing of documents: single or multiple copies, full or part of a document.

· Enables creation of Tables, which can be used to perform certain calculations & sorting on a given text.

· Has an inbuilt dictionary.

· Contains Tools such as Spelling and grammar checkers, Bookmarks & Thesaurus (which provides alternative words – synonyms).

· Typing errors can be corrected and the text modified before printing the final version.  

· Enables the use of document templates, which can be used to quickly create the most frequently used documents once the format has been set.

· Allows Mail merging, which makes it possible to combine several letters.  

This is very useful when similar letters has to be sent to several people.  The names and addresses of each person can be merged with one single standard document and printed out.

· Enables creation of Newspaper layouts, which can be used for manipulation of Column text.

· Has the ability to add graphics within documents.

· Allows creation of Footnotes and Endnotes.

· Provides file protection using Passwords.

· Contain Macros, which can be used to automate the most frequent & repetitive tasks.
· Have the ability to create and import tables, text and graphics from other programs.

· All Word processors have similar document windows with the following features:

(a). They are designed to look like a piece of paper with a few electronic improvements.

(b). The screen is blank before typing of text.

(c). There is a Cursor, which blinks at the position where you can begin entering text.

(d). There is a Status bar that provides the user with information about current status such as saving operation, the name of the file in use, the current page, and column cursor position.

(e).  Word wrap: A facility/feature that automatically moves a word or cursor to the beginning of the next line if there is insufficient room at the end of the current line.

(f). Scrolling: This is the vertical movement of text document on the screen, either using the Up or Down arrow keys, Page Up or Page Down keys, or using the Mouse in Windows based word processors.

(g). Help: Contains instructions, tips, pointers, explanations and guidance on how to use an application.

(h). Editing modes: Word processors have two editing modes; Insert mode and Type over mode.

In Insert mode, every character typed between words, lines or characters is placed at the cursor position.  This pushes all the text in front of the cursor away without deleting it.

In Type over mode, every character typed deletes what was there before and replaces it with new text at the cursor position.
Common examples of Word processors: -

* Microsoft Word.


* WordStar.

* Corel WordPerfect.


* Wang writer.

* Lotus WordPro.


* WordWrite.

Advantages of Word processors.

Word processors have almost replaced typewriters and other writing tools as the means of creating documents.  This is because; a word processor has a number of advantages that include:

(i). A document can be stored in the computer for future reference in computer files.  The files do not occupy physical space like the one on paper; hence, this creates a paperless document processing environment.

(ii). Typing using a word processor is easier & more efficient because some actions are automated.  

Examples;
· Word wrap feature automatically takes the cursor to the beginning of the next line once you reach the end of the current line.

· Automatic insertion of a new page after reaching the end of the current page.
(iii). Most word processors have special editing tools such as Spelling and grammar checkers that help the user to easily correct grammar and spelling mistakes.  Thesaurus helps to find a word with similar meanings.

(iv). Most word processors have Insert and Type over modes.  Therefore, one can easily insert or replace a word or a phrase without affecting the structure and neatness of the document.

(v). Word processors have superior document formatting features such as underlining, boldfacing, italicization, applying different colours, etc.

Formatting refers to the art of making the document more attractive and appealing to the eye.

(vi). A Word processor enables one to produce many copies of a document through printing; whereas, a typewriter may require retying of the entire document when we want many copies.

(vii). Word processor has Cut, Copy and Paste commands that enable the user to incorporate other text without having to retype it. 

(viii). Provides secrecy in writing documents through Passwords.  
(ix). Allow simple arithmetic operations such as additions, multiplications, etc.

(x). Allows Mail merging (combining of several documents).

Disadvantages of Word processors.

(i). They are Expensive.

(ii). The use of Word processors creates unemployment.

(iii). The use of the Word processors is limited only to those areas with power supply.

(iv). There is need of a literate person to operate it.

Factors to consider when choosing a Word processor.

The choice of a word processor depend on:
1. The type of operating system.

E.g., most microcomputers are currently running on Windows based operating systems.  This means that you should consider acquiring a Word processor based on graphical user interface.

2. Its user-friendliness (ease to use).

3. Its formatting and editing features.  They should be good and in variety.
Review Questions 1.1
1. (a). What is Word processing?

(b). Give THREE examples of Word processors used at present.

2. State the purpose of word processing.
3. Identify any FOUR advantages and TWO disadvantages of using a Word processor to prepare documents compared to manual Typewriter.  
4. (a). What is document formatting?

(b). List TWO editing features and THREE formatting features of a good Word processor.
5. Explain the difference between Type over and Insert mode in word processing.

6. What is word wrap?
Review Questions 1.2
1. (a). What is a Word Processor?

(b). Name two common Word processors used in the market today.

(c). Name any THREE advantages of a Word processor. 
2. Briefly describe FIVE features of Word processors.
3. What constraints do early Word processors have?
Review Questions 1.3
1. Name any THREE characteristics of a Word processor.

SPREADSHEETS.

Definition of a Spreadsheet.

A Spreadsheet is a ledger sheet that lets the user enter, edit, and manipulate numerical data.

A Spreadsheet usually consists of a series of rows & columns in which data entries can be made.

Types of Spreadsheets:

There are 2 types of spreadsheets:

1). Manual spreadsheet:

A Manual spreadsheet is ledger book with many sheets of papers divided into rows and columns for entering/writing data.

The data is entered manually using a pen or pencil. 

2). Electronic Spreadsheet:
A computer program that looks like the manual ledger sheet with rows & columns for entering data that can be manipulated mathematically using of formulae.

Advantages of Electronic Spreadsheets over Manual Worksheets.

An electronic spreadsheet:

1. Has a large worksheet for data entry & manipulation as compared to manual worksheet.

2. Has inbuilt formulae called Functions that are non-existent in manual worksheets.  These functions enable the user to quickly manipulate mathematical data.

3. Uses the power of the computer to quickly carry out operations.

4. Has better formatting & editing qualities than the manual worksheet.

5. Utilizes the large storage space available on computer storage devices to save & retrieve documents.

6. Can easily be modified in its form, while a manual spreadsheet involves a lot of manual calculations & are very difficult to amend.

7. The user can very quickly & efficiently perform complicated computations using the information stored in an electronic spreadsheet.

8. It is accurate in its calculations & allows automatic recalculation on formulae.

I.e., when one value/figure is changed, the result of the formula is automatically adjusted by the computer so as to correspond with the different input.  For a manual spreadsheet, changing one value means rubbing the result & writing the correct one again.

9. It offers graphical representation of data leading to comprehensive decisions.

10. Replaces the pencil & paper approach of the manual operations of the worksheet.

I.e., it enables the user to produce neat work because; all the work is edited on the screen and a final copy is printed.  With a manual spreadsheet, neatness & legibility of the work depends on the writer’s hand-writing skills.

11. It improves on the capabilities & speed of the Calculator.

Examples of the commonly used Spreadsheet packages

· VisiCalc – this was the 1st type of spreadsheet to be developed for PCs.

· Lotus 123 – this is an integrated software with spreadsheet module, graphs, and database.

· Microsoft Excel.

· Corel Quattro-Pro

· Microsoft Works Excel

· Super calculators.

· Multiplan.

· Vp-Planner.

Review Questions.

1. Define a Spreadsheet.

2. Differentiate between the traditional analysis ledger sheet and an electronic spreadsheet.

3. Name three commonly spreadsheet packages.

COMPONENTS OF A SPREADSHEET

A spreadsheet has 3 main components, namely;

(a). Workbook.

(b). Database.

(c). Graphs / Charts.

Workbook:

When working in any spreadsheet program, you use workbook files to hold your information.

· A Workbook is a file in a spreadsheet package that contains one or more worksheets.  The worksheets are made up of rows & columns in which you work and store your data.

A Workbook allows the user to organize various kinds of related information in a single file.

Database:

Spreadsheet programs such as Excel have special features, which can be used to manage data values entered in the cells of the spreadsheet.

These features, which are found on the Data menu, were incorporated in Excel but they belong to Database Management System software.

Examples of such features include: Filtering of records, use of Forms, calculating of Subtotals, data validation, Pivot tables and Pivot chart reports.

Example:

If related data values are entered on the same row, they form a Record.  Hence, a worksheet can be manipulated as a database that has data records entered in it.

Graphs/Charts:

A Chart is a graphical/pictorial representation of data in a worksheet.  Charts are used to summarize data in a worksheet in a pictorial form.

They enable the users to present complex data elements from a worksheet in a simple format that they can understand.
Charts make it easy for users to see comparisons, patterns, and trends in data, e.g., instead of having to analyse several columns of a worksheet, one can see at a glance whether sales are falling or rising.
Examples of charts are: Pie charts, Line graphs, Bar charts, Histograms, Column charts, etc.

Review Questions.

1. Name and describe the three components of a spreadsheet.

2. Explain the following terms as used in spreadsheets.

i) Workbook.

ii) Chart.
Application areas of spreadsheets (Areas where Spreadsheets are used)
1. Accounting.

Spreadsheets provide an easy & streamlined means of financial management.  They are mostly used by Accountants to record their daily transactions & also keep financial records.

For example; a spreadsheet can be used to do the following:
· Record sales & purchases.

· Calculate profits.

· Produce Invoices, and also compile financial statements.
· Prepare budgets.

· Assist the management of an organization to monitor the current state of payments from customers in relation to goods delivered.
· Detect aged debtors (i.e., those people who have owed you money for more than the period allowed in your terms of business.

· Track the value of assets over time (i.e., Appreciation and Depreciation).

Note.  Most spreadsheet programs come with inbuilt functions such as SUM, AVERAGE, PRODUCT, etc, which enable the Accountant to carry out his/her daily accounting tasks easily.
2. Data management.

A spreadsheet enables information to be produced easily and kept up-to-date.
For example; 
· It enables the user to create, edit, save, retrieve and print worksheet data & records.

· It enables data to be arranged neatly in tabular structure.

· Related data can be typed on the same worksheet.  If the data is on different worksheets, the worksheets can be linked so that the data can be accessed easily.

Some of the data management functions include:

· Sorting (i.e., arranging worksheet records in a particular order so as to easily access the data items).

· Filtering (i.e., displaying only the records that meet a given condition).

· Use of Forms to enter & view records.

· Use of Total/Subtotal function.
3. Scientific Applications.

Spreadsheet programs can be used by Scientists & Researchers to compile & analyse their results.  

4. Statistical analysis / Mathematical operations.

Spreadsheets provide a set of data analysis tools that can be used to develop complex statistical analyses.  In addition, some of the tools generate charts.

Examples of statistical functions include:

· AVERAGE – used to calculate the mean of a set of values.

· MEDIAN – used to give the value in the middle of a set of values.

Such mathematical operations can be used by:

· Teachers to compile their students’ marks and produce results.  

· Clerks & Secretaries to enable them easily create tables of figures and manipulate them quickly as required.

5. Forecasting (What if analysis).

The automatic recalculation feature makes it possible to use the “What if” analysis technique.

What if analysis is a feature in a spreadsheet that is used to find out the effect of changing certain values in a worksheet on other cells.  

It involves changing the value of one of the arguments in a formula in order to see the difference the change would make on the result of the calculation.

This method can be used for financial forecasting, budgeting, cost analysis, etc.

Review Questions.

1. Explain five application areas where spreadsheet software can be used.

2. Explain the concept of “What if” analysis.

Common features of Electronic spreadsheets.

The following are the typical facilities provided by electronic spreadsheets:

1. Have the ability to create, edit, save & retrieve worksheets.
2. Have inbuilt functions & formulae which can be used to perform calculations.
3. Allows Automatic recalculation, i.e., when you change one value, the rest of the values in the spreadsheet are automatically recalculated by the computer to correspond with the different input.  This enables you to play “what if” games with your system.

4. Have the ability to Sort and filter data (i.e., arrange data in a predefined order).
5. Have a Data validation facility, which ensures that the correct data is entered into the Spreadsheet.
6. Have a Chart facility that can be used to draw line graphs, Bar charts, histograms, etc.
7. Have the ability to format data (both text & numeric data) using predefined formats.

8. Some Spreadsheets have a SOLVER facility that is used to uncover the best uses of scarce resources so that desired goals can be achieved.
9. Have the ability to adjust Column widths & Row heights automatically.
10. Have the ability to hide and unhide rows & columns, and also freeze panes.
11. They enable printing of worksheets within the shortest time possible.
12. They have pre-designed Templates for automating tasks.  
A Template is a document that acts as a blueprint or outline for other documents of the same type.  It contains the standard text, graphics & formatting that will be used in all documents of this type.

This means that, all formulas and formatting for similar workbooks such as Invoices can be saved as templates and then be used to automate the task without having to create the workbook again.

13. Have the ability to summarize data using Consolidation and Pivot tables.  

Consolidation allows the merging of several worksheets into a summary sheet, while still keeping the original worksheets intact.  Consolidation adds together cells with the same co-ordinates in the various worksheets.

Pivot tables can be used to cross-tabulate large amounts of data. 

Differences between an Electronic Spreadsheet and a Calculator

An electronic spreadsheet: -

1. Has more memory than calculator.

2. Is able to perform complex logical operations, but a calculator cannot.

3. Uses the large storage capacity of the computer that a calculator does not have.

4. Has a large working area that a calculator does not have.

Review Questions.

1. Describe any five features of a spreadsheet program.

2. State five features of spreadsheets that are useful in financial modelling.

3. How does a spreadsheet differ from a Calculator?

DATABASES.

What is a Database?

· It is a collection of information related to a particular subject or purpose. 

· A collection of related data or information grouped together under one logical structure.

· A logical collection of related files grouped together by a series of tables as one entity.

Examples of databases.

You can create a database for;

· Customers’ details. 

- Library records. 

· Personal records. 


- Flight schedules.

· Employees’ records.

- A music collection. 

· An Address book (or Telephone directory), where each person has the Name, Address, City & Telephone no.  

DATABASE CONCEPTS.

Definition & Background.

A Database is a common data pool, maintained to support the various activities taking place within an organization.

The manipulation of database contents to yield information is by the user programs.

The database is an organized set of data items that reduces duplications of the stored files.

INTEGRATED FILE SYSTEMS.

These refer to the traditional methods of storing files, i.e., the use of paper files.  E.g., Manual & Flat files.

· In Integrated file systems, several inter-independent files are maintained for the different users’ requirements.

· The Integrated file systems have the problems of data duplication.

· In order to carry out any file processing task(s), all the related files have to be processed.

· Some information resulting from several files may not be available, giving the overall state of affairs of the system. 

DATABASE MAINTENANCE.

A Database cannot be created fully at once.  Its creation and maintenance is a gradual and continuous procedure.  The creation & the maintenance of databases is under the influence of a set of user programs known as the Database Management Systems (DBMS).

Through the DBMS, users communicate their requirements to the database using Data Description Languages (DDL’s) & Data Manipulation Languages (DML’s).

In fact, the DBMS provide an interface between the user’s programs and the contents of the database.  

During the creation & subsequent maintenance of the database, the DDL’s & DML’s are used to:

(i). Add new files to the database.

(ii). Incorporate fields onto the existing records in the database.

(iii). Delete the obsolete (outdated) records.

(iv). Carry out adjustments on (or amend) the existing records.
(v). Expand the database capacity, for it to cater for the growth in the volume for enhanced application requirements.

(vi). Link up all the data items in the database logically.

Data Dictionary.

All definitions of elements in the system are described in detail in a Data dictionary.  
The elements of the system that are defined are: Dataflow, Processes, and Data stores.

If a database administrator wants to know the definition of a data item name or the content of a particular dataflow, the information should be available in the dictionary.

Notes.

· Databases are used for several purposes, e.g., in Accounting – used for maintenance of the customer files within the base.

· Database systems are installed & coordinated by a Database Administrator, who has the overall authority to establish and control data definitions and standards.

· Database storage requires a large Direct Access storage (e.g., the disk) maintained on-line.

· The database contents should be backed up, after every update or maintenance run, to supplement the database contents in case of loss.  The backup media to be used is chosen by the organization.

Data Bank.

A Data Bank can be defined as a collection of data, usually for several users, and available to several organizations.  

A Data Bank is therefore, a collection of databases.  

Notes.

· The Database is organizational, while a Data Bank is multi-organizational in use.

· The Database & the Data Bank have similar construction and purpose.  The only difference is that, the term Data Bank is used to describe a larger capacity base, whose contents are mostly of historical references (i.e., the Data Bank forms the basis for data or information that is usually generated periodically).  On the other hand, the contents of the Database are used frequently to generate information that influences the decisions of the concerned organization.

TYPES OF DATABASE MODELS.

(1). Relational database model.

A Relational database is a set of data where all the items are related.

The data elements in a Relational database are stored or organized in tables.  A Table consists of rows & columns. Each column represents a Field, while a row represents a Record.  The records are grouped under fields.
~ A Relational database is flexible and easy to understand.

~ A Relational database system, has the ability to quickly find & bring information stored in separate tables together using queries, forms, & reports.  This means that, a data element in any one table can be related to any piece of data in another table as long as both tables share common data elements.

Examples of Relational database systems;
(i). Microsoft Access.

(ii). FileMaker Pro.

(iii). Approach.

(2). Hierarchical database model.

It is a data structure where the data is organized like a family tree or an organization chart. 

In a Hierarchical database, the records are stored in multiple levels.  Units further down the system are subordinate to the ones above.
In other words, the database has branches made up of parent and child records.  Each parent record can have multiple child records, but each child can have only one parent.
Components of Data hierarchy.
Databases (logical collection of related files).
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(3). Network database model.

A Network database model represents many-to-many relationships between data.  It allows a data element or record to be related to more than one other data element or record.  For example, an employee can be associated with more than one department. 

DATA BASE MANAGEMENT SYSTEMS (DBMS).

· These are programs used to store & manage files or records containing related information.
· A collection of programs required to store & retrieve data from a database.
· A DBMS is a tool that allows one to create, maintain, update and store the data within a database.

A DBMS is a complex software, which creates, expands & maintains the database, and it also provides the interface between the user and the data in the database.

A DBMS enables the user to create lists of information in a computer, analyse them, add new information, delete old information, and so on.  It allows users to efficiently store information in an orderly manner for quick retrieval.

A DBMS can also be used as a programming tool to write custom-made programs.

CLASSIFICATION OF DATABASE SOFTWARE.

Database software is generally classified into 2:

1. PC-based database software (or Personal Information Managers – PIMs). 

2. Corporate-based database software.  

PC-based database software.

The PC-based database programs are usually designed for individual users or small businesses.  

They provide many general features for organizing & analyzing data.  For example, they allow users to create database files, enter data, organize that data in various ways, and also create reports.

They do not have strict security features, complicated backup & recovery procedures.  

Examples of PC-based systems;  

* Microsoft Access.

* FoxPro.

* Dbase III Plus

* Paradox.

Corporate database software.
They are designed for big corporations that handle large amounts of data.  

Issues such as security, data integrity (reliability), backup and recovery are taken seriously to prevent loss of information.

Examples of Corporate-based systems; 

* Oracle.

* Informix

* Ingress.



* Progress.

* Sybase.

* SQL Server.

Common features of a database packages.

(i). Have facilities for Creating databases.

(ii). Have facilities for Updating records or databases.  

Using a DBMS, you can define relationships between records & files maintained in a database.  In this case, a transaction in one file of the database can also cause a series of updates in parts of other tables.  Thus, the data is input only once to the database and is made available to the many files composing it.
(iii). Have facilities for generating Reports.

(iv). Have a Find or Search facility that enables the user to scan through the records in the database so as to find information he/she needs.

(v). Allow Sorting that enables the user to organize & arrange the records within the database.

(vi). Contain Query & Filter facilities that specify the information you want the database to search or sort.

(vii). Have a data Validating facility.

FUNCTIONS OF A DATABASE MANAGEMENT SYSTEM.

The DBMS is a set of software, which have several functions in relation to the database as listed below:

1. Creates or constructs the database contents through the Data Manipulation Languages.

2. Interfaces (links) the user to the database contents through Data Manipulation Languages.

3. Ensures the growth of the database contents through addition of new fields & records onto the database.

4. Maintains the contents of the database.  This involves adding new records or files into the database, modifying the already existing records & deleting of the outdated records.

5. It helps the user to sort through the records & compile lists based on any criteria he/she would like to establish.

6. Manages the storage space for the data within the database & keeps track of all the data in the database.

7. It provides flexible processing methods for the contents of the database.

8. Protects the contents of the database against all sorts of damage or misuse, e.g. illegal access. 

9. Monitors the usage of the database contents to determine the rarely used data and those that are frequently used, so that they can be made readily available, whenever need arises.

10. It maintains a dictionary of the data within the database & manages the data descriptions in the dictionary.

Note.  Database Management System (DBMS) is used for database;

· Creation.

· Manipulation.

· Control, and 

· Report generation.
ADVANTAGES OF USING A DBMS.

1. Database systems can be used to store data, retrieve and generate reports.

2. It is easy to maintain the data stored within a database.

3. A DBMS is able to handle large amounts of data.

4. Data is stored in an organized format, i.e. under different fieldnames.

5. With modern equipment, data can easily be recorded.

6. Data is quickly & easily accessed or retrieved, as it is properly organized. 

7. It helps in linking many database tables and sourcing of data from these tables.

8. It is quite easy to update the data stored within a database.

A database is a collection of files grouped together by a series of tables as one entity.  These tables serve as an index for defining relationships between records and files maintained in the database.  This makes updating of the data in the related tables very easy.

9. Use of a database tool reduces duplication of the stored files, and the reprocessing of the same data items.  In addition, several independent files are maintained for the different user requirements.

10. It is used to query & display records satisfying a given condition.

11. It is easy to analyse information stored in a database & to prepare summary reports & charts.

12. It cost saving.  This results from the sharing of records, reduced processing times, reduced use of software and hardware, more efficient use of data processing personnel, and an overall improvement in the flow of data.

13. Use of Integrated systems is greatly facilitated.

An Integrated system – A total system approach that unifies all the aspects of the organization.  Facilities are shared across the complete organization.

14. A lot of programming time is saved because the DBMS can be used to construct & process files as well as retrieve data.

15. Information supplied to managers is more valuable, because it is based on a widespread collection of data (instead of files, which contain only the data needed for one application).

16. The database also maintains an extensive Inventory Control file.  This file gives an account of all the parts & equipment throughout the maintenance system.  It also defines the status of each part and its location.

17. It enables timely & accurate reporting of data to all the maintenance centres.  The same data is available and distributed to everyone.

18. The database maintains files related to any work assigned to outside service centres.  

Many parts are repaired by the vendors from whom they are purchased.  A database is used to maintain data on the parts that have been shipped to vendors and those that are outstanding from the inventory.  Data relating to the guarantees and warranties of individual vendors are also stored in the database.

DISADVANTAGES OF DATABASES.

1. A Database system requires a big size, very high cost & a lot of time to implement.  
2. A Database requires the use of a large-scale computer system.

3. The time involved.  A project of this type requires a minimum of 1 – 2 years.

4. A large full-time staff is also required to design, program, & support the implementation of a database.

5. The cost of the database project is a limiting factor for many organizations.

Database-oriented computer systems are not luxuries, and are undertaken when proven economically reasonable.

Exercise (a).

1. (a). What is a database?
(b). What are Database management system software?

2. Name and explain the THREE types of database models.


       (6 marks).

3. Explain THREE major concerns in a database system.       


       (6 marks).

4. How are database software generally classified?  Give examples of range of products in        each type of classification.

5. State 5 features of an electronic database management system.

6. Explain the importance of using a Database management system for storage of files in an organization.

Exercise (b).

1. Write short notes on:

(i). Database.

(ii). Database maintenance.

(iii). Data bank.

2. State the components of a data hierarchy.

3. (a). List the TWO classes of database software.

(b). Give FOUR widely used Database management systems today.

4. Identify FIVE functions of a Database management system.

5. Describe the advantages and disadvantages of a database.

Exercise (c).

1. Define the following terms:

(i). Database.








(4 marks)
(ii). Database Management System (DBMS).




(4 marks).
(iii). Relational database.

(iv). Hierarchical database.

(v). Network database.

2. List and briefly describe THREE advantages of using the electronic database approach in data storage as compared to the file-based approach.

3. List and briefly describe TWO features found in a typical Database Management System.
4. Identify and describe three major shortcomings of the conventional file structures that are being addressed by the database approach.




(6 marks).

5. Describe the functions of the following tools found in a database management system (DBMS).

(a). Data Definition Language (DDL)





(2 marks).

(b). Data Manipulation Languages (DML)




(2 marks).

(c). Data Dictionary (DD)






(3 marks).
DESKTOP PUBLISHING (DTP).

1.0 Introduction
Publishing is the process of producing publications such as newspapers, cards, pamphlets, pictures, calendars, books, etc that has special text and graphical layouts & designs.

Traditionally, publishing involved drawing and writing manually on wooden or metallic boards.  The artwork would then be painted with ink and pressed on papers to produce a printout.  Today, the art of publishing makes use of Personal computers & small printers that are able to print high-quality text and graphics.  All the publishing processes can be done on a desk in the office or at home.

1.1 Definition of Desktop Publishing
Desktop publishing refers to the process of producing publications by designing their text and graphics layout using special desktop publishing software installed on personal computers.  The text and graphical objects can then be inserted, edited, formatted and printed.

Examples of desktop publishers;

· Adobe PageMaker

· Adobe Photoshop
- mainly used for editing & formatting photographs.

· Adobe illustrator - used for creating complex freehand artwork such as drawings & logos.

· CorelDraw.

· Microsoft Publisher.

· Ventura.

· Harvard graphic.

Difference between a desktop publisher and a word processor.

· A DTP software gives the user more tools and control of the page layout, text manipulation and graphic design than a word processor.

However, today’s word processors have been incorporated with text and graphic formatting and editing tools, e.g., you can design a full publication in Microsoft Word by using the available Drawing and Picture tools, create columns, etc.

1.2 Purpose of Desktop publishing software
DTP programs give the typesetter (the person designing publications) a lot of control on: 

(a). Graphic design:

Using DTP software, a typesetter can create and edit very complex text & graphical objects of high quality.

For example, the software provides the user with rulers & ruler guides that can be used to place an object in the correct position within the publication.

(b). Page layout design:

With a desktop publisher, the user can design a page layout by setting consistent (constant) picture and object locations, divide a page into a number of columns, and also create layers.

Layering is the arrangement of objects on top of each other with the one on top being on the first layer. 

(c). Printing:

To produce any publications, they must be printed.  Therefore, DTP software helps the user to prepare artwork (i.e., publications that are ready for printing).

1.3 Types of Desktop publishing software
There are 2 main types of DTP software:

1). Graphical based:

They are specifically developed for editing & formatting graphic objects like pictures.

Examples;

· Adobe Photoshop.

- Harvard graphic.

· CorelDraw.

Graphic-based desktop publishers have superior capabilities for handling images such as setting resolution, brightness, contrast, cropping, and filling the images with colour.

2). Layout based:

They are specifically developed to create different page layout designs for text and pictures.

Examples;

· Adobe PageMaker.

· Microsoft Publisher.

1.5 Designing a publication
Different publications have different design layouts and formatting.

Types of publications

There are several types of publications that can be produced using DTP software.  They include:

(a). Cards:

They may be for special occasions such as weddings, graduations, harambee, and for congratulations.

(b). Certificates:

These are types of publications used to show completion of courses and special events.

Note.  Certificates are very sensitive, and must be designed to discourage any type of duplication or counterfeits.

(c). Newspapers, Magazines, Pamphlets and Newsletters:

They contain news targeting a group of people.

(d). Books:

Are bulky publications with many pages that are bound together.

(e). Calendars:

They are used to show dates.  They are also used by companies to advertise their products.

(f). Notices, Brochures, Posters / Advertisement, and Catalogues.

1.5 Features of DTP software.
1). Text can be entered directly into a DTP publication.  Alternatively, the text can be entered into a Word processor and then copied into the DTP document.

· Graphics can be created in a separate program, then incorporated into a Desktop publishing program.

· A Scanner can also be used to copy images, such as photographs and drawings, into a Desktop publishing document.  A Scanner is a device that reads text and images into a document.

2). A DTP program gives you more control over the graphics in a publication.  You can:

· move - change the position of a graphic on a page,

· size - make a graphic larger or smaller, 

· Rotate - turn or spin a graphic, and 

· Crop - trim part of a graphic.

3). Has a wide range of Fonts & print sizes that can be merged with useful symbols, such as arrows and stars.

4). Has Columns of various widths, in which the text is fitted automatically using sensible hyphenation.  The columns can also be reorganization automatically.

5). Enables Scaling and cropping of publications so as to fit the available space.

6). Page numbers can be inserted.

7). Enables production of multiple page documents.

Steps in using a DTP System.

1. Prepare your text and illustrations with a Word processor  or a Graphics package. 

Alternatively, use a Scanner to input text and graphics from other sources.

2. Using the DTP program, develop the format of each page.

Your screen becomes an electronic paste board with rulers, column guides and other page design aids.

3. Copy the text and illustrations into the page format you have designed in the DTP program.

The DTP program will automatically move the excess text to another column or page and also help size and place illustrations and headings.

4. Format the pages on the screen to look the way you want them, then store them electronically on your hard disk.  If necessary, print them on a Laser Printer to produce the finished printed material.

Printing terminologies used in DTP.

1). Ranner – the main headline across the top of the page.

2). Cross head – a small heading used to break up text into easily readable sections.

3). Bullet – solid dot printed before pieces of text in order to add an emphasis.

4). Cast off – a calculation as to how much space the text will use on a page.

5). Footer – a line of text at the bottom of each page giving the publications title, author’s name, etc.

6). Masthead – details of the person involved in printing the publication.

7). WYSIWYG (What You See Is What You Get) – this means that, the presentation on the screen is exactly what you will get from the Printer.

8). Jigging – moving text around by means of DTP software.

Review Questions.

1. (a). What is Desktop publishing?

(b). Why is a desktop publisher preferred in designing documents than a word processor?

2. Give three examples of desktop publishing software available in the market today.

3. (a). What is layering?

(b). Why is layering a very useful feature in a desktop publisher.

4. Mention the three main purposes of a desktop publishing software.

5. List TWO areas of DTP application.

6. State FIVE features of a Desktop publisher.

INTERNET.

Why Study about the Internet?
· To understand what the Internet is, the services that it offers, what is required in order to get connected, as well as to establish a connection and log out of the Internet.

What is the Internet?

· It is a large no. of connected computers (or a large set of computer networks) linked together that communicate with each other, over telephone lines.  

· It is a worldwide computer network connecting thousands of computer networks, through a mixture of private & public data using the telephone lines.

· It is a worldwide (global or an international) network of computers that provide a variety of resources and data to the people that use it.

· Internet refers to a global inter-connection of computers and computer networks to facilitate global information transfer.  It is an interconnection of computers throughout the world, using ordinary telecommunication lines and modems.

The Internet uses VSATS (Very Small Aperture Telecommunication Systems) such as Telephone lines, Satellite.

The other names for the Internet are:

· The Net.
· Information Superhighway. 

· Cyber space.
Internet is a facility that links the Internet users to the actual Internet documents.  Therefore, it is a system that links together many kinds of information all over the world.  This technology allows computers equipped with telecommunication links to exchange information freely, and as such, the Internet has enhanced what is being referred to as a global village.

Internet enables companies, organizations, individuals, schools and governments to share information across the world.

A computer on the Internet can be located anywhere in the world.  The Internet enables the computer to communicate with any other computer.

HISTORY (DEVELOPMENT) OF THE INTERNET.

The Internet was started by the U.S Department of Defence in 1969 as a network of 4 computers called ARPANET.  Its aim was to connect a set of computers operated by several Universities and Scientists doing military research so as to enable them share research data.

The original network grew as more computers were added to it.  By 1974, 62 computers were already attached.  

In 1983, the Internet split into 2 parts; one dedicated exclusively (solely/only) to military installations (called Milnet), and the other dedicated to university research (called the Internet), with around 1,000 host computers.

In 1985, the Canadian government developed the BITNET to link all the Canadian Universities, and also provided connections into the U.S Internet.  

In 1986, the U.S National Service Foundation created NSFNET to connect leading U.S universities.  By the end of 1987, there were 10,000 host computers on the Internet and 1,000 on BITNET.

In 1987, the National Science Foundation leased (acquired/rent) high-speed circuits to build a new high-speed backbone for NSFNET.  In 1988, it connected 13 regional internal networks containing 170 LAN’s and 56,000 host computers.  

The Canadian Research Council followed in 1989, replacing BITNET with a high-speed network called CA*net that used the Internet protocols.  By the end of 1989, there were almost 200,000 host computers on the combined U.S and Canadian Internet.

Similar initiatives (plans/projects) were undertaken by other countries in the world, such that by the early 1990s, most of the individual country networks were linked together into one worldwide network of networks.  

Each of these individual country networks was different (i.e., each had its own name, access rules, and fees structure), but all the networks used the same standard as the U.S Internet network.  So, users could easily exchange messages with each other.

By 1990s, the differences among the networks in each of the countries had disappeared, and the U.S name; Internet began to be used to mean the entire worldwide system of networks that used the Internet TCP/IP protocols. 

A Protocol - a set of rules and standards that computers use to communicate with each other over a Network.

Features of the Internet.

(i). The Internet is a collection of networks; it is not owned or controlled by any single organization, and it has no formal management organization.  However, there is an Internet Society that co-ordinates and sets standards for its use.  

In addition, Networks have no political boundaries on the exchange of information.

(ii). Networks are connected by Gateways that effectively remove barriers so that one type of network can “talk” to a different type of network.

(iii). To join the Internet, an existing network will only be required to pay a small registration fee and agree to certain standards based on TCP/IP.  

The costs are low, because the Internet owns nothing, and so it has no real costs to offset.  Each organization pays for its own network & its own telephone bills, but these costs usually exist independent of the Internet.

(iv). Networks that join the Internet must agree to move each other’s traffic (data) at no charge to the others, just as it is the case with mail delivered through the International Postal system.  This is why all the data appear to move at the cost of a local telephone call, making the Net a very cheap communication media.

FUNCTIONS OF THE INTERNET.
The Internet carries many kinds of traffic, and provides users with several functions.  Some of the most important functions are:

1. Communication.

Many people all over the world use the Internet to communicate with each other.

Internet communication capabilities include; E-mail, Usenet Newsgroups, Chatting and Telnet.  You can send e-mails to your friends anywhere in the world, chat with your friends, send instant messages, etc.

2. Information retrieval.

The Internet is a library.  Thousands of books, magazines, newspapers and encyclopedias can be read on the Internet.

3. Easy-to-use offerings of information and products.

You can find information for your school assignments, buy books online, check what the weather is like anywhere in the world, and much more.
INTERNET SERVICES.

The following are some of the services offered by Internet:

(i). Electronic mail (e-mail).

(ii). Fax services.

(iii). Conference services.

(iv). Online chatting.

(v). Downloading of programs.

(vi). Online shopping.
(vii). File transfer.

(viii). Entertainment (Games, Music and Movies).

(ix). Free information retrieval (e.g., Educational information).
(x). Formation of Discussion groups, e.g. Usenet Newsgroups.
(xi). Video Conferencing.

(xii). Access & Use of other computers.

Electronic Mail (E-mail).

An E-mail is a system that enables sending & receiving of messages electronically through computers.  It is used for communication between organizations or departments in the same organization.

E-mail is a quick, cheap, efficient & convenient means of communication with both individuals and groups.  It is faster than ordinary mail, easy to manage, inexpensive and saves paper.

With Internet mail, it is possible to send and receive messages quickly from businesses, friends or family in another part of the world.  An E-mail message can travel around the world in minutes.

Fax services.

Fax services enable individuals & businesses to send faxes through e-mail at a lower cost compared to the usual international Fax charges.

Conference services.

Conferencing on the Web can be defined as the dynamic exchange of all kinds of information – text, graphics, audio, video, etc – in a situation whereby the conversations are organized by item and allows a participant to contribute spontaneous responses to any item in the conversation.

Application of Conferencing on the Web.

The conversation can:

· Provide important information that can assist in decision-making.

· Provide any required technical support.

· Help in community-building, project management & distance learning.

· Help to organize electronic meetings, etc.

The Internet also allows you to have access to various types of information you might require to make accurate and informed decisions, E.g., it provides information on business, education, sports, politics, etc.

Chatting.

Internet Relay Chat (IRC) is a chatting system on the Internet that allows a large no. of people from various locations of the world who are on the computer to chat (i.e., simultaneously hold live and interactive electronic conversations) among themselves.

You can join discussion groups on the Internet and meet people around the world with similar interests.  You can ask questions, discuss problems and read interesting stories.

Anyone interested in chatting can join a discussion forum on one of the listed topics.  Only people who happen to be signed on at the same time are able to talk because messages are not stored.

This discussion can be an effective business tool if people who can benefit from interactive conversation set a specific appointment to meet and talk on a particular topic.

Disadvantage.

(i). Usually, the topic is open to all without security; so intruders can participate.

Information retrieval.

The Internet is a voluntarily decentralized network with no central listing of participants or sites.  Therefore, End-users, usually working from PCs are able to search & find information of interest located in different sites assisted by special software and data stored in readily usable formats.

The Internet gives you information on almost any subject.  This is because of the Worldwide Web (www).  

The World Wide Web is a global (an international) system of connected Web pages containing information such as, text, pictures, sound and video.  The WWW is hypertext based (i.e., it is able to access text and graphical data formatted for easy search, retrieval and display).

With the WWW, you can review Newspapers, magazines, academic papers, etc.  In addition, Governments, colleges, universities, companies and individuals offer free information on the Internet.  E.g., you can inquire (find out) about universities in Britain or America.

Note.  Its major problem is finding what you need from among the many storehouses of data found in databases and libraries all over the world.

Dowloading of Programs.

There are thousands of programs available on the Internet.  These programs include; Word processors, Spreadsheets, Electronic cards, etc.   

You can therefore, look for the latest software over the Internet, e.g., you can get the latest Anti-virus software, and in addition, retrieve a free trial issue.

Entertainment.

There are hundreds of simple games available on the Internet.  These include; Chess, Football, etc.  The Internet also allows you review current Movies and hear Television theme songs.

Online Shopping.

You can order goods and services on the Internet without leaving your desk.  E.g., you can view a catalogue of a certain clothes shop over the Internet and fill in an online Order form.
Commercial enterprises use the Web to provide information on demand for purposes of customer support, marketing and sales.
File Transfer.

Data in the form of files can be transferred across the Internet from one site to another using the File Transfer Protocol (FTP).  FTP software is needed at both ends to handle the transfer.  It is through FTP that the two pieces of software manage to ‘understand’ each other.

Discussion Groups.

A Discussion group is a collection of users who have joined together to discuss some topic.

There are many discussions on different topics including Cooking, Skydiving, Politics, Education, recreational, scientific research, etc.

Two of the commonly used discussion groups for business are;

· Usenet newsgroups.

· List Servers.

(a). Usenet newsgroups.

These are the most formally organized of the discussion groups.

Using a facility on the Internet called USENET, individuals can gain access to a very wide variety of information topics.

Usenet Newsgroups are usually worldwide discussion groups in which people share information and ideas on a defined topic through large electronic Bulletin Boards where anyone can read any articles or write articles and post messages on the topic for others to see and respond to.

The individuals can add messages to different topics and read those contributed by others. For instance, users such as students can ask questions about problems they face, or they could contribute or give an advice on how to improve the teaching of the subject.

Messages can be easily linked so that it is easy to know messages that are related.

Establishing a new newsgroup requires a vote of all interested people on the Internet.  If enough people express interest, the new topic is established.

Note. To join a Newsgroup and be able to read messages on various topics, your computer must have Newsreader software such as Outlook Express, or Internet News.

Any Internet user can access some of these newsgroups, while other newsgroups will require to subscribe to a specific topic or set of topics.  
Once you have subscribed, each time you access the newsgroups you are informed of any new messages added to the topics.  You can then read these messages and respond to them by adding your own message.

The Usenet software receives “postings” of information and transmits new postings to users who have registered their interest in receiving the information.  Each individual posting takes the form like that used for e-mail.

There are over 10,000 such newsgroups; however, each Usenet site is financed independently & controlled by a Site Administrator, who carries only those groups that he/she chooses.

(b). List Server

A List Server (or list serve) group is similar to the Usenet newsgroups, but is generally less formal.

Anyone with the right e-mail server software can establish a list server, which is simply a mail list.

The processor of the List Server processes commands such as request to subscribe, unsubscribe, or to provide information about the list serve.  The List serve mailer directs messages to everyone on the mailing list.

To use a List server, you need to know the addresses of both the Processor and the Mailer.

To subscribe to a List server, you send an e-mail message to the List server processor, which adds your name to the list.  Many different commands can be sent to the List server processor to perform a variety of functions.  These commands are included as lines of text in the e-mail messages sent to the processor.  

List servers are more focused that the Usenet newsgroups and have fewer members.  They are harder to find than the Usenet newsgroups because literally anyone can create one.

Video Conferencing.

Video conferencing provides real-time transmission of video & audio signals to enable people in 2 or more locations to have a meeting.

The fastest growing form of video conferencing is Desktop video conferencing.  

Small cameras installed on top of each camera enable meetings to take place from individual offices.

Special application software (e.g., CUSeeMe) is installed on top of each client computer.  It transmits the image across a network to application software on a video-conferencing Server.  The server then sends the signals to the other client computers that are to participate in the video conference.  In some areas, the clients can communicate with each other without using the server.

Some systems have integrated other types of GroupWare with desktop video conferencing, enabling participants to communicate verbally to attend the same “meeting” while sitting at the computer in their offices.

Advantage of Video conferencing.

(i). Saves time & cost, as it reduces the need to travel.
Access & Use of other computers.

The Internet has a facility called TELNET that enables a user on one computer to use another computer across the network, i.e., the user is able to run programs on the other machine as if he/she is a local user.

Telnet is a protocol, which enables a user on one computer to log in to another computer on the Internet.

TELNET establishes an error-free, rapid link between two computers, allowing a user to log on to his/her home computer from a remote computer even when traveling.  You can also log on to and use third-party computers that have been made available to the public.

TELNET will use the computer address you supply to locate the computer you want to reach and connect you to it.  You will, of course, have to log in & go through any security procedures you, your company, or the third-party computer owner have put in place to protect that computer.

Telnet requires an application image program on the Client computer and an application layer program on the Server of the host computer.  Many programs conform to the Telnet Standard (e.g., EWAN).

Once Telnet enables the connection from the Client to the Server, you can log in by use of commands.  The exact commands to gain access to these newsgroups vary from computer to computer.

Telnet enables you to connect to a remote computer without incurring long-distance telephone charges.

Telnet can be useful because, it enables you to access your Server or Host computer without sitting at its Keyboard. 

Telnet can be faster or slower than a modem, depending on the amount of traffic on the Internet.

Note.  Telnet is insecure, because everyone on the Internet can attempt to log in your computer and use it as they wish.  One commonly used security precaution is to prohibit remote log ins via Tel-net unless a user specifically asks for his/her account to be authorized for it, or permit remote log ins only from a specific set of Internet addresses., e.g., the Web server at a university can be configured to only accept telnet log ins from computers located on the Kabete Campus network.

Electronic Commerce. 

Many people are actively using the Internet for Electronic Commerce (i.e., doing business on the Internet).

The use of the Internet in E-commerce is not necessary for making money as such, but mainly to find information, improve communication and provide information.

Many people automatically focus on the retail aspect of e-commerce, i.e., selling products to individuals.  However, this is just one small part of e-commerce.  The fastest group and the largest segment of e-commerce is business-to-business settings.

There are 4 ways in which the Web can be used to support E-commerce;

(i). Electronic Store.

Electronic Store is a Website that lists all the products or services a business wishes to sell, thus enabling customers to purchase them by using the Internet itself.  

E-store sites provide physical goods and services.  

The cost of providing information on the Web is low (unlike a Catalog, in which each page adds to the cost), and therefore, electronic stores can provide much information.  In addition, electronic stores can also add value by providing dynamic information.

E-mail can also serve the purpose of E-store.  This is because, e-mail is essentially a collection of e-stores.  The mail usually provides all the computer information needed for e-commerce, and advertises the mail to potential customers.  In return, the stores pay the mail a monthly fee or some percentage of sales.

(ii). Electronic Marketing.

E-marketing sites focus on the products or services of one company with aim of increasing sales.  

This type of site supports the sales process, but does not make actual sales.  The goal is to attract and keep customers.  

By doing so, such sites provide a wealth of information about the firms and products complete with technical details and photos.  Customers can review these but cannot buy over the Web.  The idea is to encourage the user to visit a local dealer, who will then make a sale.  

Computers also use e-marketing sites to provide newsletters with information on the latest products and tips on how to use them.  Other companies enable potential customers to sign up for notification of new product releases.

E-marketing is cheaper in many ways than traditional marketing (radio, direct marketing, TV or print media).  This is because while it costs the same to develop these traditional media, it costs nothing to send information to the customers.  It is also easier to customize the presentation of information to a potential customer, because the Web is interactive.  In contrast, the other media are fixed once they are developed, and they provide the same marketing approach to all who use it.

(iii). Information / Entertainment provider.

The Information/Entertainment provider supplies information (in form of text or graphics) or entertainment.  These providers provide information from many sources with an aim of helping the users.

Several radio and TV stations are using the Web to provide broadcast of audio and video.  The Web also offers new forms of real entertainment e.g., enables new multiplayer interactive games, which are not available in any other media.  The information / entertainment providers generate revenue by selling advertisement printouts.

(iv). Customers Service sales.

This provides a variety of information for customers after they have purchased a product or service – to allow customers access most commonly needed information 24 hrs a day. 

Many software companies post updates that fix problems so that customers can download for themselves.  

Customer service sites benefit both the company and the customers.  They enable customers to get a 24 hr support and easy access to needed information.  

They often reduce the no. of staff needed by automating routine information requests that previously had to be handled by an employee.  

GroupWare.
GroupWare is a software that helps groups of people to work together more productively.

They are often organized using a two-by-two grid.

	Same place
	Same time
	Different time

	
	Group support systems
	Group support systems

	Different place
	Video teleconferencing, Desktop video teleconferencing
	E-mail, Discussion groups, Document-based GroupWare


GroupWare allows people in different places to communicate either at the same time (as on a telephone) or at different times.

GroupWare can also be used to improve communication and decision-making among those who work together in the same room, either at the same time or at different times.

GroupWare allows people to exchange ideas, debate issues, make decisions, and write reports, without actually having to meet face to face.  Even when groups meet in the same room at the same time, GroupWare can improve meetings.

The major advantage of GroupWare is its ability to help groups make faster decisions, particularly in situations where it is difficult for group members to meet in the same room at the same time.

The 3 most popular types of GroupWare are;

· Discussion groups.

· Group support systems.

· Video Conferencing.

Group Support Systems (GSS).

Both e-mail and documents-based GroupWare are designed to support individuals and groups working in different places at different times.  They are not suited to support groups working together at the same time and in the same place.  In addition, they don’t provide advanced tools for helping groups to make decisions.

Group Support Systems (GSS) are software tools, designed to improve group’s decision-making.  GSS are used with special-purpose meeting rooms that provide each group member with a network computer plus a large screen video projection system that acts as electronic blackboards.  These rooms are equipped with special-purpose GSS software that enables participants to communicate, propose ideas, analyse options, evaluate alternatives, etc.  Typically, a meeting facilitator assists the group.

The group members can either discuss verbally or use computers to type ideas and information, which are then shared with all other group members via the network.  For large groups where only one person can speak at a time, typing ideas is faster than talking.  Everyone has the same opportunity to contribute and ideas can be collected much faster.  In addition, GSS enables users to make anonymous comments.  Without anonymity, certain participants may withhold ideas because they fear their ideas may not be well received.

The system also provides tools to support voting and ranking of alternatives, so that more structured decision-making process can be used.

Just like in document-based GroupWare, vendors use the Web browser as their client software.  So, almost anyone can access GroupWare Server.
Note. Discussion groups, document-based GroupWare and GSS all focus on the transmission of text and graphical images.

Information Superhighway. 

A term coined by U.S Clinton administration referring to advanced information infrastructure accessible to individuals, groups and firms.

In general, the Information superhighway can be defined as;

· A facility that provides a global electronic data interchange between computer users at a higher rate of message exchange, and at cheaper costs.  E.g., the Internet that allows researchers, businesses, and electronic media to exchange information.
· An Information Communication Technology (ICT) network, which delivers all kinds of electronic services – audio, video, text, and data to households and businesses.

The communication services on the superhighway can be one-to-one way (Telephones, e-mail, fax, etc); one-to-many (Broadcasting, interactive TV, video conferencing, etc), many-to-many (typified by bulletin boards and forums on the Internet).

Origin.
Information superhighway is a mass technology project aimed at creating a National Information Infrastructure (NII) in the U.S.

The concept emerged as the brainchild (idea) of U.S vice president Al Gore.   It is an alliance between the Federal government and a no. of industries.

The Information superhighway describes networks of Optic fiber and Coaxial cable linked by sophisticated switches that can deliver voice, data, image, text, and video signals all in the same digital language.

In the U.S, it has been proclaimed (declared) as the foundation for a national transformation to an information-based society, and a key element in the national efforts to sustain leadership in the world economy.

Governments and industries are developing a new method of competition, which will enable telecommunications, cable television, computer hardware and software companies, and entertainment corporations to work together to create and operate information superhighways.  These activities will finally result into a wide range of electronic services including electronic Shopping malls, collaborate electronic Education and distance learning, electronic Libraries, Multimedia information, messaging, and entertainment. 
Web casting.

Web casting (or “Push technology”) is a special application of the Web that has the potential to dramatically change the way we use the Web /Internet.

With Web casting, the user signs up for a type of information on a set of channels.  Regularly (minutes, hours, days), the user browser contacts the Web server providing these channels to see if they have been updated.  If so, the browser will load the information, and if required by the user, will automatically display the information on the user screen. 

Web casting changes the nature of the Web from one in which the user searches for information (a “pull” environment) into an environment in which the user accepts whatever information is on the Webcast Server (a “push” environment).   This is called the “Push” because the user does not request specific information, but rather permits the Web server to “push” the information when it becomes available.

The Web has been likened to a library because users move form site to site and page to page just like they move from shelf to shelf and book to book in a library.

Web casting is more like TV because the content and time of delivery is selected using the Web caster, the user only chooses the channels.

Web casting can be used for news (e.g., CNN) or financial reports (e.g., Stock market quotations), Corporate announcement, and as a replacement for broadcast e-mail.  It even has the potential to provide automatic updates to software packages.

Importance of services provided on the Internet.

The services offered by the Internet can be used as important tools in various ways:

1). As a research tool:

To learn about new developments or products, competitors, market news and customer opinions.

2). As an advertising / trading tool:

To help in selling goods or delivering information through the Web pages to customers on a 24-hour basis.

3). As a communication tool:

To support communication with customers, suppliers or staff through Electronic mail (e-mail).

4). As an Entertainment channel:

Most of the Games, Movies, and Television theme songs are available for free on the Internet.

In addition, you can have live, interactive conversations with people around the world including celebrities.

Users of the Internet.

Considering the facilities & the various tools offered, the Internet has attracted among others the following users;

· Researchers can get information.

· Writers and Scientists use the Internet to compile, compare and analyse their work.

· Individuals use the Internet for their work or to communicate with each other.

· People with the same interests can share ideas.

· Large organizations use the Internet to communicate with each other, and also to keep in touch with subordinate (subsidiary) companies or their suppliers.

· Students can communicate and gather information.

· Business people can advertise, communicate and sell their goods.

· Sales people use the Internet to keep in touch with their home offices.

· Buyers can do their shopping online.

Exercise (a).

1. (a). What do you understand by the term Internet?

(b). What are the other names of the Internet?

2. Describe the Functions of the Internet.

3. List 6 services that are offered on the Internet.
4. Identify 6 categories of people who can benefit through the use of the Internet.
Exercise (b).

1. Define the Internet.

2. Briefly describe six services offered by the Internet.

3. Discuss the growth of Internet in recent days.

4. Explain the importance of Information superhighway (Internet).
5. Write short notes on the following:

(a). E-commerce.

(b). Webcasting.

(c). Telnet.

(d). Information Superhighway.

CONNECTING (LOGGING ON) TO THE INTERNET.

Log On -To identify yourself & gain access to a computer.  To log on, type a user name & a password.

Facilities Needed.

To use the Internet, you must have access to it.  In order to get connected to the Internet and access the World wide Web, you will require the following facilities:

1). A Computer.

The computer to be used must have the following desirable elements;

(i). A Fast processor, e.g., Pentium 1 & above - to quickly access and download information & programs from the Internet.

(ii). RAM memory of 32 MB & Above.

(iii). Hard disk capacity of at least 400 MB.

(iv). A high-quality Colour Screen – to enable you view the various graphics and images.

(v). Free disk space on which to download the information or programs from the Internet.

2). Web Browsers.

Web browsers are application programs that are used to retrieve Web pages from the Internet onto your Personal Computer.

One of the most popular Web browsers is Internet Explorer from Microsoft.

Each Web page in the World Wide Web is based on an HTML (HyperText Mark Language) file.  A Web browser decodes the information in an HTML file and displays a Web page on your computer screen according to its instructions.  This process is called Downloading.

· Downloading is the process of copying files from one computer to another by using a Modem or a network connection.  You can also download files from the Web to your hard disk.
· HTML (Hypertext Markup Language) -The language used to create Web pages.  To view HTML documents, use Web browsing Software.

3). Telephone lines.

4). Modem (Modulator/Demodulator).

On the Internet, computers exchange information through Telephone lines.  Therefore, to use the Internet, you need a Modem & a Telephone line.

A Modem is a device that enables you to connect to the Internet, and access information.  

As a Transmitting modem, it translates computer information (which is in digital form) into analogue form (the form that can transmit over telephone lines).  This process is called Modulation.

As a Receiving modem, it translates the information back into digital form (a form that your computer can understand); a process called Demodulation.

The Modem must be fast.  This helps to reduce the amount of time spent waiting for Web pages, files, or messages from the Internet.

Modem speeds are expressed in Bits per second (bps).  The typical speeds are 9,600 bps, 4.4 Kbps (Kilobits per second), 28.8 Kbps, 56 Kbps, etc.
5). Internet Service Provider (ISP).
When connecting to the Internet using a modem, you need to sign up with an Internet Service Provider (ISP).
· Internet Service Provider (ISP) is a commercial organization (or a company) that provides Internet connections, along with a set of support services usually for a fee.  It maintains a Server that is directly connected to the Internet. 

· Internet Service Provider - A company or organization that provides Internet Access, usually for a fee.  To connect to your ISP, use a modem.

Most people and organizations connect to the Internet over a Telephone line through an ISP.  However, some larger businesses and institutions (such as universities) have their own Internet connections.

An ISP usually has a no. of Host computers.  These host computers usually provide space for the storage of user’s electronic mail messages, storage of user’s Web sites and a set of related facilities such as, advice, support software and appropriate security.

Examples of the local ISPs include; 

· Africa Online, Kenya Web, ISP Kenya, Swift Kenya, and Inter-Connect.

Connecting to an ISP involves calling the provider and setting up a PPP account.  When you open an account with an ISP, you will be provided with a User name and a Password.

(i). Username – Every time you get connected, you require a name to identify yourself on the Internet.

(ii). Password – This is needed for security purposes.  It ensures that your Internet account is secure.

Note. ISPs charge for the services rendered.

6). Website.

This is an area in the Internet where information of a particular organization is kept.  The Website must be updated on daily basis.

Content Provider - A business that uses the Internet to supply you with information such as news, weather, business reports & entertainment.

ACCESSING THE INTERNET.
There are 3 common ways in which an individual user can access the Internet:

(a). Through a connection already setup through the computer in your organization.  Typically, the service is accessed in a similar way to other services on a LAN.

(b). Through paying for an account with an Internet Service Provider (ISP).

In order to access an ISP directly, the user will need a Personal Computer, a Modem, a Telephone line & a suitable software in order to connect to the service.  Most ISPs give help and advice on how to connect.

(c). Through a Bulletin Board Service (BBS), e.g. CompuServe.  BBS are commercially run information providers, each with its own information services and normally offering access to Internet services.

The BBS companies normally sell some form of start-up package.

Setting up an Internet account.

Purpose.

· To be able to gain access to the facilities that are offered on the Internet, the user needs to log on.  To log on, use Dial-Up to connect to the Internet, and then use a Web browser like Internet Explorer to load Web pages.

There are several ways to start Internet Explorer;

Method 1.

1. Double-click the Internet Explorer icon on the desktop.

Method 2.

1. On the taskbar, click Start, point to Programs, then click Internet Explorer.

You may be required to make a connection through your ISP in order to log on to the Internet.  To do this, a Dial-up Connection dialog box is displayed.

2. Click in the User name box, and type a user name, for instance ‘Iat’.

3. Type in your password in the Password box, and then select the Save password checkbox.

The password appears in asterisk format (***) for added privacy and security.

4. Click the Connect button to access the Internet.

The Internet Connection wizard creates an Internet connection for you, and then displays a list of Internet Service Providers (ISPs) and information about their services. 

To sign up for a new account, click an ISP in the list.

Wizard - A tool that walks you through the steps of a complex task.

Selecting options in the Internet Connection Wizard.

If you are connecting to the Internet using a modem & an Internet Service Provider (ISP), your ISP will supply most of the information needed.  You will also need to provide the following information.

Information




Needed for.

The ISP you want to use


choosing an ISP

Your address & billing information

payment for your ISP account

Note. You may be prompted to restart your computer during the Internet connection process; save and close any open documents before you proceed.

5. After successfully logging on, the Internet Explorer displays the “Home page” and a Connection Indicator icon on the taskbar to indicate that you are online.

Method 3. To open Internet Explorer from Outlook Express.

1. On the Help menu, point to Microsoft on the Web, then click the Web option you want. 

E.g., click Search the Web to look for a Web site, a person, a company, or an organization. 

 – Or- 

Click Best of the Web to open the MSN.COM page that lists some of the best sites on the Web. 

Online Service - An Internet service that provides a wide range of content to its subscribers including Internet Access.

Parts of the Microsoft Internet Explorer screen.

1). Title bar.

2). Menu bar.

3). Address Bar.  It contains the Address box in which you type an address to open the file you want.  The Address Bar provides a method of opening files that are on the Internet or your computer.  

4). Current page, with Links.

5). Scroll bars.

6). Status bar.

7). Standard toolbar; with buttons such as, Back, Forward, Stop, Refresh, Home, Search, Favorites, History, Mail, Print, Discuss.

You can use the toolbar buttons in the Internet Explorer to move between Web pages, to search the Internet or to refresh the content of Web pages.

Button 



description.

Forward



moves to the next Web page.

Back



moves to a previously viewed Web page.

Home



jumps to your home page.

History



displays a list of recently visited sites.

Favorites
displays a list of Web pages that you have selected as your favorites.

Refresh
updates the contents of a currently displayed Web page or window.

Search



opens a Web page that lists the available search engines.

Edit
opens FrontPage Express or Windows Notepad so you can edit a Web page.

Print



prints a Web page.

Stop



stops the downloading of a Web page.

Mail



opens Outlook Express or Internet News.

Viewing connection information.

Purpose.

· When you register with an ISP, you acquire an Internet account with them and from time to time, you may want to view connection information such as, how long you have been online, the speed of connection & the activities done during the online session.

1. Right-click the Connection Indicator icon on the Taskbar.

2. From the shortcut menu that appears, click Status.

The Connected to <Africa Online> dialog box appears:

Some of the useful information displayed on this window includes:

· The speed at which you are connected, e.g. 26,400 bits per second (bps).

· The duration you have been online, e.g., 2 minutes, 50 seconds.

· The Transfer rate, in case you are downloading files from the Internet.

3. Click OK, after viewing the details.

Customizing the Web browser.

Purpose.

· Moving from site to site can be slow if the ISP or Internet lines are busy, if the Host server (the server storing the site you are trying to access) is busy, or if you are using a slow modem.

If a site contains graphics (or other multimedia content like video, audio, etc) you can prevent the graphics from downloading so as to speed up browsing.

1. On the Tools menu, select Internet Options….
2. Click the Advanced tab, then scroll down to the Multimedia section.
3. Deselect the options or content that you want turned off, e.g., Show Pictures, play Animations, or Play Videos, then click OK.
Multimedia – A technology that combines data/text, voices/sounds, graphics, pictures, videos and images into one complete system.  Multimedia uses Optical disk, e.g., CD-ROM to stock all the above in one media.  Multimedia can be used in training.

Logging out from the Internet.

Purpose.

· As long as you are connected to the Internet, you continue to incur Telephone and account usage charges.  This can prove to be expensive in the long run.  

It is recommended that you disconnect or log out from the Internet soon after you have finished with a session.  This is to avoid incurring extra or unnecessary charges.

1. Right-click the Connection Indicator icon on the Taskbar.

2. From the shortcut menu that appears, click Disconnect and you will automatically be logged out.

When you log out, the Connection Indicator icon is disabled.  
Note. Some browsers or ISPs automatically disconnect you from the Internet when there is no activity between the user and ISP for a period of about 5 – 10 minutes.

Understanding the World Wide Web.

Purpose.

· To understand some of the Internet terminologies like Web pages, Web sites, Web browsers, URLs and Home page.

The World Wide Web (www).

The World Wide Web is also known as the Web, WWW or W3.  
· The Web is an Internet application (software) that uses the Internet as its network.

· World Wide Web is the graphical, multimedia portion of the Internet.  

· The WWW is a collection of hyperlinked Web pages published on the Internet.  
· The World Wide Web is a global (an international) system of connected Web pages containing information such as, text, pictures, sound and video.  The WWW is hypertext based (i.e., it is able to access text & graphical data formatted for easy search, retrieval and display).

The Web is a part of the Internet.  It is comprised of millions of Web pages.  This huge collection of documents is stored on computers, called Hosts, around the world.  

The documents may contain text, pictures, sound, small programs or forms to be completed by a user.  

To view files on the Web, you need Web browsing Software.   This software can be used to view different locations on the Web or to explore the Web pages.  

Web pages.

· Web pages are documents published by organizations and individuals who are interested in putting themselves on the Web.  Web pages can include text, pictures, sound and video.

· Web page is a location on the WWW, usually a Web site.
The Web pages can also be found on company Intranets.

Intranets and Extranets.

What is an Intranet?

· An Intranet is an internal corporate network used in organizations to enable the sharing of documents among coworkers.  It supports users inside one organization (usually on a LAN).

· Intranet - A private network within an organization. It can connect all types of computers within an organization.
Intranet has a private Web Server, which can be made available to the entire organization, individual department or to specific departmental workgroups.

An Intranet uses the infrastructure and standards of the Internet and can be connected to the Internet.
Note. Intranet applications are usually combined with the normal Web application of other organizations, but are hidden from those outside the organization.

Extranet:

An Extranet works in much the same manner as an Intranet, but provides information to selected users outside the organization.  

E.g., a certain university can have an Internet library containing millions of articles, but only make it available to staff and students at colleges and universities within the country.

To access the library, you must provide a password when you connect to the Internet site.

Home Page.

· Home page is the Web page loaded when Internet Explorer is first started, i.e., when you access the Web.

E.g., the Internet address of the Windows home page is http://www.Microsoft.com /Windows
· Home page can also the first page of a company or an individual’s Website on the Web.
Those who offer information through the Web must first establish a Home page – a www text and graphical screen that welcomes the user and explains the organization that has established the page.
· Home page – is the introductory page of a Web site.  The home page contains links to other pages in the site.

Notes. 

· You can set any Web page as your Home page.

· Do not confuse your home page with the home page of the Websites you visit.  Your home page is set through Internet Explorer.  The home page of a Website is the introductory page for the site.

If you click a hyperlink such as Home on a Web page, you will jump to the home page of the Website, not yours.  To access your home page, click the Home button on the Explorer toolbar.

Web Site.

· A collection of Web pages belonging to an organization or individual.  These organizations or individuals maintain the Website.

· Web site - A group of related Web pages.

· A Web site is a screen or a collection of screens that provide information in text or graphical form that can be viewed by Internet users by activating the appropriate icon or commands.

Web Browsers (Web browsing software).

A Web browser is a program that lets the user browse through information on (or surf) the Web.  

Information on the Web is structured into pages.  Each page has a specific address that is used to locate and access information on that page.

A WWW browser program enables the user to either search for data by name or by specifying locations known as Uniform Resource Location (URL).

The two common Web browsers are:

· Internet Explorer from Microsoft.

· Navigator from Netscape.

Browsing the Web.

This is also known as Navigating or ‘Surfing’ the Web.
· To Browse is to navigate the Internet or the contents of your computer.

· Browsing can also be defined as moving around and between Web pages.  

Using a Web browsing software you can read documents, listen to music, watch videos, make purchases, participate in surveys, advertise products, do research, share interests and download files on the Web.

EXPLORING / BROWSING THE INTERNET. 

Use the Internet Explorer on your Windows desktop to browse the Web. 

There are several ways in which you can browse the Web pages or “surf the net”.
(a). When viewing a Web page, you can navigate the Internet by clicking Links, Underlined text or special features that cause you to jump to another Web page.

Hyperlinks.

A Hyperlink is a coloured or underlined text or a graphic that you click to ‘jump’ from one location to another.  The hyperlinks enable the user to ‘jump’ to another file, or to another location in the same file.

All Web pages have hyperlinks.  These links:

(i). Connect one part of a Web page to another part of the same Web page.  This is useful if the Web page is large.

(ii). Connect one Web page to another Website somewhere on the Web.

(iii). Connect a page to a file, such as a sound clip, video, a Spreadsheet or a Word document.

The links can connect to objects stored anywhere on the Internet.  

Hypertext links are indicated by underlined text highlighted usually in blue.  Hyperlinks can also be represented by buttons, graphics or pictures.

To find hyperlinks on a page, move your mouse pointer over the page and where there is a hyperlink, the mouse pointer will change into a hand with a pointing finger.  When you click a link, another Web page appears.

As you browse the Web, Internet Explorer stores the sites and pages that you visit.  Usually, the hyperlinks you previously selected are colored differently.  Internet Explorer does this to remind you that you have already visited the page identified by this link.

(b). You can also use the Standard toolbar buttons in the Internet Explorer to move between Web pages, or to search the Internet.
History.

Internet Explorer remembers the Websites and Web pages that you have visited.  It keeps record of each Web page as it is downloaded.  This is the History feature.

You can therefore, easily return to the page you have visited.  To redisplay the page you have just left, click on the Back button.  To move to the next page (available only if you have moved back), click the Forward button.

Web Hosting.

A World Wide Web Server is a computer with programs that answer requests for documents from Clients (browsers) over the Internet.  Files containing Web sites are placed on these servers.  
A Host computer is any computer connected to the Internet and stores information that has been made available to the Web.
ISPs also use host computers to store user’s electronic mail messages, Web sites and other related facilities such as, support software and appropriate security.
Web Address (Uniform Resource Locator – URL).

An Address is the location of a file.   
Each Web page in the world has a unique Internet address or location.  Internet addresses are also called the Uniform Resource Locator (URL).  E.g., the general URL for Microsoft is http://www.Microsoft.com./ 
You can use addresses to find files on the Internet & your computer.  You can instantly display any Web page if you know its URL.  E.g., http://www.compaq.com.    

AutoComplete - A feature in the Address Bar.  When you begin typing a previously used address, this feature finishes it as you type.

How the Web Works.
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Each Client computer needs an application software package called a Web browser, such as Navigator, Internet Explorer.  

Each Server on the network needs an application software package called a Web Server.  There are many different Web servers, such as those produced by Netscape, Microsoft and Apache.

In order to get a page from the Web, the user must type the Uniform Resource Locator (URL) for the desired page, or click on a link that provides the URL.  The URL specifies the Internet address of the Web Server, the directory and the name of the specific page required.  If no directory or page is specified, the Web server will display whatever page has been defined as its Home page.  If no server name is specified, the Web browser will assume that the address is on the same server and directory as the last request.

In order for the Web server to understand requests from the Web browser, they must use the same standard protocol.  If there was no standard, then each Web browser would use a different way to request pages.  This means that, it would be impossible for a Web browser from Netscape to communicate with a Web server from Microsoft.

The standard protocol for communication between a Web browser and a Web server is the HyperText Transfer Protocol (HTTP).  An HTTP request for a Web browser to a Web server has 3 parts, but only the 1st part is required, the other two are optional.

· The Request Line, which starts with a command (e.g., GET), provides the URL, and ends with HTTP version number that the browser understands.

· The Request Header, which contains a variety of optional information such as the Web browser being used (e.g., Internet Explorer), the date, the User ID and Password for using the Web pages as password protected.

· The Request Body, which contains information sent to the Server, such as information from a firm.

Note.  Every Web user must provide the Internet address of the receiving computer, otherwise, the server would not know where to send the requested page.  

Some browsers also provide the requestor’s e-mail addresses as well.  Most Web servers keep a record of Internet addresses of all the requests (and the e-mail address, if provided by the browser).  Some companies use this information to make a follow up with prospective customers.

An HTTP response for a Web server to a Web browser also has 3 parts, but only the last part is required, the first two are optional.

· The Response Status, which contains the HTTP version number the server has used as status code (e.g., 200 means ‘OK’, 404 means ‘Page not found’), and reason phrase (i.e., a text description of the status code).

· The Response Header, which contains a variety of optional information such as the Web server being used, the date, the exact URL of the page in the response body, and the format of the body (e.g., HTML).

· The Response Body, which is the Web page itself.

Internet Addresses.

Internet addresses are strictly regulated, otherwise, someone could add a computer to the Internet that had the same address as another computer.

Each address has 2 parts; The computer name and its domain.  

The Domain is the specific part of the Internet to which the computer is connected (e.g., Canada, Australia, etc).  

The general format of an Internet address is therefore: computer.domain.  Some computer names have several parts separated by periods.  For example, the main university Web server of an imaginary University like Yairobi can be www.Yairobi.edu, while the college of Humanities and Social Sciences server can be www.chss.Yairobi.edu. 

Each domain has an address board that assigns address for its domain.  The boards ensure that there are no duplicates.

Finding Web pages (information) on the Web.

There are 3 ways you can use to find interesting and useful Web pages on the Web;

1). You could get the Web address from an advertisement.

Many businesses include their Web addresses in their Television and Print advertisements.

2). You click a link that will enable you jump from one page to another.

Many industries or organizations, magazines and topic experts maintain pages that provide links from page to page.

3). Use of Search Engines.

Search Engines / Search Services.

· A Search engine is software that helps in locating information in the Web.

· Search engine is a tool that searches the Web for information that you want to find.  
Purpose.

· If you want to get some information concerning an area or subject of interest over the Web but you do not know where to find it, you can use a Search engine to locate sites that contain the information.

· Locate particular information in a Website, e.g., if you wish to read the Sports news you can load a Web site like http://www.cnn.com/, and then use a search engine within that site to locate information on Sports.

The following are the various search engines:

1). Yahoo – www.Yahoo.com. 

2). AltaVista – www.altavista.digital.com. 

3). Excite – www.excite.com.  

4). Meta Crawler – www.metacrawler.com.

5). Infoseek.

6). Lycos.

These search engines offer different kinds of searching capabilities.  However, they differ in the way they organize information in response to your request.

Yahoo focuses on the largest & most important Websites and organizes them in a directory format.  Small and little known Websites are excluded.  Therefore, if you are looking for the address of a well-known company or product or a popular topic, Yahoo is probably the easiest way to find it.

Alta Vista is the broadest of all.  It lists almost everything it can find.  It is probably the best choice if you are looking for an unclear topic or a very specific combination of topics or words (e.g., to find a famous quote).

The major disadvantage of Alta Vista is that, you may have to look through dozens of sites before you find the ones you want.  In addition, Alta Vista does not provide some help in focusing your search.

Excite is easier to use in that, it uses advanced special intelligence techniques to help you search those pages that best match your interest.  E.g., after looking at the result of a search, you can tell Excite to find more pages that are similar to a specific page it has found.  Excite will then search again and present those pages first.  In this case, Excite refines the search based on the characterization of the page you have selected.

Meta Crawler provides the best search facilities.  It does not search the Web and provide a list of what it finds.  Instead, whenever you enter a search request, it simultaneously sends that request to several search engines (including Yahoo & Alta Vista), then combines, and organizes the information it receives from all the search engines into one display.

How Search Engines find Web pages.

Hundreds of thousands of new Web pages are created each day.

There are 2 ways that search engines use to locate Web pages:
· Use of Spiders / Robots.

· Through Submissions.

(a). Spiders.

Search Engines normally use software spiders to explore the Web.  The Spiders are usually automated robots that travel around the Web looking for new pages, and creating links to them.

These spiders methodically search all the pages on the Websites they can find and report back their discoveries.  The search engine builds an index to these pages based on the words they contain.  When you connect to a search engine, and type a few words describing what you want, the Search engine will search its index for these keywords and provide you with a list of pages that contain them.

(b). Submissions.

These are derived from people who have created new Web pages and then submit information about the pages they have created.

1. Select a search engine, e.g., Yahoo, and type its address in the Address box, i.e., http://www.yahoo.com/. 

Once the search engine home page appears, type a keyword or phrase in the Search box, e.g., Kenya, then click the Search button.

Note.  The steps may vary depending on the search engine you are using.

2. When the search is completed, a list of sites that contain the keyword or phrase you are looking for is displayed.  Select a site whose description comes closest to the information you desire and click on its link.

3. If there are many sites, an option that allows you to view the next 10 or so matches is displayed.  Click on this if necessary to view the next set of links.

If there are too many matches, you may want to use an additional keyword to narrow down the search.  E.g., to find the sites that contain information about the economy in Kenya, in the Search box, type phrase “Kenya AND Economy”.

4. Click the Search button.

5. From the search results, select the links that may help you get the information you require.  

Locate information within a Website.

Once you access a Website, you can search for specific text or information on that site or page.  

Unlike search engines like Yahoo, Infoseek, Lycos, Web Crawler, and Excite that present you with the URLs or links of sites that hold information you are looking for, search engines within a Web page locate information within that Web page.

1. Load the Web page to browse.  E.g., let’s use a Website: http://www.carleton.ca. 

2. Click in the Search box, and type a keyword(s), e.g., International AND Student.

Note. When typing in a keyword, you can use logical words or operators like AND (when you want to display results that meet both criteria) and OR (when you want to display results that meet one of the two criteria).

3. Click the Search button, to begin the search.

4. From the Search Results screen, click on a link that is closest to your requirements.

To open a favorite Web site from the Start menu.

1. Click the Start button, point to Favorites, and then click the Web page you want. 

To search the Web from the Start menu.

1. Click the Start button, point to Find, then click On the Internet. 

To use the Run command to open a Web page.

1. Click Start, click Run, and then type the Internet address you want. 

If the page you are opening is one you've viewed before, the AutoComplete feature can complete the address for you.

To find pages you've recently visited.

To find Web sites and pages you've viewed in the last few days, hours, or minutes.

1. On the toolbar, click the History button. 

The History bar appears, containing links for Web sites and pages visited in previous days and weeks.

2. In the History bar, click a week or day, click a Web site folder to display individual pages, and then click the page icon to display the Web page. 

Notes.
· To return to the last page you viewed, click the Back button on the toolbar. 

· To view one of the last nine pages you visited in this session, click the arrow to the side of the Back or Forward button, and then click the page you want from the list. 

To enter Web information more easily.

The AutoComplete feature saves previous entries you have made for Web addresses, forms, and passwords. 

When you type information in one of these fields, AutoComplete suggests possible matches. 

1. When typing an information in the Address bar, and the AutoComplete feature suggests what you want to enter in that field, click the suggestion.  If not, continue typing. 

Setting or changing a Home Page.

Home page is the page that is displayed every time you start Internet Explorer. 

Note.  Make sure it is a page that you want to view frequently, or make it one that you can customize to get quick access to all the information you want, such as the Msn.com home page. 

Purpose.

· To enable the user to choose or specify a page that will provide a good starting point for exploring the Web.

The Home page will appear each time the user accesses the Web.

1. Go to the page you want set as your Home page.

2. On the Tools menu, click Internet Options....
The Internet Options dialog box appears.
3. Click the General tab.

4. Under the Home Page section, type the address of the new home page in the Address box.  Alternatively, click Use Current to make the current Website the home page.

5. Click the OK button.

Tips. 

· To restore your original home page, click Use Default. 

· You can return to your home page anytime by clicking the Home button.

Exercise.

1. Mention at least 4 facilities that are needed to connect to the Internet.
2. How can you establish the time you have been online in a session?

3. In a step-by-step format, illustrate how you can log out of the Internet.

4. Define the following terms:

(a). Intranet.

(b). Extranet.

(c). Worldwide Web.

5. (i). What is a Web site?

(ii). Give the advantages and disadvantages of a Web site.

6. Give 2 examples of Web Browsers.

7. Explain the term ‘Host computer’.

8. Define the word ‘History’ with reference to a Web browser.
9. (a). What is a Search engine?

(b). Give examples of Search engines.

10. How does the Web work?  Explain with the help of a diagram.

11. Describe the procedure of finding information on the Web.

Downloading Web pages and programs from the Internet.

Purpose.

· To enable the user to view Web pages without being connected to the Internet.

· To be able to browse a site in a location that does not provide any network access.

· In order to free your telephone lines.

Downloading a Web page.

1. Load the Web page you want to download, e.g., http://www.nationaudio.com. 

2. Access all the links that you would like to read offline.  Make sure that the whole Web page is fully loaded before moving to the next one.

3. On the Favorites menu, click Add to Favorites.

4. Select the option Yes, notify me of updates and download the page for offline viewing.

5. Click OK, and then Logoff.

Downloading a program.

· Programmers and software houses like Microsoft usually develop programs and may decide to send a test copy to their existing clients or to publish it on the Internet for interested users to test it for a specified period of time.

To test such software, a user will have to download the program onto the hard disk.  A user can also download a movie clip or games, etc, and view it offline to save on costs.

1. Locate a site from which you wish to download a program, e.g., http://softwarenow.iboost.com. 

2. Select the category of programs you want to download, e.g., Games.

3. Select a game category, e.g., Racing Games.

4. Select a game you want to download.

Note. The window lists the properties of the program, e.g., version, file size.  Ensure that you understand the licence agreement, i.e., whether the program is freeware or shareware.

Freeware is a program that is absolutely free, while Shareware program is available for a limited period of time.

5. To download the program, click on the download link, e.g., Download Cars & Brix.

6. From the File Download dialog box, select Save this program to disk option, then click OK.

7. In the Save As dialog box, select the folder in which you wish to store the downloaded program, then click Save.

Once the program is loaded, you can access the folder it was saved in and load it without being connected to the Internet.

Saving pictures or text from a Web page.

Purpose.
· You can save information for future reference or in order to share with other people.  You can save the entire Web page or any part of it: text, graphics, or links. 

· You can print Web pages for people who don’t have access to the Web or a computer. 

To copy information from a Web page into a document, 

1. Select the information you want to copy, on the Edit menu, click Copy.

To use a Web page image as desktop wallpaper.

1. Right-click the image on the Web page, then click Set as Wallpaper.

Saving information (a Web page) from the Internet to the Hard disk.

Purpose.

· When you come across a Web page you would want to read, but it is too long, you can save the Web page onto your hard disk so as to read it later on when you are off-line.  This helps in reducing the costs of browsing while online.  

1. Load the Web page you want to download. 
Make sure the Web page you want to save is completely transferred to the screen of your Web browser.

2. On the File menu, select Save As.

3. In the Save HTML Document dialog box that appears, select the drive & folder where you want to save the page in.

4. In the File name box, type a name for the page.

5. In the Save as type box, select a file type.

· To save all of the files needed to display this page, including graphics, frames, and style sheets, click Web Page, complete. This saves each file in its original format.

· To save just the current HTML page, click Web Page, HTML only. This will save the information on the Web page, but it does not save the graphics, sounds, or other files.

· To save just the text from the current Web page, click Text Only. This saves the information on the Web page in straight text format.

6. Click Save.  

The Explorer program automatically assigns the extension .htm to the file name.

To open a saved file.

· After saving a Web page, you may want to read and analyze the information at a later time.  

· You may also want to send the saved file to another person via e-mail as an attachment.

1. On the File menu, select Open.  This displays the Open dialog box.

2. Click on the Browse button in order to locate the folder where the file is stored.

3. Click the file, then choose Open.

Note.  When you save a file in a local disk, only the text on the page is shown.  The graphics in a site are displayed in graphics placeholders (which appear as small rectangles).

Graphics and Download time.

When designing Web pages, graphics have to be incorporated sensibly into the Web page.  

Although they are appealing to the eye, the more graphics you use on a Web page, the longer the Web browser will take to download the page.

File Formats.

The most common file formats found on the Internet are:

· Graphic Interchange Format (GIF), and

· Joint Photographic Experts Group (Jpeg).

Generally, GIFs are used for simple page design elements like lines, buttons and dividers, while JPEGs are mostly used for complex photographs and images.

Movie (video) files usually have the extension .avi, .mpg, or .mov, while Sound (audio) files have the extension .au, or .ra, or .ram, or .wav.

Printing Web pages.

Purpose.

· To obtain a hard copy of the information that you have researched on and collected, for the purposes of reviewing later or filing.

Change how a page looks when it prints.

Before printing a Web page, it is advisable to check the settings in the Page Setup dialog box.  

This will ensure that the right Paper size, Margins and Orientation of the page are set correctly.  You can also add headers and footers to a Web page.

1. On the File menu, click Page Setup. 

2. In the Margins boxes, type the margin measurements (in inches). 

3. In the Orientation area, click either Portrait or Landscape to specify whether you want the page printed vertically or horizontally. 

4. In the Header and Footer boxes, specify the information to be printed, then click OK. 

Printing the Web page.

1. On the File menu, click Print to display the Print dialog box.

2. Set the printing options you want, then click OK. 

Exercise.

1. What are the benefits of saving information from the Internet to your hard disk?

2. List the type of files that can be downloaded from a Website.

3. In which dialog box would one enter a footer and header of a Web page to be printed.

4. Graphic objects are visible upon opening of saved Web pages.  True/False? Explain.
5. Define the following terms with respect to the Internet:

(i). Website.

(ii). Upload.

(iii). Access Provider.







(6 marks).

Creating a Bookmark.

Purpose.

· When you browse the Web, you may come across sites that you want to visit regularly.  

Examples of such sites include; news sites like CNN or BBC.  You can decide to ‘bookmark’ the Web page.

The Bookmark feature (also known as a Hotlist or Favorites feature) allows you to store the addresses of Web pages that you frequently visit.  Hence, you do not have to constantly retype your favourite Web page addresses.  When you want to visit the site, simply select the bookmark from a list.

1. Open the Website that you want to create a shortcut to.  E.g., http://www.cnn.com. 

2. On the Favorites menu, choose Add to Favorites.

The Add to Favorites dialog box appears.  The name of the site you are in appears on the Name box.

3. Under Create in: click the folder you want to add the site to, e.g., Links, then click OK.

This will add the title of the Web page in the Favorites list.

To go to a site using a Bookmark.

1. On the menu bar, select Favorites.

2. Select the folder that holds the favorites item, e.g., Links.  

3. From the drop-down list, click CNN.com.
To delete a Bookmark.

1. On the menu bar, select Favorites.

2. Point to the item from the Favorites list, e.g., CNN.com.

3. Right-click the item, and then click Delete.

The Confirm File Delete dialog box appears.

4. Click Yes, to remove the item from the list.

Working Offline.

Connection to the Internet usually means that you are using telephone lines, and therefore incurring telephone charges and usage on your ISP account.

Offline - Not connected to a network or the Internet.

BROWSING THE WEB (INTERNET) OFFLINE.

Purpose.

· To enable the user to save on the time spent connected to the Internet, and hence reduce the general costs of being online.

1. Access the Web site that you want to browse offline.

2. Access all the links to download all the information you require.

Ensure that each Web page is downloaded completely before going to the next one.

3. On the Taskbar, right-click the Connection Indicator button, then choose Disconnect.

The Connection Indicator disappears from the Taskbar showing that you are now working offline.

After disconnecting the user can go ahead and read all the downloaded information.  The user can also “browse” through the site while offline provided all the pages and links are downloaded.

Note. Some services like Internet, Usenet, Newsroom, or Shopping will not be available when you are offline.  To use these services, you need to re-establish the connection.

Making Web pages available for offline viewing.

Offline Reading -To view a Web page without being connected to the Internet.

You can download the page to your hard disk, disconnect from a network or the Internet, and read the material later.

When you make a Web page available offline, you can read its content when your computer is not connected to the Internet. 

E.g., you can view Web pages on your Laptop computer when you don't have a network or Internet connection. 

1. On the Favorites menu, click Add to Favorites. 

2. Select the Make available offline checkbox. 

3. To specify a schedule for updating that page, and how much content to download, click Customize. 

4. Follow the instructions on your screen. 

Note. Before you go offline, make sure you update your pages.  To do this, click the Tools menu, then click Synchronize. 

To make an existing favorite item available offline.

1. On the Favorites menu, click Organize Favorites. 

2. Click the page you want to make available offline. 

3. Select the Make available offline checkbox. 

4. To specify a schedule for updating that page, and how much content to download, click Properties. 

Get Help with Internet Explorer.

Purpose.

· While working with Internet Explorer, you may sometimes need help on how to perform certain tasks or help on a particular topic of interest.

1. On the Help menu, select Contents and Index (or press F1).

The Internet Explorer Help window is displayed.

2. Click the Contents tab.

3. Click a book in the list, and then click a Help topic you want to look at.

The Help topic contents are displayed on the right-hand side of the Help window.

4. Read the help and click the hyperlinks (blue, underlined text) if you want to see help on related topics.

5. When you have finished, click the Close button to exit help.

Using the Index to get Help.

1. On the Help window, click the Index tab.

2. Type in the first few letters of the word or topic that you are looking for.

In the Index box, all the help topics are listed in alphabetical order.

3. Click the Display button to view the information about the topic selected.

Exercise.
1. What is a Bookmark?

Advantages of the Internet.

(i). One can download (copy) information from a Website.

(ii). The Internet has enabled the interlinking of people worldwide / globally.

(iii). It is convenient in the sense that you can access data 24 Hrs.

(iv). It is cheap, i.e., the operational cost that one may incur is low.

(v). It has brought in the technology of doing the following; E-learning, E-Agriculture, E-commerce, E-governance, etc.

(vi). Provides up-to-date information.

(vii). It doesn’t require a lot of training to browse.

(viii). It provides entertainment facilities.

(ix). Can be used for research.

(x). Brings harmony in the world, because people can communicate and exchange ideas.

(xi). The Internet can be accessed at any part of the world.

(xii). There is always a full backup provided by the Servers, hence no data loss.

(xiii). It’s a fast way of communicating. 

(xiv). It provides an easy way to use offers in Information and products.  

Internet provides information from almost all parts of the world that you need in order to make accurate and informed decisions.

You will get information you need from business to education, from sports to politics, from arts to eating out.  
Disadvantages of Internet.

(i). It’s a technology, which is fetched for (imposed/forced on) the Third world countries.

(ii). The cost of the Internet Service Provider is high.

(iii). It is leading to exposure of morally harmful shows such as Pornography.

(iv). It leads to spread of viruses.

(v). Has proved to be unreliable especially accessing information.

(vi). No copyright rules meant to protect the property of an organization.

ELECTRONIC MAIL (E-MAIL).

About e-mail.

Electronic mail (also known as e-mail) is one of the common services provided by the Internet.

· E-Mail is a worldwide system for sending & receiving electronic messages from one computer to another.

· E-Mail (Electronic mail) refers to electronic messages sent over the Internet or a network.  E-mail can contain both text & files.

With e-mail, users can create and send messages to one user, several users, or all the users on a distribution list.

Most e-mail software enable users to send text messages. In addition, users can attach files from Word processors, Spreadsheets, Reports, production data, etc, and then send them by e-mail. 
Most E-mail packages allow you to do the same things you do with regular paper mail.  You can file messages in electronic file cabinets, forward copies of messages to other users, send “carbon copies” of messages, and so on.  The E-mail packages also allow you to filter or organize messages by priority.  E.g., all messages from a particular user (e.g., your boss) could be given top priority, so that they always appear at the top of your list of messages.

However, E-mail is a much faster, economical & convenient way of sending messages to family, friends and colleagues than the paper mail (usually called “Snail mail”).  Messages can be sent or received 24-hrs a day.  With “Snail mail” a message or a letter is sent to the recipient through the Post office and takes days or weeks before reaching the destination.  
Components required.

For one to be able to communicate using e-mail, the following components are needed:

1). A Computer - where you will send or receive the e-mail messages.

2). An E-mail program.
Your computer must be installed with an e-mail program that lets you send, receive and manage your e-mail messages.  

Examples of E-mail programs; 

· Microsoft Outlook, Outlook Express, & Microsoft Exchange from Microsoft.

· Communicator from Netscape. 
· Lotus Notes.

· Eudora.

3). E-mail address of the sender & the address of the receiver.

4). An Internet Service Provider (ISP) - company who will deliver your message to the receiver.

Once you send a letter or a message, it travels from your computer through a Modem, which connects your computer to the Internet using the Telephone network.  The Mail passes through various computers, until it reaches the final destination.
How E-mail Works.

The figure below shows how an e-mail message can travel over a Wide Area Network (WAN) such as the Internet.
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Each Client computer in the Local Area Network (LAN) runs an e-mail software package called User Agent, e.g., Eudora, Lotus Notes, Outlook Express, Microsoft Outlook, etc.

The user writes the e-mail messages using one of the User Agents, which formats the message into 2 parts;

(i). The Header, which lists the source and destination e-mail addresses.

(ii). The Body, which is the message itself.

The User agent sends the message header & body to a Mail Server that runs a special application package called a Message Mail Transfer Agent.  The Message Mail Transfer Agent in the Mail Server reads the envelope & then sends the message through the network (possibly through dozens of Message Transfer Agents) until the message arrives at the Mail Server of the receiver.  

The Message Transfer Agent on this server then stores the message in the receiver’s mailbox on the server.

When the receiver accesses his/her e-mail, the User Agent on the receiver’s Client computer contacts the Message Transfer Agent on the Mail Server, and asks for the contents of the user’s mailbox.  The Message Transfer Agent sends the e-mail message to the client computer, which the user reads using the user agent.

E-MAIL STANDARDS.

Several standards have been developed to ensure the compatibility between different e-mail software packages.  

The 3 commonly used standards are:

1). Simple Mail Transfer Protocol (SMTP).

2). X-400.

3). Common Messaging Calls (CMC).

All the 3 e-mail standards work in the same basic fashion.  

Simple Mail Transfer Protocol (SMTP).

SMTP is the most commonly e-mail standard used on the Internet.

SMTP defines how Message Transfer Agents operate and how they format messages sent to them.  As the name suggests, SMTP is a simple standard that permits only the transfer of text messages.  Non-text files such as graphics or Word processing documents are not permitted.

However, several standards for non-text files have been developed that can operate together with SMTP.  They include; Multi-Purpose Internet Mail Extension (MIME), Unencoded & Bin Hex.

A different standard called Post Office Protocol (POP) defines how User agents operate and how messages to & from the Mail Transfer Agents are formatted.

POP is gradually being replaced by a newer standard called Internet Mail Access Protocol (IMAP).  

The main difference between POP & IMAP is that, before a user can read a mail message with a POP user agent; the e-mail message must be copied to the client’s hard disk and deleted from the mail server.  With IMAP, e-mail messages can remain stored on the mail server after they have been read.  Therefore, IMAP is beneficial to users who read their e-mail from many different computers (e.g., at home, in office & in computer labs), because all e-mail is stored on the server until it is deleted.

X-400

The X-400 e-mail standard was developed in 1984.  It is a set of seven (7) standards that define how e-mail is to be processed by the User agents and the Mail Transfer Agents.

Common Messaging Calls (CMC).

The CMC standard is a simpler version of the X-400 standard.  

It was developed in 1994.

It is more popular than X-400, because it is simple & it is also supported by a large no. of leading vendors/sellers.

File Transfer Protocol (FTP).

FTP enables you to send and receive files over the Internet.  FTP requires an application program on the client server and an application program on the FTP Server.  Many application packages use the FTP standard (e.g., WS-FTP).

Almost anyone can establish a FTP server, which permits anyone on the Internet to log in, send and receive files.

There are 2 types of FTP sites;

(i). Closed.

(ii). Anonymous.

Closed FTP site.

A Closed site requires users to have permission before they can connect and gain access to the files.  Access is granted after the user provides an Account name with a secret password.

For example, a Network Manager would write a Web page using software on his/her client computer and their user FTP to send it to a specific account on the Web Server.

Anonymous FTP site.

Anonymous is the most common type of an FTP site.  

It permits any Internet user to log in using the account of anonymous.

When using the anonymous FTP, you will still be asked for a password.  You can enter your Internet e-mail address as the password.

Many files and documents available via FTP have been compressed to reduce the amount of disk space they require.

Note.  If a file that you want has been compressed by a compression program that is not in your computer, you cannot access the file until you get the decompression program it used.

Using Lotus Notes.

One of the problems with e-mail is that, it lacks a structured way to support an ongoing discussion.  Each mail message is a separate item, unrelated to the other messages.  Usually, you can group and file e-mail messages into separate file folders, but it not possible to combine them.

Using Lotus Notes (a document database of text and graphics), documents with different sections can be organized into a hierarchical structure of sections, documents and folders.

Lotus Notes can be used as a computer Bulletin board to support ongoing discussions. Several topics and sub-topics can be created, and everyone or selected individuals in the organization can be given access.  

Lotus Notes can also be used to organize a discussion among certain people such as a Project team working to improve manufacturing quality.  It might reduce the amount of time the team spent in face-to-face meetings, because many of the issues might be discussed before the meeting actually starts.

Lotus Notes also could be used to replace standard Word processors in preparing reports.  Each team member could use Lotus Notes to write a portion of report, which could then be passed to other team members for editing or comments.

Lotus Notes can also automate certain document-based processes (called Workflow automation).  For example, insurance claims require people from several different parts of an Insurance company to work together to process the claim.  One person might handle the initial claim, which would then be passed to an Insurance adjuster to finish a report.  Another person would process the payment.  All this paperwork could be replaced if Lotus Notes were used to prepare and pass the documents from one person to another.

Note. Lotus Notes has the ability to replicate.  Replication is the automatic sharing of information among servers when information changes.  E.g., Lotus Notes servers can be set to replicate information they contain within any other Lotus Notes server on the network, so that a change to a document on the server will automatically be shared with all other servers that contain the same document.

Setting up (adding) an E-mail or News account.

To set up an e-mail account, use an e-mail program such as Outlook Express.  Outlook Express is a Web browsing software that can help you exchange e-mail messages with colleagues and friends on the Internet or join newsgroups to trade/share ideas and information.

You will need the following information from your Internet Service Provider (ISP) or Local Area Network (LAN) administrator:

· For e-mail accounts, you'll need to know;

· The type of Mail server you use (POP3, IMAP, or HTTP) 

· Your Account name and Password.

· Name of the incoming mail server and, 

· If you are using POP3 or IMAP, the name of an outgoing mail server. 

· For a news account, you'll need to know;

· The name of the news server you want to connect to and, if required, your account name and password. 

To add a mail or news account.

1. On the Start menu, point to Programs, then click Outlook Express.

2. On the Tools menu, click Accounts. 

3. In the Internet Accounts dialog box, click the Add button. 

4. Select either Mail or News to open the Internet Connection Wizard, and then follow the instructions to establish a connection with a mail or news server. 

Tips.

· After you set up your account, just double-click the Outlook Express icon on the desktop to begin sending and receiving e-mail.

· You can get a free mail account from Hotmail, which uses HTTP servers. 

E-mail addresses.

Each user has his own e-mail address (or mailbox) in form of computer storage space to receive messages.  The mailbox is accessed via a computer terminal within the system.  In addition, each user has a password to protect access to his/her own mailbox.

Messages are drawn to the user’s attention when they enter the system.

Components of an E-mail address.

An e-mail address consists of two parts separated by the @ symbol.  For example, if your e-mail address is Drg@tropicalheat.com: 

(i). The 1st part of the address to the left side of the @ symbol refers to the person’s identity or login name.  It is the name or identifier of the specific individual or organization, e.g., “drg”.

(ii). The 2nd part following the “@” symbol is the computer address.  It is usually made up of 2 to 3 sub-parts to further identify the individual, organization, ISP or a country.  In this case:

· “tropicalheat” identifies the business.

· “.com” is the extension, which identifies the type of the organization.

The table below shows some extensions and what they represent: -

	Extension 
	Represents

	.org
	A non-profit making organization

	.edu
	An educational institution or organization

	.com
	A commercial organization

	.net
	Network

	.mil
	Military

	.gov
	government


Sometimes, the name of the country is included in the e-mail address.  E.g., Skynews@sky.co.uk or Nation@africaonline.co.ke. 

In this case, “.co.uk” refers to a company in the United Kingdom, while “.co.ke” refers to a company in Kenya.

Examples of E-mail addresses;

Smith@CompuServe.com
Iat@Africaonline.co.ke
Were@Egerton.edu
Manager@Kenyapower.org
Bridge@arcc.or.ke
Tim@Yahoo.com

(free e-mail address)
Douglas@hotmail.com
(free e-mail address)
Exercise.

1. (a). What is E-mail?

(b). Give TWO examples of e-mail software.

(c). Give an example of an e-mail address.

2. Identify institutions whose e-mail addresses end with the following extensions:

(i). .org
______________________________________________________

(ii). .gov
______________________________________________________

(iii). .edu
______________________________________________________

(iv). .com______________________________________________________

(v). .net
______________________________________________________

(vi). .mil
______________________________________________________

3. Identify the parts of the following e-mail address:

iat@africaonline.co.ke 
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Reading E-mail Messages.

Purpose.

· Once an e-mail message that has been sent to you arrives at your computer, to read the contents you must open it using the program you have installed for sending e-mail, e.g., Microsoft Outlook or Outlook Express.

1. Open the e-mail program, e.g., Outlook Express from the Start menu or a shortcut on the desktop.

The Choose Profile dialog box appears to allow you to select your profile.

Note.  A User Profile is a group of settings that define how the e-mail program is set up for a particular user.  It also defines through the information services how a user can send, store, and receive messages.

2. Select your profile by clicking the down arrow on the Profile Name box, and then click OK.

Usually, all incoming messages are stored in the Inbox when you connect to Outlook Express.  The Inbox displays all the e-mail messages that you have received.

3. To open and read e-mail messages, click the Inbox icon either on the Outlook bar or on the Folders list, and then choose the message that you want to read.

· To view the message in the preview pane, click the message in the message list. 

· To open the message in a separate window, double-click the message in the message list. 

The lower grid of your screen will have the full message.  

4. When you have finished reading a message, you can close the window.  Choose Exit on the File menu.  This will take you back to the Outlook Express window.  If there are any e-mails in the Outlook that have not been sent, a message will appear prompting you to send the e-mail(s) at that particular time or you can send it later.

Tips

· After Outlook Express downloads your messages, you can click the Send/Recv button on the toolbar, to read messages either in a separate window or in the preview pane. 

· To view all the information about a message, such as when it was sent, click the File menu, and then click Properties. 

· As you read the items in your items in your Inbox, you can reply to, forward, or file them in other folders that you create.

· To save the message in your file system, click Save as and then select a format (mail, text or HTML) and location. 

Reply to E-mail Messages.

Purpose.

· If you have read a message, you may want to send a reply to the original sender.

· If the original message that you are replying to was also copied to a no. of other people, you may want to send a reply to all of them.

When replying to a mail message, you can choose to reply with or without the original message insertion.  The original message, sometimes referred to as the History, appears in the body of the message, and is used for reference purposes.  

Reply with the original message insertion.

1. Open the message you want to reply.

2. Click the Reply button in the Mail window.  The Reply message window appears containing the message you are replying to at the bottom.

3. Type the reply where the insertion point is.

4. When you have finished typing and editing the reply, click the Send button (if you are online) to send the message.

Note.  If you click the Send button while you are offline, the mail will be placed in the Outbox folder and will automatically be sent the moment you are online.

Reply without the original message insertion.

To remove the original message, select the text, and then press the DELETE key or set options in the Options dialog box. 

1. On the Tools menu, click Options.

2. Click the Reading tab.

3. Under When replying to a message box, click the down arrow, then select Do not include original message, then click OK.
4. Follow the procedure used to reply a message with the original message insertion.  

This time, the Reply message window will not contain the message you are replying to at the bottom.

Note.  After replying to an e-mail, the E-Mail icon will indicate a checkmark showing that the mail has been replied to.
Creating and sending an e-mail message.

Purpose.

· To communicate with another user who has an e-mail address.  This is cheaper than sending fax or using the telephone especially for long distance calls.

· It is also faster to send e-mail than to post a letter.  

E.g., to send a letter around the world using e-mail takes some few minutes as compared to the weeks ordinary mails take.

1. Start the Microsoft Outlook window.

2. On the toolbar, click the New Mail Message button. 

The message composition window is displayed.

3. In the To… and/or Cc… boxes, type the e-mail addresses of each recipient. 

· If you want to sent copies of the message to other people, type in their e-mail addresses in the Cc… box, separating the addresses with a semicolon (;).

· To add e-mail names from the Address Book, click the book icon in the New Message window next to To, Cc, and then select names.

· You can also send a Blind Carbon Copy (Bcc).  In this case, the recipients entered receive the message but their names are hidden from other recipients of the message.  To use the Bcc box, click the View menu, and then select Bcc field.
4. In the Subject box, type a message title. 

5. In the lower grid of the message composition window, type in the message that you want to send.

You can format the e-mail message using the formatting tools like, Bold, Font size, Underline, etc.

6. When you have finished typing the message, editing, and spell checking, click the Send button on the New Message toolbar. 

Notes.

· To save a draft of your message to work on later, click the File menu, then click Save. You can also click Save as to save a mail message in your file system in mail (.eml), text (.txt), or HTML (.htm) format. 

· A message that returns to the sender because it cannot reach its destination is referred to as a Bounced message.

Checking the spelling in mail messages.

Before sending a mail message, you can spell check it to correct any spelling mistakes in the mail.

Outlook Express uses the spelling checker provided with Microsoft Office 97 programs, such as Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. 

1. In the New Message window, click the Spelling button on the toolbar, (or click the Tools menu, and then choose Spelling). 

2. The Spelling dialog box appears.  The misspelt words are highlighted and shown in the dialog box.  Choose the correct word by selecting it, and then click the Change button.

If the word or phrase is correct but is not in the dictionary, click Ignore.

3. Once spell checking of the mail is complete, and a dialog box appears, click OK.

Formatting e-mail message text.

To add special emphasis or structure to message text-such as bold, color, or bulleted lists, and also to add graphics and links to Web sites in your mail messages, use Hypertext Markup Language (HTML) - the standard language for formatting text for the Internet. 

To use HTML formatting on all outgoing messages.

· When you create messages using HTML formatting, only mail programs that support HTML can read the formatting. If the recipient's mail or newsreading program does not read HTML, the message is displayed as plain text with an HTML file attached.  The recipient can view the attached file by opening it in any Web browser. 

To send the message in HTML formatting;

1. In the main window, click the Tools menu, click Options, then click the Send tab. 

2. In the Mail Sending Format or News Sending Format sections, click HTML. 

To use HTML formatting on an individual message.

In an e-mail message window, make sure HTML formatting is turned on, i.e., Click the Format menu, then choose Rich Text (HTML). A black dot appears by the command when it is selected. 

To change the font, style, and size of text.

You can change the way the text looks for all your messages or you can make changes to selected text within a message.

To change the text style for all messages.

1. On the Tools menu, click Options. 

2. Click the Compose tab, then click the Font Settings button.

To format text within individual messages.

1. Select the text you want to format.  To change the font for an entire message, click the Edit menu, then click Select All. 

2. On the Formatting toolbar, click the buttons for the options you want. 

To format a paragraph.

1. Click anywhere in the paragraph, or select the text you want to format. 

2. Use either the Formatting toolbar or the commands on the Format menu to change the text. 

To
                                        Do this


Change the indentation of a paragraph
Click the Increase Indent or Decrease Indent button on the Formatting toolbar.

Add a horizontal line

Click where you want the line to appear, and then click the Insert Horizontal line button on the Formatting toolbar.

Format text written in Rich Text (HTML) mode
Click the Format menu, point to Style, and then choose an option.


To create a numbered or bulleted list.

1. In your message, click where you want the list to start. 

2. On the Format menu, point to Style, then click either Numbered List or Bulleted List. 

3. Type the first item in the list. When you press ENTER, another list entry is started on the next line. 

To end the list, press ENTER twice. 

Inserting items in a message.

To insert a Business card in all messages.

1. On the Tools menu, click Options, then select the Compose tab. 

2. In the Business Cards section, select the Mail or News check box, and then select a business card from the drop-down list. 

Notes.

· To change information in a business card, click the Edit button. 

· To add a business card or signature to an individual message, in a message window, click the Insert menu, then click either Signature or My Business Card. 

To include a sound in a message.

1. Click anywhere in the message window. 

2. On the Format menu, point to Background, and then click Sound. 

3. Enter the name of the file you want to include and the number of times you want the file to play. 

To insert a picture in a message.

1. In the message, click where you want the image to appear. 

2. On the Insert menu, click Picture, then click Browse to find the image file. 

3. Enter Layout and Spacing information for the image file as needed. 

Notes.

· If message recipients are not able to view your inserted images, click the Tools menu, and then click Options. Click the Send tab, click HTML Settings, and then make sure that Send pictures with messages is selected.  Then resend your message. 

· To insert a background picture in your message, in the message window, click the Format menu, point to Background, then click Picture. Click the Browse button to search for the file you want to use. 

Attaching files to e-mail messages.

Purpose.

· You can attach a copy of any type of file such as a document, spreadsheet, graphic image or a presentation to your e-mail messages.

1. Click the New Message button.

2. In the Message Composition dialog box, enter the e-mail address and type in the message to be sent.

3. Click where you want the file attachment to appear, then click the Insert File button to display the Insert File dialog box.

4. Locate the folder that contains the file you want to attach, and then click the file.  

To select multiple files, hold down the CTRL as you click each of the files.

5. Click the OK button.

The attached file is displayed as an icon in the body of the message.  The icon indicates the file type and name.  e.g., Sales Results.xls
6. Click the Send button.

To open or view the attached file.

Documents that contain file attachments display a paper clip image in the view or folder next to the document file.

Once the document is open, Microsoft Outlook displays an icon representing the attachment.

Note. You must have the application in which the attachment was composed in order to open it.  The MIME (Multi-purpose Internet Mail Extension) type of file enables Internet browsers to access an Internet mail file without prompting the user to specify the program used to create the attached file.

1. In the Inbox, select the e-mail message that contains the attachment.

2. Double-click the e-mail message to open it.

3. Double-click the icon that represents the attachment.

Deleting an attachment.

1. Open the e-mail message that contains the attachment.

2. To delete the attached file, click the file icon, then press the Delete key.

Organizing E-mail messages. 

Purpose.

· You can use Outlook Express to organize your incoming messages and make it easy to send mails.

To use your online time efficiently, use Outlook Express to find messages, automatically sort incoming messages into different folders, keep messages on a mail server, or delete them entirely.

Organizing the Inbox.

You can organize the messages in your Inbox quickly by sorting them.

To quickly sort messages by Subject, Sender or the Date received, click on the respective column header.  E.g., to sort your messages in alphabetical order by sender, click on From in the column header.

To create a Mail folder.

1. On the File menu, click New, then choose Folder.

2. Enter the name of the folder in the Name box, e.g., My Own.

3. Select the Inbox folder so that the mail folder created will become a subfolder of the Inbox.

4. You can add details, such as a description of the folder in the Description box, then click OK.
To move or copy a message to another folder.

1. In the message list, select the message (s) you want to move or copy. 

2. On the Edit menu, click Move to Folder or Copy to Folder, then select the folder you want to move or copy the message to. 

To delete a mail message.

1. In the message list, select the message. 

2. On the toolbar, click the Delete button (or press the Delete key). 

Notes.

· To restore a deleted message, open the Deleted Items folder, and then drag the message back to the Inbox or other folder. 

· If you don't want messages to be saved in the Deleted Items folder when you quit Outlook Express, 

1. Click the Tools menu, then click Options. 

2. On the Maintenance tab, select the checkbox labeled Empty messages from the 'Deleted Items' folder on exit. 

· To manually empty all deleted items, 

1. Select the Deleted Items folder. 

2. On the Edit menu, click Empty Deleted Items Folder. 

Sending a Web page by e-mail.

Purpose.

· You may find some interesting and useful material on the Internet that you would like to share with friends and colleagues.

You can send Web pages by e-mail to other people even if the recipients are not connected to the Internet.

1. Access the Web page you want to send.

2. Click the File menu, point to Send, then click Page By E-mail or Link By E-mail. 

3. If necessary, choose the correct profile to use from the Profile dialog box, i.e., Outlook Express, and click OK. 

4. In the Message dialog box, enter the address of the recipient, then click the Send button.

Note. You must have an e-mail account and an e-mail program set up on your computer. 

Blocking Unwanted messages.

You can control the mail and news messages you get in Outlook Express . You can block certain people from sending you mail, you can hide conversations that don't interest you, and you can guard against being sent damaging code in mail by setting security levels. 

To block messages from a sender or domain.

You can block messages from a particular sender or domain. 

· The Domain is the name following the @ symbol in an e-mail address. 

· Domain - A group of networked computers that share information & resources.

When you block a sender or domain, no e-mail or news message from that sender or domain will arrive in your Inbox or in the news messages you read. 

E-mail from blocked senders goes directly into your Delete folder while Newsgroup messages from blocked senders are not displayed. 

1. From your e-mail Inbox or the list of messages in a newsgroup, select a message from a sender you want to block. 

2. On the Message menu, click Block Sender. 

The e-mail address of the sender will appear in the Address box. You can type a different address or domain in the Address box if you wish. 

3. Select the blocking option you want: mail, news, or both kinds of messages. 

Important.  Blocking a sender applies to standard POP mail only. It does not apply to HTTP mail (Hotmail) or IMAP messages

Differences between E-mail and General Post office mail.

1). E-mail is computerized, while Post office mail is manually operated.

2). Post office mail is slow, while E-mail is fast & has a wide area of coverage.

3). E-mail is more secure.

Advantages of E-mail.

Electronic mail has several advantages over regular mail.

(i). It is cheap & economical.  

It costs almost nothing to transmit an e-mail message over the network, i.e., there is no need for stamps, envelopes, etc.

(ii). It is secure, i.e., access to a user’s mailbox can be restricted by use of a password.

(iii). It is faster, i.e., mails can be sent instantly.  

The delivery of an e-mail message normally takes seconds or minutes, depending on the distance to the receiver.

(iv). It is efficient, i.e., a message prepared only once can be sent to several people.

(v). It is convenient.

With E-mail, you can send your messages when it is convenient for you and your recipients respond at their convenient times.

(vi). E-mail is cheaper in terms of the time invested in preparing the message.

The expectations and culture of sending & receiving e-mail are different from that of sending regular letters.  Regular business letters & inter-office memos are expected to be error-free and formatted according to certain standards.  In contrast, most e-mail users accept less well-formatted messages and slight typographical errors are overlooked. So, less time is spent perfecting the appearance of the message.

(vii). E-mail can act as a substitute for the Telephone calls, thus allowing the user to avoid telephone tag (i.e., the process of repeatedly exchanging voice mail messages because you or the other person may not be available when the other calls).

E-mail can often communicate enough of a message so that the entire “conversation” will take less time than a phone call.

E-mail is particularly effective for multinational organizations, which have people working in different time zones around the world.
Disadvantages of E-mail.

(i). The initial installation cost is higher.

(ii). Messages may be lost before they are read due to virus infections.

(iii). Messages may not be kept for future reference due to the high cost of storage, i.e., it requires regular deletion of messages from the hard disk.

Exercise.

1. How does one send an e-mail message?

2. What is the advantage of filing e-mail messages when you can leave them in the Inbox and still have them for future reference?

3. List THREE levels of importance one can set on an e-mail message.

4. Lucille has received an e-mail message that contains an attachment.  Can she use any application to open the attached file? Explain.

5. What are the advantages of e-mail over the ordinary post office mail.

6. Give THREE differences between electronic mail and the Post office mail?
Using the Address Book.

Purpose.

· The Address Book is a directory of personal details, including e-mail addresses, for the people to whom you send messages (called Contacts).

It is used to store/keep track of e-mail addresses, mailing addresses, phone numbers, and other information about your friends and also provides space for notes.

You can store such addresses in the Address Book so as to address mails more easily, i.e., each time you want to send e-mail messages, you simply select the names from the list of addresses.

This will save the time used to enter lists of e-mail addresses as well as help maintain their accuracy.  E.g., an e-mail address like Njiiri.mworia@mit.edu.uk can be difficult to remember.  In addition, one can easily make a typing error when typing the address.

The Address Book is accessible from Internet Explorer, Outlook Express and NetMeeting, thus enabling you to keep one list of addresses that are accessible by various programs.

To add a contact to the Address Book.

1. To open the Address Book, click the Address Book button.

There can be several types of address books in the Address Book dialog box including the Global Address list and Personal Address Book. 

2. In the Show names from the box, select the type of address book you want to use. 

The Global Address list is the address book that contains all e-mail addresses for users, groups, and distribution lists in your organization that you can address messages to.  The Administrator creates and maintains this address book.

The Personal Address Book is the address book used to store personal distribution lists you frequently address messages to, such as a list of your friends.

3. Click the New Entry button.

4. Specify the entry type of the contact, i.e., whether it is an Internet address or an entry for a distribution list.

5. Type in the display name for the address as well as the full e-mail address.

6. Complete the dialog box with the rest of the contact details using the other tabs, e.g., Business or Phone Numbers, then click OK.

The contact address is added to the Address Book.

To edit a contact in the Address Book.

1. Open the Address Book.

2. Select the contact that you want to edit.

3. On the File menu, click Properties.

4. Make the necessary changes to the information, then click OK.

To create a contact from a mail message.

When you receive a mail message, you can add the sender’s details (name and e-mail address) to your Address Book.

1. From the Inbox, right-click a message.

2. Select Add sender to Address Book, from the shortcut menu that appears.

To delete a contact from the Address Book.

1. Open the Address Book.

2. Select the address that you want to remove from the Address book.

3. Click the Delete button (or press the Delete key).

4. Click Yes to confirm that you want to delete the name or entry.

To create a distribution list.

If you send mails to the same group of people frequently, you can create a group address list.  Group address lists are known as Distribution lists.

When you address a message to that group, each individual in the group receives it.  

Note.  You must have a Personal Address Book set up in order to be able to create a personal distribution list.

1. Open the Address Book.

2. Click the New Entry button.

3. In the Select the entry type box, click Personal Distribution List, and then click OK.

4. In the Name box, type a name for the group, e.g. Sales Dept., then click the Add/Remove Members button.

5. To add members to the group, select a contact or name from the left hand list box, then click the Members button (or double-click on a name) to move the name to the right list box.

The contact is copied to the Personal Distribution List box.

6. Repeat step 5 until you have all the names you want in your group in the Personal Distribution List, then click OK.

The group or distribution list is usually listed in the Address Book.

To send a message using the Address Book or distribution list.

1. In the Microsoft Outlook window, click File then select the New Mail Message.

2. Click the To… button to open the Address Book. 

3. Select the contact names from the list or select the distribution list, then click on To ->.

Note. To see the full e-mail addresses, select the name of the person from the lists and click on Properties button.

4. Click OK to return to the message composition dialog box.

5. Type out the rest of the message and click on Send.

Exercise.

1. What are the advantages of using the Address Book as opposed to typing e-mail addresses each time you send e-mail?

READING MAIL MESSAGES OFFLINE.

Once you have opened the E-mail program, it is not necessary for you to be connected directly so that you can read & write your e-mail messages.  You may choose to work offline to save on costs. 

When you are offline, Outlook Express downloads mail messages to your local computer. When you connect (or choose to work online) again, messages in your Outbox are sent, messages you marked for deletion are removed, and all other actions taken offline are completed at once.

There are 2 situations where it is beneficial to use Outlook Express offline: 

(i). If your ISP charges you by the hour or if you have only one phone line.  Under these conditions, you might want to reduce time spent online. 

(ii). If you use a Laptop to read your messages while you are traveling or any other time you are not connected to the Internet.

To set up Outlook Express to reduce online time.

1. On the Tools menu, click Options. 

2. On the Connection tab, select Hang up after sending and receiving. 

If you connect to an IMAP or HTTP server, click the server name in the folder list, and then make sure that the items you want to view offline are checked. 

This procedure can be used to set up Outlook Express so that it automatically disconnects after you select Send and Receive from the Tools menu. 

You can then read and compose messages offline without incurring charges or tying up a phone line. 

Note.  To reconnect to send or receive messages, click the Tools menu, point to Send and Receive, and then select the option you want. 

To read messages while you are away from your Internet connection.

1. On the Tools menu, select Options, then click the General tab.

2. Under the field labeled If my computer is not connected at this time, select Connect only when not working offline. 

If you connect to an IMAP or http server, click the server name in the folder list, make sure

that the items you want to view offline are checked, and then click Sync Account. 

3. On the File menu, click Work Offline. 

Note.  To check the type of account you have, click the Tools menu, and then click Accounts. Select your e-mail account and then click Properties. The account type is listed on the Advanced tab. 

Viewing and posting to Newsgroups.

What are newsgroups?

A Newsgroup is a collection of messages posted by individuals to a News server (a computer that can host thousands of newsgroups).

Some newsgroups are "owned" by someone who reviews the postings, can answer questions, delete inappropriate messages, etc. 

Anyone can post messages to a newsgroup. This is because, Newsgroups do not require any kind of membership or joining fees.

To use newsgroups in Outlook Express, your Internet Service Provider must offer links to a news server. After you set up an account for the server you want in Outlook Express, you can read and post messages in any of the newsgroups stored on that news server. 

To switch between mail and news reading.

· In the Folders list, click Inbox to go to your e-mail, or click a news server name or specific newsgroup to visit newsgroups. 

To find newsgroups of interest.

1. In the Folders list, click a server name, then click the Newsgroups button. 

2. In the Display newsgroups which contain box, type the words you want to search for. 

To subscribe to a newsgroup.

Subscribing ensures that the newsgroup is included in your Folders list for easy access.

You can subscribe to a newsgroup in any of the following ways:

(a). When adding a news server, Outlook Express prompts you to subscribe to newsgroups on that server. 

(b). Click a news server name in your Folders list, and then click the Newsgroups button. Select the newsgroup that you want to subscribe to, and then click the Subscribe button.

Note: When you double-click a name in the Newsgroup list, a subscription is automatically generated. 

(c). When you click a newsgroup, its name appears in your Folders list. Right-click the name, and then click Subscribe. 

Tips.  To cancel your subscription to a newsgroup, 

1. Click the Newsgroups button, click the Subscribed tab, select the group you want, and then click the Unsubscribe button. 

-Or- 

Right-click the newsgroup in your Folders list, then click Unsubscribe. 

To view a newsgroup without subscribing to it.

To find out if a specific newsgroup is right for you, read some of the messages in it. 

1. From the Tools menu, select Newsgroups to open the Newsgroup Subscriptions dialog box. 

2. Select the news server you want in the Accounts list.  All of the newsgroups on that server appear on the All tab. 

3. Select the newsgroup you want to view, and then click Go To. 

Note.  The first time you view a newsgroup, it may take several minutes to download the messages. The next time you go to that newsgroup, it downloads faster, because Outlook Express downloads only new messages. 

To read newsgroup messages.

Go to a newsgroup and look through the message list for a message you want to read (you may need to scroll). 

· To view the message in the preview pane, click the message once. 

· To view the message in a separate window, double-click the message in the message list. 

To read and send international messages.

Outlook Express can usually display messages in the language in which they were sent. However, some messages, particularly those from newsgroups, often do not have enough information (or the information is incorrect) in the header file to display the correct language. 

To change the language encoding for a message you are reading.

· In the message window, click the View menu, point to Encoding, and then click the language encoding you want to use. 

To set the default encoding for reading messages.

1. On the Tools menu, click Options.  On the Read tab, click Fonts. 

2. Select a language at the top, and then click the Set as Default button. 

Posting messages to newsgroups.

There are several ways that you can post messages, depending on whether you are posting a new message or replying to one and how widely you want it distributed. 

1. In the Folders list, select the newsgroup you want to post a message to. 

2. On the toolbar, click the New Post button. 

Note. To send your message to multiple newsgroups on the same news server, click the icon next to Newsgroups in the New Message dialog box. In the Pick Newsgroups dialog box, hold down the CTRL key to select multiple newsgroups, and then click Add. 

3. Type the Subject of your message. Outlook Express cannot post a message that does not contain a subject. 

4. Compose your message, and then click the Send button. 

To reply to a newsgroup message.

1. In the message list, click the message you want to reply to. 

2. To reply to the author of the message by e-mail, click the Reply button on the toolbar. 

To reply to the whole newsgroup, click the Reply Group button on the toolbar. 

3. Type your message, and then click Send. 

Note.  To view information about a newsgroup message, such as when it was sent, select the message, click the File menu, and then click Properties. 

To prevent newsgroup messages from automatically downloading.

On the Tools menu, click Options. 

On the Read tab, clear the following check box: Automatically download messages when viewing in the Preview Pane. 

To view newsgroups efficiently.

View only unread news messages in a newsgroup.

1. Open the newsgroup, click the View menu, point to Current View, and then click Hide Read Messages. 

View the replies to a particular message in a newsgroup.

1. Click the plus sign ( + ) next to the message. The replies to that message appear below it. A message with its replies is called a "conversation." 

To watch a conversation.

In both mail and news, you can watch a conversation that is of particular interest you. A conversation is an original message and all its replies. 

1. In your Inbox or newsgroup message list, select the conversation you wish to watch.

2. On the Message menu, click Watch Conversation. 

If your message list's Watch/Ignore column is turned on, the watch icon will appear next to all the messages of a watched conversation.

READING NEWSGROUP MESSAGES OFFLINE.

Offline newsreading enables you to read newsgroup messages without being connected to the Internet, saving connection costs. 

To do this,  you must subscribe to the newsgroup whose messages you want to read offline, mark it to specify whether you want to see headers or whole messages, and then transfer them to your computer (synchronize). Once this is done, you can log off from the Internet and then read the messages at your leisure. 

Reading message headers only, gives you the subject, author, and size of the message. 

To set up newsgroups for offline news reading.

For newsgroups you subscribe to, you can set up Outlook Express to make messages or headers available offline by synchronizing. This enables you to read them at your leisure when you are not connected to the Internet. 

1. From the Folders list, select a news server. 

2. In the main window, select one or more newsgroups you subscribe to whose messages you want to read offline. (To select multiple newsgroups, hold down the CTRL key while you click the newsgroups.) 

3. Click the Settings button, and then click to mark what you want transferred from the server to your computer during synchronization: 

· All Messages, 

· New Messages Only (new to the server since you last synchronized), or 

· Headers Only (subject, author, date, and size of message). 

4. Click the Sync Account button. 

Exercise.

1. (a). When can you work offline?

(b). Why should you work offline?

Methods of Accessing Computer and Locating Files.

(1). Gopher:

This is a client/server tool that enables the user to locate almost all textual information stored on Internet servers through a series of easy-to-use or understand, hierarchical menus that provide point-and-click interfaces.

The Internet has thousands of Gopher server sites throughout the world.  Each gopher site contains its own system of menus listing related topics, local files, and other relevant gopher sites.

To search for a specific topic or select a related item from a menu, activate the gopher software.  The server will automatically transfer you to the appropriate file on that server or the selected server wherever it is located in the world.  Once on the distant server, you are presented with more menus of files and Internet addresses of other gopher site servers that might interest you.  You can then move from site to site locating information that you want anywhere in the world.  After finding the information or files you want, you are free to browse, read them online, or download them onto your own computer for searching for text that appears in gopher menus.

(2). Archie:

This is a tool for locating data on the Internet that performs keyword searches of an actual database of documents, software, and data files available for downloading from servers around the world.

An individual Archie database can list only a small percentage of the files in the world.  However, clicking on the relevant listing from one Archie server will bring you to another computer system where relevant files are stored.  While on the other computer, the Archie server may provide other relevant references, allowing you to continue your search for related files, moving from database to database, library to library, until you locate what you need.

Archie database searching uses the subject keywords entered such as “telecommuting” or “inflation” to display a list of sites that contain files on that topic.  Once you find the files you want, you may use a file transfer program to download them.

(3). WAIS (Wide Area Information Servers):

This is a tool for locating data on the Internet that require the name of the databases to be searched based on keywords.  

Once you specify specific database names and key identifying words, WAIS searches for the keywords in all the files in those databases.  When the search is completed, you are given a menu listing all the files that contain your keywords.

(4). The Word Video Web:

The Web is another information retrieval tool similar to gophers, Archie, and WAIS.  It is widely used for commercial purposes on the Net due to the fact that, it is attractive, easy to use, and helpful in publishing or providing information to anyone interested.

(5). Home Page:

Anyone willing to offer information through the Web must first establish a Home Page (a WWW text & graphical display that welcomes the user and explains the organization that has established the page).  The Home page will lead the user to other pages.

All the pages of an organization are known as a Website.

Home pages combine text, hypermedia, graphics and sound, unlike the other methods of locating information on the Net, which are text-based.  This means that, home pages can handle all types of communication, while making it easy to link resources that are far apart.  

Graphics allow organizations to communicate more effectively, making their own material more appealing to the eye, more informative, and easy to understand.

Hypermedia provides a point-and-click connection to related information within the same document, between documents on the same computer, or to documents located on another computer anywhere in the world (as long as the computer is connected to the Net, and the hypermedia connection has been programmed in).

Sound allows some of the Web displays to talk or play music.  

Note.  The specific hypermedia technology used in the Web is known as Hyperlinks.

Within any web document, there are certain words or graphics that are highlighted (usually appear bold, in a different colour, underlined, or a combination of these).  The highlighted objects have hyperlinks embedded within them that contain the path to another location within the same document, a document on the same computer, or a document on another computer.  

Hyperlinks allow the user to move with ease within complex documents or across the network.  If the reader of the document wants more information on the highlighted word, he/she double-clicks the word, and quickly that other information will be displayed, even if it is stored in another part of the world.

Advantages of Hyperlinks.

(i). It is easy to use.

(ii). The user is free to jump from place to place following his/her own logic and interest, and does not have to move according to a static, pre-programmed, linear sequence.

The user moves around almost as easily as a book reader might follow keywords and jump around an encyclopedia. 

To navigate the Web requires a graphics Computer to link to the Internet.  The user must also have a special software tool to navigate the Web known as Web Browser.

BENEFITS FROM THE USE OF THE INTERNET.

1). Reduces the Cost of Communication.

Before the Internet, organizations had to build their own Wide Area Networks or subscribe to Value-Added Network (VAN) service.  

Many organizations find the Internet more cost-effective than building their own networks or paying VAN subscription fees.  Organizations use the Internet to fulfill a wide range of communication needs.  This lowers other communication costs, including their network management expenses, telephone and Fax costs.

Reduced communication costs are beneficial particularly to small businesses because it sometimes enables them to compete with larger companies in the markets that would otherwise be closed to them.

2). Enhances Communication & Co-ordination.
Global companies use the Internet as an important instrument for coordinating their activities.  Such companies have set up internal Web sites to keep employees informed about company developments.  Through the Web, employees are able to see a company Calendar, the employee Policy manual, product Brochures, interactive Training tools, and even stock quotes.

The Internet has made it easier and less expensive for companies to co-ordinate small staffs when opening new markets or working in isolated places, because they do not have to build their own networks.
3). Accelerates the Distribution of Knowledge.
To speed product development and also to react to an emerging problem, information gathering must be quick and easy.  

The Internet is very useful in the modern society, which is increasingly dependent on knowledge.  Organizations are using E-mail and the availability of databases all over the world to gain access to information in such areas as Business, Science, Law, and Government.  The Internet can quickly link a computer user sitting at a computer screen to mountains of data (including Graphics) all over the world, which would otherwise be too expensive and too difficult to get.

4). Improves Customer service and satisfaction.
Organizations can also use the Internet to communicate efficiently to make product information, ordering and technical support easier and immediately available.  

A company can establish a Website on the Internet in order to distribute useful product information to its customers and product users.  It can also use the Internet to give engineering support to its customers without the involvement of engineering staff.

5). Facilitates Sales and Marketing.
The Internet provides opportunities for firms to market and sell their products in a way that does not offend others.  This is because, the Internet is a passive instrument, i.e., it requires potential customers to seek out offerings by companies rather than having those companies actively reach out to potential customers, as is the case in most marketing and advertising.

Retailers update their Web page offerings frequently as required.  Suppliers can also update technical materials used by customers easily.  Therefore, the Internet assist buyers and sellers make contacts.  

Firms use their Websites to distribute more marketing information.  A firm can include its Web address in product advertisements and design their site for visitors to browse information on pricing, press releases on new products, technical manuals and sales brochures.

PROBLEMS FACING THE INTERNET.

1). Lack of Security.

Lack of security is one of the reasons why the Internet, while being widely used to facilitate transactions, is still in limited use to carry out transactions.

When large amounts of data are stored in electronic form, they are exposed to more kinds of threats/dangers than when they exist in manual form.

Through data communication networks, information systems in different locations on the Internet are interconnected.  The potential for unauthorized access, abuse or fraud is not limited to a single location but can occur at any access point in the Internet.  

Internet Hackers have found ways of stealing passwords as they pass through one site and use them to break into computer system at other sites all over the world.

The hackers can get access to company’s strategic business plans, profit reports, product development information, pricing data, marketing plans, sales contracts, and scientific research data.  Such information is too sensitive and companies are unwilling to have it accessed by unauthorized people.
2). Technology Problems.

(a). The Internet lacks standards for accessing the net and sending e-mails.  A no. of incompatible ways for accessing the net exist, allowing specific users to perform certain functions but not others.  

(b). The lack of standards also affects the ability of organizations to establish a stable link to the Internet.  As the traffic on the Internet becomes more complex, it can bring problems if it does not have good technical support.

(c). Many people and organizations are sending so much data through the Net, much of it in graphics form, such that telecommunication links are already overloaded.  Frequent users are unable to access the net, while those who use the graphics-based Web regularly find connecting to the intended Server very slow or even almost impossible during busy times.

(d). Moreover, the growing need for bandwidth due to graphics will only expand as the transmission of sound and full-motion video expands.  All this is raising the cost of using the Net.  Some firms are already discovering that they need more expensive telecommunications connections, Workstations or higher speed computers with improved graphics capability, and even Information system specialists with skills related specifically to the Internet.

(e). Individuals and organizations in less developed countries with poor Telephone lines, limited hardware and software capacity or Government controls on communication will not be able to take full advantage of Internet resources.

(f). Due to the fact that there is no a comprehensive method of locating and keeping track of pages in the World Wide Web (www), Internet users often spend a lot of time in futile (unsuccessful) searches, despite the many new tools and planned indexes to the Web.  There is no good technology enough to filter/sort out irrelevant information while allowing people to access the specific information they need. 

3). Legal Issues.

Until a greater clarity on several legal issues is obtained, doing business on the Internet will become unreliable.

Laws governing E-commerce are mostly non-existing or are just being written.  

There are several open questions that still exist such as, the legality of E-mail contracts, the role of electronic signatures, and the application of copyright laws to electronically copied documents. 

4). Anti-Commercial culture.

Initially, the Internet was a scientific and academic tool.  As it grew, a strong anti-commercial culture grew with it.  

Internet users have shown themselves unwilling to accept the Internet mail.  Many commercial users also fear that allowing commercial organizations to add very many unasked for marketing messages will make the Internet E-mail difficult to manage.  

Thus, while businesses remain free to use the Internet for E-mail, research, and other forms of information exchange, they will have to learn new ways to do their marketing on the Internet; ways that do not offend the other users.

Exercise I.

1. State the various methods of accessing computer and locating files.

2. Describe the main benefits from the use of the Internet.

3. Give a brief view of the main problems of the Internet.

Exercise II.

1. Briefly describe four advantages of using Internet to disseminate information compared to other conventional methods.






(8 marks).

2. One of the problems of using Internet for business is insecurity.  What are some of the other problems and what controls should be put in place in order to solve the problems?. (4 marks).

3. Your manager wishes to be connected to the Internet.  He already has a powerful Personal Computer (PC), a Printer and access to a Telephone line.  However, he understands that he will need a Modem.

Required:

(a). State why a Modem is required to connect him to the Internet.

(2 marks).

(b). Suggest any four application areas in which you would expect a Supermarket retail manager to use the Internet.






(4 marks).

DATA SECURITY AND CONTROL

Introduction
Data & Information must be protected against unauthorized access, disclosure, modification or damage.  This is because; it is a scarce & valuable resource for any business organization or government.  It is mostly used in transactions, it can be shared, and has high value attached to it.

Data & Information security:

Data security is the protection of data & information from accidental or intentional disclosure to unauthorized persons.

Data & Information privacy:

Private data or information is that which belongs to an individual & must not be accessed by or disclosed to any other person, without direct permission from the owner.

Confidential data or information – this is data or information held by a government or organization about people.  This data/information may be seen by authorized persons without the knowledge of the owner.  However, it should not be used for commercial gain or any other unofficial purpose without the owner being informed.

Review Questions
1. Differentiate between private and confidential data.

2. Why is information called a resource?

3. (a)
Explain the term ‘Information security’.

(b)
Recently, data and information security has become very important.  Explain.

SECURITY THREATS TO DATA & INFORMATION

1). COMPUTER VIRUSES

· A computer virus is a destructive program that attaches itself to other files when the files are opened for use, and installs itself on the computer, without the knowledge of the user.

·  A computer virus is a program designed specifically to damage other programs or interfere with the proper functioning of the computer system.

A virus is a computer code usually designed to carry out 2 tasks:

(a) To copy itself from one computer system to another.

(b) To locate itself within a computer system enabling it to amend/destroy program & data files, by interfering with the normal processes of the operating system.

Types of computer viruses.

1. Boot sector viruses – they destroy the booting information on storage devices.

2. File viruses – they attach themselves to files either erasing or modifying them.

3. Hoax viruses – they come as e-mails with an attractive subject & activate themselves when the e-mail is opened.

4. Trojans – they appear to perform necessary functions, but perform other undesirable activities in the background without the knowledge of the user.

5. Worms – viruses that stick in the computer memory.

6. Backdoors – may be a Trojan or Worm that allows hidden access to a computer system.

Types of destructions/damages caused by a virus attack.

· Delete or modify data, information & files on storage devices (disks) or memory during normal program execution, e.g., may attack the format of a disk making any program or data on it impossible to recover.

· Systematically destroy all the data in the computer memory.

· Might lock the keyboard.

· Can change keystroke values or data from other I/O devices, e.g., change the effect of SHIFT key.

· Delete characters displayed on a visual display.

· Uses up computer memory/space, hence slowing down its performance or causing the system to crash.

· Changes colour of the display.

· Cause boot failure.

Sources of viruses.

a) Contact with contaminated systems:

If a diskette is used on a virus infected computer, it could become contaminated.  If the same diskette is used on another computer, then the virus will spread.

b) Use of pirated software:

Pirated software may be contaminated by a virus code or it may have been amended to perform some destructive functions which may affect your computer.

c) Infected proprietary software:

A virus could be introduced when the software is being developed in laboratories, and then copied onto diskettes containing the finished software product.

d) Fake games:

Some virus programs behave like games software.  Since many people like playing games on computers, the virus can spread very fast.

e) Freeware and Shareware:

Both freeware & shareware programs are commonly available in Bulletin board systems.

Such programs should first be used in controlled environment until it is clear that the program does not contain either a virus or a destructive code.

f) Updates of software distributed via networks:

Viruses programs can be spread through software distributed via networks.

Symptoms of viruses in a computer system.

The following symptoms indicate the presence of a virus in your computer:

· Boot failure.

· Files & programs disappearing mysteriously.

· Unfamiliar graphics or messages appearing on the screen, e.g., the virus might flash a harmless message such as “Merry Christmas” on the computer terminal.

· Slow booting.

· Gradual filing of the free space on the hard disk.

· Corruption of files and programs.

· Programs taking longer than usual to load.

· Disk access time seeming too long for simple tasks.

· Unusual error messages occurring more frequently.

· Frequent read/write errors.

· Disk access lights turning on for non-referenced devices.

· Computer hags anytime when running a program.

· Less memory available than usual, e.g., Base memory may read less than 640KB.

· Size of executable files changing for no obvious reason.

Control measures against viruses.

i). Install up-to-date (or the latest) antivirus software on the computers.

ii). Restrict the movement of foreign storage media, e.g., diskettes in the computer room.

If they have to be used, they must be scanned for viruses.

iii). Avoid opening mail attachments before scanning them for viruses.

iv). Write-protect disks after using them.

v). Disable floppy disk drives, if there is no need to use disks in the course of normal operation.

vi). Backup all software & data files at regular intervals.

vii). Do not boot your computer from disks which you are not sure are free from viruses.

viii). Avoid pirated software.  If possible, use the software from the major software houses.

ix). Programs downloaded from Bulletin Boards & those obtained from computer clubs should be carefully evaluated & examined for any destructive code.

2). UNAUTHORIZED ACCESS

Data & information is always under constant threat from people who may want to access it without permission.  Such persons will usually have a bad intention, either to commit fraud, steal the information & destroy or corrupt the data.

Unauthorized access may take the following forms:

a). Eavesdropping:

This is tapping into communication channels to get information, e.g., Hackers mainly use eavesdropping to obtain credit card numbers.

b). Surveillance (monitoring):

This is where a person may monitor all computer activities done by another person or people.

The information gathered may be used for different purposes, e.g., for spreading propaganda or sabotage.

c). Industrial espionage:

Industrial espionage involves spying on a competitor so as to get or steal information that can be used to finish the competitor or for commercial gain.

The main aim of espionage is to get ideas on how to counter by developing similar approach or sabotage.

d). An employee who is not supposed to see some sensitive data gets it, either by mistake or design.

e). Strangers who may stray into the computer room when nobody is using the computers.

f). Forced entry into the computer room through weak access points.

g). Network access in case the computers are networked & connected to the external world.

Control measures against unauthorized access.

i). Enforce data & information access control policies on all employees to control access to data.

ii). Keep the computer room closed when nobody is using it.

iii). Reinforce weak access points, e.g., doors & windows with metallic grills & burglar alarms.

iv). Use file passwords to prevent any person from getting access to the electronic files.

v). Enforce network security measures, e.g., use of firewalls.

vi). Encrypt the data & information during transmission.

vii). Perform frequent Audit trails to identify threats to data & information.

3). COMPUTER ERRORS & ACCIDENTAL ACCESS

Errors and accidental access to data & information may be as a result of:

· Mistakes made by people, e.g., one may print sensitive reports & unsuspectingly give them to unauthorized persons.

· People experimenting with features they are not familiar with.  E.g., a person may innocently download a file without knowing that it is self-installing or it may be dangerous to the system.

Control measures against computer errors & accidents.

i). Restrict file access to the end-users and technical staff in the organization, i.e., deny access of certain files & computers to certain groups of end-users.

This is because; accidental access mistakes occur if the end-users have too much privilege that allows them to access or change sensitive files on the computer.

ii). Set up a comprehensive error-recovery strategy in the organization.

4). THEFT

The threat of theft of data & information, hardware & software is real.  Some information is so valuable such that business competitors or some governments can decide to pay somebody a fortune so as to steal the information for them to use.

Control measures against theft of information, hardware, & software.

i). Create backups & store them in locations away from the main computing centre.

ii). Reinforce weak access points, e.g., the windows, doors, & roofing with metallic grills and strong padlocks.

iii). Put burglar proofs in the computer room.

iv). Employ guards to keep watch over data & information centres and backups.

Review Questions
1. Explain any three threats to data and information.

2. Give two control measures one would take to avoid unauthorized access to data and information.

3. Explain the meaning of ‘industrial espionage’.

4. (a)
Define a computer virus.

(b)
Give and explain two types of computer viruses.

(c)
List three types of risks that computer viruses pose.

(d)
List and explain five sources of computer viruses.

(e)
Outline four symptoms of computer viruses.

(f)
Explain the measures one would take to protect computers from virus attacks

5. How can one control the threat of user’s errors to data and information?

COMPUTER CRIMES

· A computer crime is a deliberate theft or criminal destruction of computerized data.

· The use of computer hardware, software, or data for illegal activities, e.g., stealing, forgery, defrauding, etc.

· Committing of illegal acts using a computer or against a computer system.

Types of computer crimes.

The following are the major types of computer crimes:

1. Trespass.

2. Hacking.

3. Tapping.

4. Cracking.

5. Piracy.

6. Fraud (Theft of money)

7. Sabotage.

8. Alteration of data.

9. Theft of computer time / Theft of service.

10. Theft of data, information or programs.

11. Damage of software.

Trespass.

· Trespass refers to the illegal physical entry to restricted places where computer hardware, software & backed up data is kept.

· It can also refer to the act of accessing information illegally on a local or remote computer over a network.

Trespass is not allowed and should be discouraged.

Hacking.

Hacking is an attempt to invade the privacy of a system, either by tapping messages being transmitted along a public telephone line, or through breaking security codes & passwords to gain unauthorized entry to the system data and information files in a computer.

Reasons for hacking.

· To copy or corrupt the information.

· As a hobby to test their expertise.  Some people like the challenge & they feel great after successful hacking.

· Some do it for computer & software producing companies that want to secure their systems by reducing weaknesses discovered after professional hacking.

Hacking is done by skilled programmers referred to as Hackers.  Hacker is a person who gains unauthorised access to a computer network for profit, criminal mischief, or personal gain.

Such people are able to break through passwords or find weak access points in software.  They are involved in propagating computer viruses.

Tapping.

Tapping involves listening to a transmission line to gain a copy of the message being transmitted.

Tapping may take place through the following ways:

a) A person may send an intelligent program to a host computer that sends him/her information from the computer.

b) Spying on a networked computer using special programs that are able to intercept messages being sent & received by the unsuspecting computer.

Cracking.

Cracking is the use of guesswork by a person trying to look for a weakness in the security codes of a software in order to get access to data & information.

These weak access points can only be sealed using sealed using special corrective programs called Patches, which are prepared by the manufacturing company.

A program patch is a software update that when incorporated in the current software makes it better.

NB: Cracking is usually done by people who have some idea of passwords or user names of the authorized staff.

Piracy.

Software, information & data are protected by copyright laws. Piracy means making illegal copies of copyrighted software, data, or information either for personal use or for re-sale.
Ways of reducing piracy:

i) Enact & enforce copyright laws that protect the owners of data & information against piracy.

ii) Make software cheap enough to increase affordability.

iii) Use licenses and certificates of authenticity to identify originals.

iv) Set installation passwords that prevent illegal installation of software.

Fraud.

Fraud is the use of computers to conceal information or cheat other people with the intention of gaining money or information.

Fraud may take the following forms:

a). Input manipulation:

Data input clerks can manipulate input transactions, e.g., they can create dummy (ghost) employees on the Salary file or a ghost supplier on the Purchases file.

b). Production & use of fake documents:

E.g., a person created an intelligent program in the Tax department that could credit his account with cents from all the tax payers.  He ended up becoming very rich before he was discovered.

Fraudsters can either be employees in the company or outsiders who are smart enough to defraud unsuspecting people.

Reasons that may lead to computer fraud.

· For economic gain (i.e., to gain money or information).

· To gain respect (self-worth)

Security measures to prevent fraud:

i) Careful recruitment of staff.

ii) Set up a clear & firm management policy on crimes & frauds.

iii) Restrict access to computer room or terminal.

iv) Use transaction & fill logs to monitor access to sensitive areas of the system.

v) Monitor & investigate error logs and reports on regular basis.

vi) Carry out risk analysis to examine the exposure of the organization to possible fraud.

Sabotage
Sabotage is the illegal or malicious destruction of the system, data or information by employees or other people with grudges with the aim of crippling service delivery or causing great loss to an organization.

Sabotage is usually carried out by discontented employees or those sent by competitors to cause harm to the organization.

The following are some acts of saboteurs which can result in great damage to the computer centres:

· Using Magnets to mix up (mess up) codes on tapes.

· Planting of bombs.

· Cutting of communication lines.

Alteration.

Alteration is the illegal changing of stored data & information without permission with the aim of gaining or misinforming the authorized users.

Alteration is usually done by those people who wish to hide the truth.  It makes the data irrelevant and unreliable.

Alteration may take place through the following ways:

a). Program alteration:

This is done by people with excellent programming skills.  They do this out of malice or they may liaise with others for selfish gains. 

b). Alteration of data in a database:

This is normally done by authorized database users, e.g., one can adjust prices on Invoices, increase prices on selling products, etc, and then pocket the surplus amounts.

Security measures to prevent alteration:

i) Do not give data editing capabilities to anybody without vetting.

ii) The person altering the data may be forced to sign in order for the system to accept altering the information.

Theft of computer time.

Employees may use the computers of an organization to do their own work, e.g., they may produce publications for selling using the computers of the company.

Theft of data (i.e., commercial espionage).

Employees steal sensitive information or copy packages and sell them to outsiders or competitors for profit.

This may lead to a leakage of important information, e.g., information on marketing strategies used by the organization, research information, or medical reports.

Review Questions
1. (a)
Define the term ‘Computer crime’.

(b)
State and explain various types of computer crimes.

2. Differentiate between Hacking and Cracking with reference to computer crimes.

3. What is a program patch?  Why are patches important?

4. Give two reasons that may lead to computer fraud.

5. How can piracy be prevented in regard to data and information.

6. What is data alteration?  Explain its effects on data.

7. Explain the meaning of Tapping while dealing with computer crimes.

DETECTION & PROTECTION AGAINST COMPUTER CRIMES

The following measures can be taken to detect & prevent computer crimes, and also seal security loopholes.

Audit trails

This is a careful study of an information system by experts in order to establish (or, find out) all the weaknesses in the system that could lead to security threats or act as weak access points for criminals.

An audit of the information system may seek to answer the following questions: -

1. Is the information system meeting all the design objectives as originally intended?

2. Have all the security measures been put in place to reduce the risk of computer crimes?

3. Are the computers secured in physically restricted areas?

4. Is there backup for data & information of the system that can ensure continuity of services even when something serious happens to the current system?

5. What real risks face the system at present or in future?

Data encryption

Data being transmitted over a network faces the dangers of being tapped, listened to, or copied to unauthorized destinations.

To protect such data, it is mixed up into a form that only the sender & the receiver can be able to understand by reconstructing the original message from the mix.  This is called Data encryption.

The flow diagram below shows how a message can be encrypted and decrypted to enhance security.
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The message to be encrypted is called the Plain text document.  After encryption using a particular order (or, algorithm) called encryption key, it is sent as Cyphertext on the network.

After the recipient receives the message, he/she decrypts it using a reverse algorithm to the one used during encryption called decryption key to get the original plain text document.

This means that, without the decryption key, it is not possible to reconstruct the original message.

Log files

These are special system files that keep a record (log) of events on the use of the computers and resources of the information system.

Each user is usually assigned a username & password or account.  The information system administrator can therefore easily track who accessed the system, when and what they did on the system.  This information can help monitor & track people who are likely to violate system security policies.

Firewalls

A Firewall is a device or software system that filters the data & information exchanged between different networks by enforcing the access control policy of the host network.

A firewall monitors & controls access to or from protected networks.  People (remote users) who do not have permission cannot access the network, and those within cannot access sites outside the network restricted by firewalls.

LAWS GOVERNING PROTECTION OF INFORMATION

Laws have been developed that govern the handling of data & information in order to ensure that there is ‘right of privacy’ for all people.

The following rules must be observed in order to keep within the law when working with data and information.

1. Data & information should be kept secure against loss or exposure.

2. Data & information should not be kept longer than necessary.

3. Data & information should be accurate and up-to-date.

4. Data & information should be collected, used & kept for specified lawful purposes (i.e., it should not be used for unlawful gain).

5. The owner of the data has a right to know what data is held by the person or organization having it.

6. Data should not be transferred to other countries without the owner’s permission.

7. Do not collect irrelevant and overly too much information for a purpose.

Review Questions
1. What do the following control measures against computer crimes involve?

(i) Audit trail.

(ii) Data encryption.

(iii) Log files.

(iv) Firewalls.

2. Give four rules that must be observed to keep within the law when working with data and information.

COMPUTER SECURITY

What is Computer security?

· Safeguarding the computer & the related equipments from the risk of damage or fraud.

· Protection of data & information against accidental or deliberate threats which might cause unauthorised modification, disclosure, or destruction.

A computer system can only be claimed to be secure if precautions are taken to safeguard it against damage or threats such as accidents, errors & omissions.

The security measures to be undertaken by the organization should be able to protect:

i) Computer hardware against damage.

ii) Data, information & programs against accidental alteration or deletion.

iii) Data & information against hazards.

iv) The computer against unauthorised use.

v) Data, information & programs against piracy or unauthorised copying.

vi) Data & programs used by the computer system against illegal or unauthorised modification.

vii) Storage media, e.g., diskettes, tapes, etc against accidental destruction.

viii) Policies of the organization.

ix) Buildings.

x) Accidental interruption of power supply or communication lines.

xi) Disclosure of confidential data or information.

xii) Ensure that both hardware & software have longer life span.

Environmental threats to computers & Information systems.

1). Fire.

Fire destroys data, information, software & hardware.

Security measures against fire:

· Use fire-proof cabinets & lockable metal boxes for floppy disks.

· Use of backups.

· Install fire fighting equipments, e.g., fire extinguishers.

· Have some detectors.

· Training of fire-fighting officers.

· Observe safety procedures, e.g., avoid smoking in the computer rooms.

· Have well placed exit signs.

· Contingency plans.

2). Water, floods & moisture.

This causes rusting of the metallic components of the computer.

Security measures against water, floods & moisture:

· Set up computer rooms on higher grounds to avoid floods & humidity.

· Avoid installing computer components in the basement.

· There should be adequate drainage system.

· Use water-proof ceilings & floors.

3). Lightening, electricity & electrical storms.

This causes power failure that can cause damage to data, which has not been transferred to permanent storage devices.

Security measures:

· Install facilities to control power fluctuations, e.g., use of Uninterrupted power source (UPS)

· Use power stabilizers.

· Have standby power generators/sources.

· Have lightening arresters in the building.

4). Excessive Heat or Temperature.

Excessive heat or temperature from the computer itself or from the surrounding environment can destroy computer storage media or devices.

Security measures:

· There should be efficient ventilation system.

· Use a cooling system in the computer rooms, e.g., cooling fans & air conditioners.

5). Computer virus attack.

A virus is a rogue software program that spreads rampantly through computer systems, destroying data or causing the system to break down.

Security measures against computer virus:

· Make backup copies of software, and store the copies off-site.

· Restrict access to programs & data on a ‘need-to-use’ basis.

· Check all programs regularly for change of size, as this could be a sign of virus infiltration.

· Be careful with ‘Shareware’ and ‘Freeware’ programs, as they are the major entry points for viruses.

· Make sure all purchased software is in its original sealed-disk containers.

6). Smoke and Dust.

Dust and Smoke particles settle on storage devices and may scratch them during Read/write operation.

Security measures:

· Have dust mats or carpets to prevent entry of dust.

· Fit the computer room with special Curtains to reduce entry of dust particles.

· Cover the devices with Dust covers when cleaning the room.

· Remove shoes before entering the room to prevent dust. 

7). Terrorist attack.

This includes activities such as:

· Political terrorists,

· Criminal type of activities,

· Individuals with grudges, or

· People intending to cause general destruction.

Security measures:

· Hiring of security guards to control physical access to the building housing the computer room.

· Activities that can cause terrorism should be avoided, e.g., exploitation of workers.

· Have double door & monitoring devices.

· Use of policies.

· System auditing / use of log files.

· Use of passwords.

· Punitive measures.

· Encryption of data.

· Use of firewalls.

· Consult & co-operate with the Police and Fire authorities on potential risks.

8). People.

People threats include:

· Carelessness.

· Clumsiness.

· Accidental deletion of data, information or programs.

· Vandalism, i.e., theft or destruction of data, information or programs & hardware.

· Piracy of copyrighted data & software.

Security measures against Carelessness & Clumsiness:

· Better selection of personnel.

· Have a good office layout.

· Improve employee training and education.

· Limit access to data and computers.

· Regular backups.

· Use of Undelete & Unformat utilities.

Security measures against Vandalism:

· Should have a sensitive attitude to office behaviour.

· Tighten security measures, e.g., install alarm systems, burglar-proof doors/windows, & roofs).

· Limit access to sensitive company information.

· Use Keyboard lock on terminals used by authorised users.

· Use of disk locks.

· Punitive measures.

9). Earthquakes.

Review Questions
1. (a)
What is Computer security?

(b)
Mention various threats to computer security.

2. Discuss the environmental problems affecting the operation of computers.

CAUSES OF DATA LOSS IN COMPUTERS

1. Power failure:
Momentary interruptions or fluctuations of electrical power may cause:

· Crashing of computers.

· Loss of data or information that had not been saved before the power disruption.

· Damage to computer’s secondary storage media.  This may result to loss of data & Application software stored on the media.

The main cause of power disruptions are:

· Amplitude fluctuations,

· Power line noise,

· Low voltage sages,

· High voltage surges,

· Voltage outages,

· Voltage spikes,

· Waveform distortions,

· Power frequency variations.

Precautions against data loss due to Power failure:

a) Regular saving of documents.

Frequent saving of documents ensures that minimum data is lost in case of any power failure.

Some application packages have an AutoSave feature, which should be activated to automatically save work after a specified time interval.

b) Use of Uninterruptible Power Supply (UPS).

To eliminate any power quality defects or fluctuation, use power correction equipment such as a Stabilizer or Uninterruptible Power Supply (UPS).  These equipments ensure a steady flow of input power to the computer system. 

2. Computer viruses:
A computer virus destroys all the data files & programs in the computer memory by interfering with the normal processes of the operating system.

Precautions against computer viruses:

a) Anti-virus software.

Use Antivirus software to detect & remove known viruses from infected files.

Some of the commonly used Antivirus software are: Dr. Solomon’s Toolkit, Norton Antivirus, AVG Antivirus, PC-Cillin, etc

NB:  The best way to prevent virus is to have a memory-resident antivirus software, which will detect the virus before it can affect the system.  This can be achieved by installing a GUARD program in the RAM every time the computer boots up.  Once in the RAM, the antivirus software will automatically check diskettes inserted in the drives & warn the user immediately if a disk is found to have a virus.

· For an antivirus to be able to detect a virus, it must know its signature.  Since virus writers keep writing new viruses with new signatures all the time, it is recommended that you update your antivirus product regularly so as to include the latest virus signatures in the industry.

· The Antivirus software installed in your computer should be enabled/activated at all times.

· You should also perform virus scans of your disks on a regular basis.

· Evaluate the security procedures to ensure that the risk of future virus attack is minimized.

Review Questions
1. Describe two ways of preventing data loss due to power outage.

2. (a)
What is a Computer virus?

(b)
What are Anti-viruses?  Explain how they detect and remove viruses.

3. Accidental erasure:
Commands such as DELETE & FORMAT can be dangerous to the computer if used wrongly.

Both commands wipe out the information stored on the specified secondary storage media, e.g., formatting the Hard disk (drive C:) will destroy all the software on that system.

Precautions against Accidental erasure:

a) Use of Undelete utilities.

Use the Undelete facilities in case you accidentally delete your files.

There are two Undelete facilities depending on the operating system you are using.

· MS-DOS 6.0 Undelete facility:

To undelete at the DOS prompt, change to the drive & directory whose files were deleted, then type, e.g., 




C:\>UNDELETE <directory that contain the deleted file>

A list of all deleted files will be displayed with the first letter missing.  Type in the first letter and the file will be recovered.

· Norton utilities & PC Tools:
Norton utilities & PC Tools also have an undelete facility, which is similar to the DOS Undelete facility.

· Windows Recycle Bin:

The Recycle Bin temporarily stores all deleted files & can be used to recover your files.

1. Double-click the Recycle Bin on the desktop.

2. Click on the files you want to undelete.

3. Click on File, choose Restore.

The Recycle Bin will restore all selected files to their original folders and disks.

NB:  If you delete a file accidentally, don’t copy any files or install any applications to the disk that contains the deleted file.  If you write anything to the disk, you might destroy parts of the deleted file, making it unrecoverable.

b) Use of Unformat utilities.

MS-DOS 6.0 has an Unformat facility which can be used to recover information stored on disks that have been accidentally formatted.

c) Use of Backups.

All data must be backed up periodically either on diskettes, tapes or CDs so that in case of any accidental loss, the backed up copy can be used to recover the data.

For small files, use the Copy command to make a copy of the data on a diskette.  For larger amounts of data, use the Backup command to copy the data to several diskettes or to a tape drive.

Review Questions
1. Name two commands that can erase the information from a disk.

2. Define ‘Data backup’ and state its importance.

4. Crashing of hard disks:
When a hard disk crashes, the data or information on the disk cannot be accessed.  The effect is the same as formatting the hard disk.

Crashing of a hard disk can occur due to the following reasons:

i) Mishandling of the computer system, e.g., 

· Moving the system unit while the computer is on.

· Accumulation of dust.

ii) Computer virus attack.

iii) Physical damage to the System unit caused by dropping or banging when being moved.

Precautions against crashing of Hard disks:

a) Use of Backups.

All data must be backed up regularly.  In addition, all application programs & operating system software should also be kept safely so that in case of a complete system crash, everything can be re-installed/restored.

b) Use of Recovery tools.

System tools such as Norton Utilities, PC Tools, QAPlus, etc can be used to revive a disk that has crashed.

Review Questions
1. List two possible causes of a hard disk crash.

5. Unauthorised access:
Unauthorised access refers to access to data & information without permission.

Computer criminals can do the following harms:

· Steal large amounts of funds belonging to various companies by transferring them out of their computer accounts illegally.

· Steal or destroy data & information from companies, bringing their operations to a standstill.

· Spread destruction from one computer to another using virus programs.  This can cripple the entire system of computer networks.

· Spread computer worm programs.  Worm programs are less harmful in the beginning, but render the computer almost useless in the long-run.

Precautions against Unauthorised access:

a) Restrict physical access.

Physical access to computer systems should be restricted to ensure that no unauthorised person gets access to the system.

Some of the ways of restricting physical access include:

· Locking of doors.

· Use of personal identification cards.

· Use of fingerprint identification.

· Use of special voice-recorders.  They analyse the voice of a trespasser & checks against the database containing the voice patterns of valid users. 

b) Password protection.

Install a password to restrict access to the computer system.

A Password is a secret code that can be used to prevent unauthorised access of data in a computer.

Passwords can be put in at various levels:

· At the point of switching on the computer – to restrict access to the computer.

· On folders/directories – to restrict access to entire folders/directories.

· On files – to restrict access to individual files within a directory.

· On database systems – to restrict access to individual data elements.

When a valid password is entered, the user gets access to the computer system.  Usually, the user is allowed three (3) attempts to get the password correct.  If an invalid password is entered, access is denied after the 3 attempts.

Some computer security systems may generate an alarm if someone tries to use a fake password.

NB:  You should never use passwords that can easily be linked to you, e.g., your name, birth date, or names of people close to you. 

Review Questions
1. State and discuss four causes of data loss in a computer system.

2. (a)
Discuss two methods used to restrict unauthorised access to computer systems.

(b)
What is a Password?  Give its main importance.
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Microsoft PowerPoint 2007 Basics

Microsoft PowerPoint 2007 has a completely redesigned user interface.  The standard menus along the top have been removed and replaced with a series of toolbars Microsoft calls “The Ribbon.”  These tool bars are changed using tabs at the top and try to automatically adjust themselves to the content you are working with.  If you select an image it will automatically switch to the picture tools.  The new layout seems to offer easier access to most of the features of PowerPoint allowing for more complex documents to be created quicker.
The Office Logo

The first thing most people will need to relearn is where to go to open a document, create a new one, save your document and print.  Clicking the Office logo at the top left of the screen will provide most of the items formerly found under the file menu including those listed above.   Beside the logo you also will find a disk icon to save your document as well as the undo and redo buttons.  More buttons can be added to this “Quick Access Toolbar” through the word options mentioned in the next section.


As you can see here the Office logo opens up listing your options for new, open etc. and also contains a list of your recent documents for quick opening.  Any of the items listed with an arrow beside them will replace the recent documents on the right with the options associated with the menu item.  You should also see at the bottom right of this menu a button for exiting PowerPoint and changing PowerPoint’s options.

Save as

The save as option will provide you with the most common file formats to save your document in.  The common ones are PowerPoint Presentation, PowerPoint Show, and PowerPoint 97-2003 Presentation.  The last one is the option most people should be using currently, especially if they wish to share documents with others who do not have the new version of Office.

Print

Here you can choose from Print, Quick Print and Print Preview.  Print brings up the standard print dialog box, quick print will print one copy without any dialog box coming up and print preview will bring up the print preview screen.

Prepare

The prepare menu’s most common options are Properties, Inspect Document, Mark as Final and Run Compatibility Checker.  The properties option allows you to setup metadata for the document like Author, Title, keywords, comments and others.  Inspect Document will scan the document for any hidden data like comments and annotations, and any hidden collaboration data.  This is very useful when making a previously private document public.  It will help you find any comments or changes made previously that should not be made public.  Mark as Final will mark the document as a final copy and make it read only so changes cannot be made.  The last common item, Run Compatibility Checker will scan the document for new features that were used and show you these.  This is recommended if you where creating a document in the new file format but now need to convert it back to the Office 2003 format to share with someone who does not have Office 2007.

The Home Tab

[image: image16.jpg]N’
-/‘Hume Insert  Design  Animations  Side Show  Review  View  Add-ns

% ~ ) ¥ shape Fill - 4 Find
o/

Z shape Outline - || %, Replace -

o i e N W [ ) |
- = Arrange  Quick.

Reset
‘ - Styles -

Paste || New (B2 U e & 8- oaaffA-
Clipboard & Slides. Font (c] Paragraph ] Drawing £l Editing

Side - * Delete < Shape Effects - || &b Select -





The home tab the basic formatting tools found in PowerPoint 2007.  You will find five sections, Clipboard, Slides, Font, Paragraph and Editing.  Clicking the down arrow beside any of the icons here will drop down more options for that tool.  Each section except slides also contains an arrow in the bottom right corner which will open a window containing the options found in that section.

Clipboard

The Clipboard allows you to cut, copy, paste and copy formatting from one place to another.   

Slides

The slides section has tools to add new slides, change the layout of a slide, also reset or delete a slide.  Both the New Slide and Layout sections offer drop down menus with predefined slide layouts to use.  

Font

The font section of the ribbon provides a section to handle the basic text formatting.  Items such as bold, underline, strikethrough, highlight and font type can be changed here.  There are also some items like character spacing and text shadow.  Some items from this section and some items from the paragraph section are also available by highlighting text and moving your cursor slightly above the highlighted text.  This saves having to move your cursor all the way to the top of the screen for some common formatting items.

Paragraph

The paragraph section provides icons for bullets, lists, justify, line spacing, indents and text direction.  You can also access tools to align the text vertically within a section and add smartArt graphics.

Drawing

The main part of the drawing section gives you a large number of shapes, lines arrows and flowchart pictures.  The arrange icon is used to bring an item forward or backwards on the screen or group and ungroup objects.  The quick styles icon gives a drop down with predefined shape style options or you can use the shape fill, shape outline, or shape effects icons to create your own styles.

Editing

The Editing section of the toolbar allows you to find, replace and select items.  The select option gives you the ability to select all, select objects or select text with similar formatting.  This last option gives you the ability to quickly change everything in your document with one style to another style without having to manually find all of that text and change each area separately.

Insert Tab
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The insert tab has five  sections for inserting most types of objects.  The sections are tables, illustrations, links, text and media clips.  

Table

The table section only has a drop down menu which offers a grid to create a new table, insert table, draw table, convert text to table for selected text, Excel spreadsheet, and some predefined “Quick Tables” that have formatting already setup for you.  When working on a table you will have two additional tabs along the top of the ribbon, the design and layout tabs.  There are screenshots of both directly below.

Table Design
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Table Layout
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Illustrations

The Illustrations section allows you to insert pictures, clipart, photo albums shapes, SmartArt and charts.  After inserting or selecting a picture you are provided with a new toolbar along the top shown here.   This toolbar gives you the ability to change the brightness, contrast, shape, position, text wrapping and other options for the picture.  Clicking off the picture or on one of the other tabs will take you back to the standard toolbars.  The Shapes option of the Illustrations section allows you to insert lines, arrows, boxes, basic flowchart shapes and a number of others.  The SmartArt option provides features like org charts, flow charts, illustrated lists and processes.  The Chart option is similar to PowerPoint 2003 but it offers more options for your charts.

Links

The links section provides options for inserting hyperlinks, or actions.  The actions option allows you to link an item to a hyperlink, program, sound or macro.

Text

Options in the text section include text box, Header and Footer,  WordArt, date and time, slide numbers, symbols and objects.  There are a lot of option in here to setup on your own or you can use Words predefined options.

Media Clips

Sounds or movies can be added through this section.  A large number file types can be added here including, mp3, midi, wav , wma, wmv, avi and many others.
Design Tab
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The design tab has three sections, Page Setup, Themes and Background.  

Page Setup

Page setup provides you with the tools to slide size and orientation.  The slide size option allow for some predefined sizes like letter, legal, overhead, and tv aspect ratios like 4:3 standard resolution and 16:9 widescreen. 

Themes
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The themes section gives predefined colour, fonts and effects or you can choose your own.

Background

The background section lets you choose a background style or hide the background on the selected slide..

Animations Tab
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The animations tab contains three sections, preview, animations and transitions to this slide.

Preview

The preview section will show you’re the current slides animation to allow you to check it is the way you want it.

Animations

Here you can create your own animations for use in the slide.

Transition to This Slide
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The remainder of the Animations tab is taken up by the Transition to This Slide section.  Here you can apply different transitions to be used between slides like fades, slides and many more.  You can set options for speed, sounds, and timing. 

Slide Show Tab
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The Slide Show tab contains three sections, start slide show, set up and monitors.

Start Slide Show

The start slide show section is used to start your slide show either from the beginning or the current slide.  You can also use this section to create a custom slide show.  Custom slide shows can be used to create one thirty minute presentation and one sixty minute presentation using the same set of slides but omitting some for the shorter show.

Set Up

The main features of this section are setup a slide show, record narration and rehearse timings.

Monitors

This section provides the tools to change the resolution of the slide show choose which monitor to display it on if you have multiple monitors and use presenter view if you have multiple monitors.

Review Tab
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The review tab offers three sections which include proofing, comments, and protect.

Proofing

The proofing section provides the standard spelling check, a thesaurus, research tools that include MSN search and Microsoft Encarta encyclopedia.  You will also find translation tools to help with single words or the whole document.  The translation of the entire document is done by an online service called Wordlingo.

Comments

The comments section allows you to add comments to a document for easier collaboration.  You can cycle through the comments to find out what notes you left for yourself or others and you can delete a comment that was made when it is no longer relevant.

Protect

The protect section gives you options to add a password and protect the document.  You can restrict changes to formatting and editing or the whole document.  If you use Windows Live you can also manage permissions for specific users who also have Windows Live.

View Tab
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The view tab offers six sections which include presentation views, show/hide, zoom, Color/Greyscale, window and macros.

Presentation Views

The presentation views section switches you between normal, slide sorter, notes page, slide show, slide master, handout master and notes master.  Normal shows you one slide in the centre with thumbnails of all slides to the left of the screen.  Slide sorter fills the centre with thumbnails of all slides which you can drag around to sort them.  The notes page view shows the slide on the top section and notes you add in a bottom section.  Slide show will start the slide show from the beginning.  The Slide master, handout master and notes master views allow you to change what the presentations themes will follow by working with a master setup.  Each of these master views also provide another tab to the ribbon.

Show/Hide

The show/hide section will toggle certain tools on or off the screen including rulers, gridlinesand message bar.  The rulers will show along the top and left side of the screen.  Gridlines will cover your entire document inside the margins.  They will be visible on screen but don’t print.  The message bar can only be displayed when there is a message to be displayed.  One common reason for the message bar to display is when macros have been enabled or disabled.  

Zoom

The zoom section provides tools to zoom into or out of the document.   You can choose your own zoom factor or use one of the predefined zoom factors.

Color/Greyscale

This section allows you to switch between color, grayscale or pure black and white.  This will allow you to see how slides will look when printed on a black and white printer.

Window

The new window button will open your current document in a new window.  The arrange all button will take your currently open windows and stack them one on top of the other.  This is also where you can easily switch between windows.

Macros

The macros section provides the tools required to work with and create basic macros.  You can view existing macros or record your own.  Choose record macro from the drop down and then perform the functions you do often, like change the page layout, and style of the document.  Once you have done those tasks then stop recording.  You will be able to use that macro over again to shorten the steps you need to take every time you need to perform that set of tasks.
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